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Brand and product names mentioned in this manual may be trademarks, registered 
trademarks or copyrights of their respective holders. All brand and product names 
mentioned in this manual serve as comments or examples and are not to be understood as 
advertising for the products or their manufactures.

Software License Agreement and Warranty Information
Contact Miranda for details on the software license agreement and product warranty.

Important Safeguards and Notices
This section provides important safety guidelines for operators and service personnel. 
Specific warnings and cautions appear throughout the manual where they apply. Please 
read and follow this important information, especially those instructions related to the risk 
of electric shock or injury to persons.

Restriction on Hazardous Substances (RoHs)
Miranda is in compliance with EU Directive RoHS 2002/95/EC governing the restricted use of 
certain hazardous substances and materials in products and in our manufacturing 
processes.
Miranda has a substantial program in place for RoHS compliance that includes significant 
investment in our manufacturing process, and a migration of Miranda product electronic 
components and structural materials to RoHS compliance.
It is our objective at Miranda GVD to maintain compliance with all relevant environmental 
and product regulatory requirements. Detailed information on specific products or on the 
RoHS program at Miranda is available from Miranda Customer Support at 
1-800-719-1900 (toll-free) or
1-530-265-1000 (outside the U.S.).

WARNING 

Any instructions in this manual that require opening the equipment cover or 
enclosure are for use by qualified service personnel only. To reduce the risk of electric 
shock, do not perform any service other than that contained in the operating 
instructions unless you are qualified to do so.
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Symbols and Their Meanings 

General Warnings
A warning indicates a possible hazard to personnel which may cause injury or death. 
Observe the following general warnings when using or working on this equipment:

•  Heed all warnings on the unit and in the operating instructions.
•  Do not use this equipment in or near water.
•  This equipment is grounded through the grounding conductor of the power cord. To 

avoid electrical shock, plug the power cord into a properly wired receptacle before con-
necting the equipment inputs or outputs.

•  Route power cords and other cables so they are not likely to be damaged.
•  Disconnect power before cleaning the equipment. Do not use liquid or aerosol clean-

ers; use only a damp cloth.
•  Dangerous voltages may exist at several points in this equipment. To avoid injury, do 

not touch exposed connections and components while power is on.
•  Do not wear rings or wristwatches when troubleshooting high current circuits such as 

the power supplies.
•  To avoid fire hazard, use only the specified fuse(s) with the correct type number, voltage 

and current ratings as referenced in the appropriate locations in the service instruc-
tions or on the equipment. Always refer fuse replacements to qualified service person-
nel.

•  To avoid explosion, do not operate this equipment in an explosive atmosphere.
•  Have qualified service personnel perform safety checks after any service.

The lightning flash with arrowhead symbol within an equilateral triangle alerts the 
user to the presence of dangerous voltages within the product’s enclosure that 
may be of sufficient magnitude to constitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle alerts the user to the presence 
of important operating and maintenance/service instructions.

The ground symbol represents a protective grounding terminal. Such a terminal 
must be connected to earth ground prior to making any other connections to the 
equipment.

The fuse symbol indicates that the fuse referenced in the text must be replaced 
with one having the ratings indicated.

The presence of this symbol in or on Miranda equipment means that it has been 
designed, tested and certified as complying with applicable Underwriter’s Labora-
tory (USA) regulations and recommendations.

The presence of this symbol in or on Miranda equipment means that it has been 
designed, tested and certified as essentially complying with all applicable Euro-
pean Union (CE) regulations and recommendations.
iv
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General Cautions
A caution indicates a possible hazard to equipment that could result in equipment damage. 
Observe the following cautions when operating or working on this equipment:

•  When installing this equipment, do not attach the power cord to building surfaces.
•  To prevent damage to equipment when replacing fuses, locate and correct the problem 

that caused the fuse to blow before re-applying power.
•  Use only the specified replacement parts.
•  Follow static precautions at all times when handling this equipment.
•  This product should only be powered as described in the manual. To prevent equip-

ment damage, select the proper line voltage on the power supply(ies) as described in 
the installation documentation.

•  To prevent damage to the equipment, read the instructions in the equipment manual 
for proper input voltage range selection.

•  Some products include a backup battery. There is a risk of explosion if the battery is 
replaced by a battery of an incorrect type. Dispose of batteries according to instruc-
tions.

•  Products that have (1) no on/off switch and (2) use an external power supply must be 
installed in proximity to a main power output that is easily accessible.
v
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Chapter Structure 
This user’s guide provides installation instructions and operating instructions for the Master-
Config application — software that configures the master control processing modules in an 
Miranda master control system. This guide includes the following chapters: 

• Chapter 1, Preface, outlines effective ways to use this guide, provides a list of terms and con-
ventions, and prerequisites for operating MasterConfig to configure an MCPM or an MCE. 

• Chapter 2, Introduction, presents an overview of the Miranda master control system, review 
of MCPM features, and a summary of the MasterConfig application. 

• Chapter 3, Usage, provides orientation to MasterConfig and editing and basic operating 
instructions.

• Chapter 4, Operation, provides detailed configuration instructions for the MasterConfig 
application.

• Appendix A, Reference, provides useful references that pertain to MCPM or MCE configura-
tion.

• An Index is also provided.

The PDF Document 
This guide is provided in PDF format, allowing you to use Acrobat’s “bookmarks” to navigate to 
any desired location. You can also easily print a hardcopy. Please note:

• Use the Table of Contents or the bookmarks page to jump to any desired section. 

• Many hyperlinks are provided within the chapters.

• Use the Index to jump to specific topics within a chapter. Each entry in the index is a hyper-
link.

• Use Acrobat’s ‘Go to Previous View’ and ‘Go to Next View’ buttons to retrace your complete 
navigational path. 
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• Use the ‘First Page’, ‘Previous Page’, and ‘Next Page’, and ‘Last Page’ buttons to go to the first, 
previous, next, or last page within a PDF file. 

• Use Acrobat’s extensive search capabilities, such as the ‘Find’ tool and ‘Search’ tool to per-
form comprehensive searches as required. 

Terms, Conventions and Abbreviations 
The following conventions are used throughout this guide: 

• The symbol  denotes an example or a special message.

• Entries enclosed in single quotation marks or written in a sans-serif font or Capital Letters 
denote GUI menus and buttons, and on occasion, physical control panel buttons and knobs. 

Click ‘Apply’ to . . . 

The following terms and abbreviations are used throughout this guide: 

• “MC” is an abbreviation for “master control.”

• The terms “panel” and “control panel” refer to any of the master control panels. These 
include:

iMC-Panel-GUI — a software control panel (or GUI). 

iMC-Panel-100 — a 3RU button panel coupled with a third-party monitor. 

iMC-Panel-200 — a compact hardware control panel. 

iMC-Panel-300 — a full-sized hardware control panel. 

• “MCPM” stands for Master Control Processing Module — a “transition processor.” One MCPM 
provides one master control channel.

• “MCE” stands for Master Control Engine. An MCE is a type of MCPM.

• MasterConfig is the software that configures MCPMs and MCEs. 

• MasterDiag is the software used to assign MCPMs and MCEs network addresses and perform 
diagnostics.

• MasterLogo is the software that converts your graphic images into logos in the format 
required by the MCPM or MCE.

• The MCS Panel Configuration Editor is the software that configures control panels.

Other terms, used occasionally, include the following:

• Intuition XG is a single- or dual-channel graphics processor. The term “Intuition XG” can 
encompass all the hardware and software involved in the Intuition XG component of master 
control.

• XMedia is a term that includes different software applications that create and manage 
images, keyers, logos, etc. used by Intuition XG.

• Xplay and the XG Dashboard are software applications under XMedia. Both of these are used 
to configure the Intuition XG processor.

• Xbuilder and Xstudio are creative software applications under XMedia. 

Note

To display the navigation buttons, right-click the Tool Bar area, and check ‘Navigation’.
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• Oxtel is a division of Miranda. Its name is used to identify certain ports of the Intuition XG 
hardware. The Oxtel protocol is used by the Imagestore 750s in the master control system.

• The term “DC21” identifies the master control device controller used for machine control. 
“DC21” is trademark of DNF Controls. 

Prerequisites
Please observe the following important prerequisites:

• Master control frame (and its control cards, I/O cards, and MCPMs) properly installed.

At least one MCPM (or MCE) is required.

• At least one configuration PC is required. 

MasterConfig and other configuration software are to be installed on this PC. The software is 
available on the master control software and documentation CD (SB0243).

GUI software is available on the SB0244 CD.

• At least one master control panel properly configured.

For operation, the configuration PC, MCPMs, MCEs, and master control panels must be con-
nected on an Ethernet LAN. 

• NV9000 requirements met.

You are using a master control system in conjunction with an NV9000 router control system. 
Ensure that the NV9000 is properly installed and that your master control system and 
NV9000 are communicating with each other. 

• User accounts for PCs used for master control set to ‘Standard User’ or better. 

Master control software does not function properly when user accounts are set to ‘Restricted 
User’ or its equivalent.

MasterConfig allows you to create MCPM and MCE configurations off-line. You do not need a 
connection to an MCPM or an MCE or to an NV9000 system to perform most configuration tasks. 

A connection to an NV9000 system is required to specify portions of an MCPM or MCE configura-
tion that reference NV9000 devices and device categories. It is possible, but more difficult, to 
make those configurations from memory or from written notes. Ultimately, a connection 
between your configuration PC and an MCPM (or MCE) is required to upload the configuration. 

Options
The Master Control Tally Processor is an option. It provides 32 GPI inputs and 32 GPI outputs. It 
can monitor master control events and trigger master control events. 

The Master Control (DC21) Device Controller is an option but is required if your master control 
system is to perform machine control. It also has 32 GPI inputs and 32 GPI outputs and has 4 
serial ports. 

Intuition XG is an option that can be enabled for specific MCEs. Intuition XG adds rich branding 
to master control because it includes sophisticated design tools and a powerful graphics 
processors.

If Intuition XG is integrated with master control, at least one SWB input card (and backplane 
module) is required. 
3
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How to Use This Manual
If you have already read the Master Control Reference Manual, you can skip much of the introduc-
tory material. 

Please do read the chapter entitled “Usage.” Many characteristics of the menus, buttons, and 
configuration pages in MasterConfig are obvious, but some are not.

MasterConfig is necessarily complex and the material describing the configuration pages is like-
wise complex. We recommend that you first skim through all the operations sections. Then read 
carefully the sections you need to read, one at a time.

If you intend to use the Intuition XG component of master control, please obtain Intuition docu-
mentation from Miranda. It is not included on the SB0243 CD.
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Chapter 2 is an introduction to MasterConfig. 

Topics
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Master Control System Overview 
Miranda’s master control system — a multi-channel switcher — might include one or more 
MCPMs or MCEs in NV5100MC frames and one or more Imagestore 750s. The frames are 8RU 
assemblies that have 16 I/O card slots that can operate in conjunction with other switchers, 
routers, an NV9000 router control system, and other products.

Each frame holds one or more transition processors (MCEs or MCPMs) and optionally a multi-
format router. The MCEs, MCPMs, and Imagestore 750s are the modules that actually perform 
the master control switching. Each MCE, MCPM, or Imagestore 750 is considered a channel.

The Imagestore 750 is an independent 1RU transition processor. 

MasterConfig has no relationship to Imagestore 750s. Therefore, aside from its brief mention in 
this chapter, the Imagestore 750 will not be discussed.

MCPMs, MCEs, and control panels communicate on an Ethernet LAN. When an operator presses 
control panel buttons (the ‘Transition’ button, for example), the control panel issues commands 
to an MCPM (or MCE). The MCPM (or MCE) responds with status and (unless a problem exists) 
executes the command. When a command is successfully executed, the MCPM or MCE notifies 
the panel, which updates its displays and indicators accordingly. 

Figure 2-1 shows the basic relationships in a master control system: 

Fig. 2-1: iMC Network

Master control can work in conjunction with the NV9000 router control system. In such a config-
uration, a channel (MCPM or MCE) has access to the entire router input space, with the ability to 
assign any router source dynamically to control panel buttons.
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Most control panels can control one or more channels (MCPM) at any time — but usually one at 
a time. Operators can select which channel(s) to control. When you change channels, control 
panel updates take about a second. We say that the panel attaches the newly selected channel, 
and the channel’s own source layout, transition rates, and layer presets are available for use. 

Each MCPM and MCE can also be operated under automation. An MCPM or MCE can be 
controlled by multiple control panels.

NV9000 Router Control System 
A master control system can be viewed as a part of an NV9000 system. Alternatively, the NV9000 
can be regarded as a provider of inputs to the master control system. 

In either case, master control allows router outputs as master control inputs and allows an oper-
ator (or automation) to take any router source to the master control output.

An MC system used in conjunction with an NV9000 system must be connected to the NV9000 
(in the control section of the master control frame). 

Control Panels 
Presently there are 2 hardware control panels and 1 software control panel (GUI): 

Transition Processors
Transition processors include MCEs, MCPMs, and Imagestore 750s.

MCEs are a specific type of MCPM, although they have advanced features that other MCPMs do 
not have.

iMC-Panel-GUI A software control panel, also called the “GUI.” This panel also runs on a PC 
and has a graphical user interface. This GUI is a software emulation of the 
iMC-Panel-200. This GUI is designed to operate with (or without) a touch-
sensitive screen.

iMC-Panel-200 A compact hardware control panel that has a large LCD touchscreen, many 
function buttons, and a joystick. The iMC-Panel-200 mounts on a desktop or 
work surface. All buttons have LCD legends and color-coding. 

iMC-Panel-300 A “full-size” control panel that has a large LCD touchscreen, many function 
buttons, and a joystick. The iMC-Panel-300 mounts on a desktop or work 
surface. All but 2 buttons have LCD legends and color-coding. 
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MCPMs
MCPMs (master control processing module) are the devices that perform master control 
switching and mixing. There are several types of MCPMs: 

Imagestore 750
The Imagestore 750 (called a “channel branding processor”) is an independent 1RU transition 
processor. It supports either HD or SD video input. It supports A/B mixing for program and 
preview, and provides 4 “downstream keyers” and optionally 2 DVEs for both program and 
preview. Refer to XREF and the Master Control Reference Manual for details.

“Preview,” to Imagestore 750s, is approximately what “preset” is to MCEs and MCPMs.

Other Miranda Products
Listed here are products that relate to master control.

Tally Processor
Miranda offers a third-party “tally processor”— a 1RU device that provides 32 optically isolated 
inputs and 32 relay outputs, also optically isolated. Through Miranda’s NVISION Ethernet 
protocol (NVEP), the tally processor can sense master control events such as main source selec-
tions and transitions and trigger master control events.

Multiple tally processors can be added to a master control network. 

MCPM-SD 2-slot modules that process standard definition (SD) video. Provides 3 
keyers, 2 logos, 1 squeezeback layer, 4 AES outputs, and 8 analog audio 
outputs in addition to program output. 

MCPM-HD, 
MCPM-HD2

4-slot modules that process either high definition (HD) video. Provides 3 
keyers, 2 logos, 1 squeezeback layer, 4 AES outputs, and 8 analog audio 
outputs in addition to program output. Two slots can be filled with router 
output cards.

MCPM-SDHD 4-slot modules that process either HD or SD video, as a field-programmable 
option. Provides 3 keyers, 2 logos, 1 enhanced squeezeback layer, 4 AES 
outputs, and 8 analog audio outputs in addition to program output. One of 
the slots can be occupied by a router output card. 

MCPM-MK-SD 1-slot modules that process standard definition (SD) video. Provides 3 
keyers, 1 logo, but no squeezeback. These modules are also named “mixer/
keyers” or “branding engines.”

MCPM-MK-HD 2-slot modules that process high definition (HD only) video. Provides 3 
keyers, 1 logo, and no squeezeback. Unlike other MCPMs, this model accepts 
inputs (16) from its backplane, not the frame’s motherboard. These modules 
are also named “mixer/keyers” or “branding engines.”

MCE A 1- to 3-slot module that processes either HD or SD video, as a field-
programmable option. MCEs are considered “next generation” processors 
and have new architecture. See MCE, on page 18.
7
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DC21
The DC21 is a 1RU device (from DNF) — very much like the Tally Processor — that (1) performs 
GPIO functions and (2) has 4 serial ports in support of machine control.

Each of the serial ports can be configured for one of 3 protocols: Sony, Odetics, or VDCP.

The GPOs can be configured, in adjacent pairs, to control up to 16 devices with 100 ms start and 
stop pulses. The odd member of the pair carries the start pulse and the even member carries the 
stop pulse. GPOs not used for master control may be programmed to respond to GPI and device 
control events. 

EBCP 
The emergency bypass control panel (EBCP) is a simple one: it is a 1RU panel that has two large 
button switches. One says “Main” and the other says “Bypass.” Pressing the red “Bypass” button 
places an MCPM or MCE in bypass mode. Pressing the green “Main” button enables normal 
mode. (The panel controls only the MCPM to which it is connected.) 

Intuition XG 
Intuition XG is a combination of the following: 

• A single- or dual-channel HD/SD graphics processor.

This processor stores video “key layers” and transmits the keys (fill and key) on demand. Fully 
In its maximum configuration, the processor can store up to 1.8 TB of video (about 360 hours 
at 10 Mbps). 

The processor can “play out” video upon a signal from an MCE. The MCE treats the video as a 
key source and mixes the video from the with program or preset output.

The keys can also include CG and real-time or “live” data feeds.

The processor receives information regarding what to play and when to play it from an MCE 
over its Ethernet connection.

• XMedia software for configuration and for composing, rendering, and previewing graphics. 
Xmedia includes these applications among others:

XG Dashboard. An application that allows you to modify the settings and behavior of the 
Intuition XG and its software.

XPlay — “media event sequencer” used to configure the Intuition XG and to manage clips. 
Xplay must be running on the Intuition XG processor for correct operation under master 
control.

Xbuilder — “template population” and “promo timeline control.” 

Xstudio — “template creation.” Xstudio can create video segments that, while executing in 
the Intuition XG processor, control an MCE’s squeeze effects and audio overs. 

• There is an ‘Int XG’ button on the main menu of the panels (when they are controlling MCEs 
or MCPMs). Each causes a menu of Intuition XG key layers to be displayed. These control pan-
els might also have ‘XG layer’ buttons on the preset, program, and preview button rows and 
an ‘XG keyer control’ among the configurable buttons. 

• The panels also have a ‘Preview Int XG’ button that works with an MCE’s preview bus. 
8



MasterConfig
User’s Guide
MCPM Overview 
An MCPM is a “master control processing module.” An MCPM is also called a transition processor. 
It performs the bulk of what occurs in master control. A Miranda master control system has one 
or more MCPMs. 

The most basic function of the MCPM is to switch its output from one program source to 
another and to maintain a smooth and noise-free transition as it does so. A transition involves 
both video and audio. A secondary MCPM function is to apply video effects and audio “overs” to 
program output. A program source is called a main source in contrast to other sources, such as 
those for video keyers.

What the MCPM produces as output is called program and what is to appear next on the 
program output is called preset. An operator at a control panel or an automation system presets 
a main source (video and audio) and one or more video effects or audio overs. When the oper-
ator or the automation system initiates a transition, the MCPM mixes the preset and program 
video and the preset and program audio. The video effects and audio overs fade in or out as 
required by the transition rate and transition type. (Not all transitions involve mixing.) At the end 
of the transition, what was on preset is now on program. The MCPM also has options to swap 
the preset and program settings and to clear effects from preset after the transition.

The MCPM applies video effects and audio overs in the sequence shown in Figure 2-2. 

Fig. 2-2: Video and Audio Layering

Video effects on the right are considered downstream and those on the left are considered 
upstream. Downstream effects modify any upstream effects. For instance, a squeeze effect 
affects logo A, because logo A is upstream of the squeeze function, but does not affect logo B, 
which is downstream. Downstream effects appear on top of upstream effects.

Audio overs are mutually exclusive and layering does not apply to the audio overs, although the 
over does overlay the main source audio.

The MCPM adheres to the “audio follows video” paradigm: a main source in the MCPM is consid-
ered a video input with attached audio inputs. There are two ways the MCPM can obtain an 
audio input: 

• From a discrete audio connector: analog, AES, or Dolby E.

• From audio embedded in the video signal: AES or Dolby E.

The MCPM can process Dolby-E encoded audio input if the MCPM has a Dolby module installed.

The MCPM provides 8 channels of audio processing. Each main source (on both program and 
preset) can have 8 channels of audio. Each audio channel can be individually configured. 

MCEs provide 16 channels of audio processing.

A third function (provided by some MCPMs) is to “host” one or more router output cards. These 
MCPMs have one or two “wing” connectors into which you can plug SWB router cards. These 
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MCPMs contain one or more crosspoints that provide the outputs, 16 for each router output 
card. (The router output cards are optional.)

A fourth function is to switch from normal program output to emergency program output 
during periods of “emergency” or malfunction. MCPMs have an emergency bypass control that 
performs the switch.

All MCPMs provide audio metering outputs and audio monitoring outputs. Some MCPMs 
provide analog audio outputs. All MCPMs have auxiliary functions (such as GPIs). The set of 
auxiliary functions varies among the MCPM models.

Video Effects and Audio Overs
Applicable effects and audio overs include

keyer 1, logo A, squeezeback, keyer 2, keyer 3, logo B.

The MCPM applies video effects, layered cumulatively, to the selected main source (preset or 
program) in the order listed here. Some MCPMs do not support all effects.

A key1 is a video overlay. A key can have two video sources: key (or mask) and fill. Some keys 
have only one source — fill — and the mask is derived from the luminance of the fill. These keys 
are called “self-keys.” A keyer is a key processor and is selectable at the control panel or by 
automation. 

For MCEs only, an external Intuition XG subsystem can provide video fill and key sources for 
1 or 2 of the keyers. See Intuition XG, following.

A logo is a graphic overlay. Logos are stored in the MCPM and are selectable at the control panel 
or by automation. Logos overlays require no video input. Logos can be single-frame images or 
animations. Animations can either loop or play once. The number of logos and animations is 
limited by available MCPM memory.

Squeezeback means that program output is reduced to a set portion of the video image gradu-
ally over the transition period while a video source (the squeeze “background”) is displayed 
under the squeezed image. There are 3 forms of squeezeback — basic, enhanced (single), and 
enhanced (dual). Dual squeezeback involves two images (main sources); single squeezeback 
involves just one image. Enhanced squeezeback allows the squeeze regions to have borders of 
variable width and color.

An over is an audio overlay. An audio over requires an audio source. The MCPM mixes audio over 
and program audio in a ratio that can be preconfigured and also adjusted at the control panel.

Not all MCPMs support all effects. Some control panels can be configured with a reduced set of 
effects. Only the MCPM-SDHD and MCE support enhanced squeezeback. 

Intuition XG 
MCEs can be connected to Intuition XG subsystems. The Intuition XG stores video keys and plays 
them out when directed by a signal from the MCE. 

An Intuition XG processor has either one or two channels. Each channel provides up to 4 layers. 
The layers are selected or deselected with XG layer buttons. Each channels uses one of the MCE’s 
keyers. Which keyer to use is configurable and depends on a number of factors. See Intuition XG 
on page 196 for configuration details.

1. A keyer is the firmware that mixes key signals with upstream video.
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It is MasterConfig that defines the connections between the MCE and Intuition XG hardware. 
The MCS Panel Configuration Editor configures the control panel buttons that operate the Intu-
ition key layers. 

Note that Intuition XG can provide real-time or “live” character generation.

Transition Types 
A transition can be fast, medium, slow, or controlled by a transition lever arm (TLA). The exact 
duration of “fast,” “medium,” and “slow” is configurable. A transition controlled by a TLA is also 
called a “manual” transition. 

Basic transition types include cut, V-fade (or fade-fade), cut-fade, cross-fade (or X-fade), and 
fade-cut. “Preset black” transitions include cut/cut, V-fade, cut-fade, and fade-cut, but cross-
fade. The MCPM performs audio transitions that match the rate and period of the video transi-
tions. Audio transition types are analogous to the video transition types, but are not exactly the 
same. They involve smoothing to eliminate audio artifacts.

The TLA, manual transitions, and preset black transitions are concepts relegated to legacy 
equipment. However, MCEs, MCPMs and control panels still acknowledge PB transition 
types. The MCEs and MCPMs substitute normal transition types when they encounter PB 
transition types. 

The MCPM can also perform a “fade-to-black” or FTB transition. An FTB transitions the program 
output to a pre-defined matte (and program audio to silence) — after all effects and overs — in 
the transition period defined for the FTB. The matte can be any color, not just black. 

The master control system allows “hot cuts” although they are not recommended. A “hot cut” is 
where the operator switches a main source immediately (on program output) or turns an effect 
on or off without benefit of transition processing. A hot cut should be considered an emergency 
measure — to correct an error quickly — because it can have noticeable artifacts that would be 
absent in a normal transition.

A transition that involves pre-roll is called a pre-roll transition. When a pre-roll transition is 
pending, the transition button turns red and displays the word “Preroll. As the transition begins, 
there is a pre-roll period (that depends on the longest pre-roll value pending). During the pre-
roll period, the transition button blinks between high- and low-tally red. After the pre-roll 
period, the transition button reverts to orange. 

MCPM Types
There are 7 MCPM types: 

MCPM-SD MCPM-MK-SD (“Mixer/Keyer”) MCPM-SDHD
MCPM-HD MCPM-MK-HD (“Mixer/Keyer”) MCE
MCPM-HD2

All MCPMs have common characteristics, such as audio meter outputs, GPIO, clean-feed 
outputs, and emergency bypass capability, but also have many differences. 

Common Features
All MCPM models have a diagnostic/configuration port, a reset button, and an emergency 
bypass switch (and bypass indicator) at the front. All MCPMs also have a set of LED status 
indicators. 
11
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All MCPMs have program output, preview1 output, and clean-feed output. Each of these 
provides video output with embedded audio. Some models provide additional AES outputs.

All MCPMs have an emergency bypass video input (that supports embedded audio). Some 
models have additional (AES) emergency bypass inputs.

Older MCPMs have 2 video reference connectors and meter/monitor connectors. MCEs have 1 
video reference connector, internally terminated.

All MCPMs have control connectors and auxiliary connectors, although the number of pins of 
auxiliary connectors differ. The aux connectors provide GPI inputs and outputs and emergency 
bypass relay connections, at a minimum.

Figure 2-3 shows the backplane connectors of the MCPMs: 

Fig. 2-3: MCPM Backplanes

1. The preview output presents the source and effects of the preset bus. On MCEs, this output is called pre-
set output.
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–8

–16

7–24
Figure 2-4 shows the backplane connectors of the Mixer/Keyers: 

Fig. 2-4: MCPM (Mixer/Keyer) Backplanes

Figure 2-5 shows the (3) backplane connectors of the MCE: 

Fig. 2-5: MCE Backplanes
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Figure 2-6 shows the 2-slot core backplane that has BNCs instead of 1.0/2.3 connectors: 

Fig. 2-6: MCE Backplanes with BNCs

MCPM-SD
The MCPM-SD is a 2-slot module that processes standard definition (SD) video. 

The MCPM-SD receives video and audio input from the motherboard — up to 128 video sources 
or 128 stereo (256 mono) sources, or a combination thereof, in multiples of 16 sources. Video 
sources may contain embedded audio. The MCPM-SD provides 3 video keyers, 2 logo keyers, 1 
squeezeback layer, and 2 audio overs. These MCPMs accept optional Dolby E decoder modules. 

At the backplane, the MCPM-SD has 4 video outputs: program, program monitor, preview (a.k.a. 
preset), and clean-feed. The MCPM-SD also has 4 discrete AES program outputs. 

The backplanes also have 5 emergency bypass inputs, one video (with or without embedded 
audio) and 4 AES inputs. 

The MCPM-SD has 8 analog audio outputs in addition to audio meter and monitor outputs. 

The MCPM-SD has Ethernet (control) and RS-422 (automation) connections. (An additional 
10BaseT port is unused.) The aux connector has time-code inputs and Dolby metadata outputs 
in addition to GPI and relay contacts.

The MCPM-SD has an internal black/silence generator for use as a program or preset main 
source, or as a squeeze background. 

Aux
Connections Video Reference

Video and Audio Connections, 
including Monitor and Clean-
Feed Outputs

Automation
(RS-422)

Ethernet
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MCPM-HD, -HD2 
The MCPM-HD and -HD2 are 4-slot modules. Each processes SWB (either HD or SD) video. The 
MCPM-HD2 is an improved version of the -HD. 

The MCPM-HD (and -HD2) receives video and audio input from the motherboard — up to 64 
video sources or 641 stereo (128 mono) sources, or a combination thereof, in multiples of 16 
sources. Video sources may contain embedded audio. The MCPM-HD and -HD2 provide 3 video 
keyers, 2 logo keyers, 1 squeezeback layer, and 2 audio overs. These MCPMs accept optional 
Dolby E decoder modules. 

At the backplane, the MCPM-HD and -HD2 have 4 video outputs: program, program monitor, 
preview (a.k.a. preset), and clean-feed. They also have 4 discrete AES program outputs. The 
backplanes also have 5 emergency bypass inputs, one video (with or without embedded audio) 
and 4 AES inputs. The MCPM-HD and -HD2 both have 8 analog audio outputs in addition to 
audio meter and monitor outputs. 

The MCPM-HD has an internal black/silence generator for use as a program or preset main 
source, or as a squeeze background. 

The MCPM-HD and -HD2 both Ethernet (control) and RS-422 (automation) connections. (An 
additional 10BaseT port is unused.) The aux connector has time-code inputs and Dolby meta-
data outputs in addition to GPI and relay contacts.

The MCPM-HD and -HD2 both have a 2-slot wing that accepts one or two SWB router output 
cards. The output cards have little (or nothing) to do with master control. These MCPMs provide 
two 16-output crosspoints for the multi-format router that might optionally occupy the 
NV5100MC frame. The output cards connect to the wing and not to the NV5100MC 
motherboard. 

The MCPM-HD does not have control over its wing output cards. The MCPM-HD2 has some 
control over its wing output cards. In the MCPM-HD2, wing outputs 1–16 (in wing slot 1) can be 
individually configured:

• To be controlled only by the router control card. (This is the default setting.)

• Emit program main video. 

• Emit preset main video.

Wing outputs 17–32 (in wing slot 2) cannot be configured. They are controlled only by the 
router output card.

If you have an SWB output card in a wing slot, you must also have an SWB output backplane 
in the corresponding backplane slot. 

MCPM-SDHD 
The MCPM-SDHD is a 4-slot module. It processes either HD or SD video, as a field-programmable 
option. It provides all the features of an SD or HD processor plus this extension:

• It provides enhanced squeezeback. Enhanced squeezeback can manipulate 2 squeezeback 
video sources and an audio source for the second video image. 

(The second video source is a main source. The squeezeback audio is from that main source 
and is accessible when the panel operator selects the squeeze audio as an audio over.)

1. Inputs 1–64 are committed to HD video sources; inputs 65–128 are available for other signals.
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The MCPM-SDHD has an internal black/silence generator for use as a program or preset main 
source, or as a squeeze background. 

The MCPM-SDHD receives video and audio input from the motherboard — up to 64 video 
sources or 64 stereo (128 mono) sources, or a combination thereof, in multiples of 16 sources. 
Video sources may contain embedded audio. The MCPM-SDHD provide 3 video keyers, 2 logo 
keyers, 1 enhanced squeezeback layer, and 2 audio overs. It accepts optional Dolby E decoder 
modules. 

At the backplane, the MCPM-SDHD has 4 video outputs: program, program monitor, preview 
(a.k.a. preset), and clean-feed. The MCPM-SDHD also has 4 discrete AES program outputs. The 
backplanes also have 5 emergency bypass inputs, one video (with or without embedded audio) 
and 4 AES inputs. The MCPM-SDHD has 8 analog audio outputs in addition to audio meter and 
monitor outputs. 

The MCPM-SDHD has Ethernet (control) and RS-422 (automation) connections. (An additional 
10BaseT port is unused.) The aux connector has time-code inputs and Dolby metadata outputs 
in addition to GPI and relay contacts.

The MCPM-SDHD has a 1-slot wing that accepts an SWB router output card. This card has rela-
tively little to do with master control. The MCPM-SDHD provides a 16-output crosspoint for the 
multi-format router that might optionally occupy the NV5100MC frame. The output card 
connects to the wing and not to the NV5100MC motherboard. 

The MCPM-SDHD has some control over its wing output card. Each of the 16 wing outputs can 
be individually configured:

• To be controlled only by the router control card. (This is the default setting).

• Emit program main video.

• Emit preset main video. 

• Emit program main audio (if embedded).

• Emit preset main audio (if embedded). 

If you have an SWB output card in a wing slot, you must also have an SWB output backplane 
in the corresponding backplane slot. 

MCPM-MK-SD
The MCPM-MK-SD is a 1-slot module. MCPM-MK-SDs are also named “mixer/keyers” or 
“branding engines.” The MCPM-MK-SD processes standard definition (SD) video. The MCPM-MK-
SD is a lower-cost and smaller alternative to the MCPM-SD, but has a reduced feature set:

• One logo generator, not two.

• No squeezeback generator.

• No analog outputs.

• No Dolby E decoders (and no Dolby metadata output).

• No “program monitor” output. (Its clean-feed output can be used as a program monitor.)

• No AES outputs (except for monitor/meter output).

Otherwise, it has all the many features found in the MCPM-SD.

The MCPM-MK-SD receives video and audio input from the motherboard — up to 128 video 
sources or 128 stereo (256 mono) sources, or a combination thereof, in multiples of 16 sources. 
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Video sources may contain embedded audio. The MCPM-MK-SD provides 3 video keyers, 1 logo 
keyers, and 2 audio overs. 

At the backplane, the MCPM-MK-SD has 3 video outputs: program, preview (aka preset), and 
clean-feed. The MCPM-MK-SD has no AES output connectors (except for meter/monitor 
outputs). Emergency bypass audio input must be embedded in the emergency bypass video 
input. 

The MCPM-MK-SD has no analog audio outputs, but does have audio meter and monitor 
outputs. 

The MCPM-MK-SD has Ethernet (control) and RS-422 (automation) connections. The aux 
connector has time-code inputs in addition to GPI and relay contacts. Because the MCPM-MK-
SD does not have a Dolby E decoder, the aux connector does not have Dolby metadata outputs.

MCPM-MK-HD 
The MCPM-MK-HD is a 2-slot module. MCPM-MK-HDs are also named “mixer/keyers” or 
“branding engines.” The MCPM-MK-HD processes high-definition (HD) video only. The MCPM-
MK-HD is a lower-cost and smaller alternative to the MCPM-HD, but has a reduced feature set:

• One logo generator, not two.

• No squeezeback generator.

• No analog audio outputs.

• No Dolby E decoders (and no Dolby metadata output).

• No “program monitor” output. (The clean-feed output can be used as a program monitor.)

• No AES outputs (except for monitor/meter output).

• Video inputs are restricted to the 16 connectors on the -MK-HD’s backplane module.

Otherwise, it has the many features found in the MCPM-HD.

Unlike other master control processors, the MCPM-MK-HD obtains video inputs (16) from its 
own backplane, not from the NV5100MC motherboard. These inputs can contain embedded 
audio. However, they are HD inputs, not SWB inputs and therefore do not accept SD signals. 
Further, key and fill signals must also be taken from among the 16 backplane connectors. The -
MK-HD does not obtain key and fill from the motherboard.

The MCPM-MK-HD does, however, receive audio input from the motherboard — up to 64 stereo 
(128 mono) sources, or a combination thereof, in multiples of 16 sources. The MCPM-MK-HD 
provides 3 video keyers, 1 logo keyer, and 2 audio overs. 

At the backplane, the MCPM-MK-HD has 3 video outputs: program, preview (aka preset), and 
clean-feed. The MCPM-MK-HD also has no AES connectors. Emergency bypass audio input must 
be embedded in the emergency bypass video input. 

The MCPM-MK-HD has no analog audio outputs, but does have audio meter and monitor 
outputs. 

The MCPM-MK-HD has Ethernet (control) and RS-422 (automation) connections. The aux 
connector has time-code inputs in addition to GPI and relay contacts. Because the MCPM-MK-
HD does not have a Dolby E decoder, the aux connector does not have Dolby metadata outputs.
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MCE 
MCEs (master control engines) are the “next generation” of MCPMs — devices that perform 
master control switching and mixing. 

The MCE is an extendable product, occupying up to 3 card slots, with a full set of features. There 
are 4 modules in the MCE card set:

• MCE-CORE. The minimum MCE comprises this single (full-size) card that performs core mas-
ter control functions.

• MCE-PVW. The preview module (not available yet) provides functions that allow the use of 
the “next generation” preview bus. 

• MCE-AXM. The audio expansion module supports Dolby E and additional audio functions. 
The AXM provides Dolby E decoders for the program and preset buses and audio outputs at 
its backplane. (The AXM has slots for up to 8 third-party Dolby E modules.)

• MCE-DVE. The digital video effect cards are mezzanine (small) cards that can be added to the 
core and the preview cards for additional video effects. 

MCEs have inputs and outputs similar to those for MCPMs, such as audio meter outputs, GPIO, 
clean-feed outputs, and emergency bypass capability. All MCEs have a reset switch, a bypass 
toggle (for the emergency bypass relay) and an diagnostic port at their front. Like the MCPM-
SDHD, the MCE can process either HD or SD signals as a field-programmable option. 

Notable differences between the MCEs and older MCPMs include:

• Audio output is embedded.

• MCE audio and video connectors are coaxial (1.0/2.3 DIN) connectors; MCPM audio and 
video connectors are BNCs.

• MCEs have 2 clean feed outputs and 2 aux outputs.

• The audio monitor outputs of MCEs are completely independent and have 16 audio chan-
nels each.

• MCEs that have AXM cards have more AES outputs and more Dolby metadata outputs than 
MCPMs have. Those outputs are configurable. 

• All MCE logos are stored in non-volatile memory.

• MCEs can receive key inputs from Intuition XG processors.

• MCEs provide machine control and pre-roll functions.

There are other minor differences. 
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Figure 2-7 shows the front of one of 4 possible MCE assemblies and its associated backplanes: 

Fig. 2-7: MCE Assembly, Core, Preview, and AXM Backplane Modules

(There is also a 2-slot core backplane having BNCs instead of 1.0/2.3 connectors. See Figure 2-6.)

Emergency Bypass 
MCPMs provide emergency bypass inputs for program video and audio. The MCPMs use relays 
on their backplanes that switch between the program signal path and the emergency bypass 
inputs. A relay control signal from the MCPM’s internal “system controller” controls those relays. 
The relay control signal is driven by a one-shot (watchdog) timer that, if not reset periodically, 
will cause the relays to change to the bypass position. This ensures that if the system controller 
is not operating correctly, that the emergency bypass inputs are routed to the program video 
and audio outputs. 
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The emergency bypass LED on the front of the MCPM indicates the state of the bypass relay. The 
emergency bypass relay will switch to ‘bypass’ if any of the following conditions are true:

• There is a physical problem with the MCPM (e.g., power failure or component failure).

• The MCPM determines that it is not capable of passing video and audio (e.g., bad configura-
tion or FPGAs not loaded).

• If the bypass toggle switch located on the front of the MCPM forces the emergency bypass 
relays into the bypass mode.

• A GPI input, configured to control the emergency bypass relay, forces the MCPM into bypass 
mode. 

Note that the emergency bypass relay will be set to non-bypass or “normal” mode (i.e., passing 
program video) only if all of these conditions are false.

The optional emergency bypass control panel (EBCP) can use a GPI input to trigger emergency 
bypass mode.

Bypass at System Startup
When the MCPM restarts, the program outputs are fed by the bypass inputs. When the MCPM 
has initialized and is stable, the system controller switches the program outputs to the master 
control outputs. To avoid pops, its audio begins in silence and fades up.

Emergency Bypass Relay Behavior
When error conditions exist, the MCPM ignores any external control of the emergency bypass 
relay. An external control will not be able to set the emergency bypass relay to “normal.” If the 
bypass switch on the front of the MCPM is set to bypass, the MCPM will also ignore any external 
control of the emergency bypass relay.

The MCPM’s aux connector provides an external connection to the emergency bypass relay. The 
MPCM-SD, -HD, and -SDHD provide all 3 relay terminals, NC, COM, and NO. The MCPM-MK-SD 
and -HD provide only 2 terminals, COM and NO. 

There are 3 ways in which the emergency bypass relay can be controlled externally:

• From the MCPM’s GPI inputs. 

• From a control panel.

• By automation.

GPI 
GPI stands for “general-purpose interface.” The GPI is available on the MCPM’s aux connector.

GPI Inputs 
The MCPM has two configurable GPI inputs. The MCPM configuration software lets you select a 
GPI input and specify one of 5 behaviors for the input:

• Toggle control of the emergency bypass relay.

• Level control of the emergency bypass relay.

• Set the EBR to “bypass.”

• Set the EBR to “normal.”

• Disabled. The MCPM ignores the GPI input.
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Typically, router outputs connect to the bypass input connectors. This allows, for example, the 
same program to continue to broadcast during the emergency or break, albeit without the tran-
sitions and effects provided by the MCPM.

Another use of the bypass BNCs would be to provide a “technical difficulties” message.

GPI Outputs 
The MCPM’s two GPI output are SPDT relays (24VDC, 100mA). Connections to the relay terminals 
are present on the MCPM’s aux connector. The Mixer/Keyers (MCPM-MK-SD and -MK-HD) 
provide COM and NO connections; other MCPMs provide COM, NO, and NC connections.

The MCPM can be configured so that when certain conditions are met, the MCPM activates an 
output relay — triggering the device that you have connected to the outputs (e.g., a cart 
machine). 

(Activation means that the NO-COM circuit closes and the NC-COM circuit opens.) 

There are 7 ways a GPI output can be activated:

• Disabled. (It does not activate.)

• Controlled from a control panel button press. 

• A selected video effect on the program or preset bus. 

• For the duration of any transition. 

• A selected main source is on the program or preset bus. 

• A selected over source is on the program or preset bus. 

• The Dolby decoder is in use by any main source on the preset or program bus.

Router Output Cards 
The MCPM-HD, MCPM-HD2, and MCPM-SDHD all have “wings” that accept SWB router output 
cards. The MCPM-SDHD accepts one SWB card; the MCPM-HD and -HD2 accept two. 

Each of these MCPMs includes a 16-output crosspoint for each SWB card. An NV5128 multi-
format router (in the same frame) can route any of up to 64 SWB inputs to outputs on these 
cards.

The MCPMs have little or nothing to do with the router output except to supply the crosspoints 
and connectors. However, the -HD2 and -SDHD both allow limited control over the outputs. See 
MCPM-HD, -HD2, page 15, and MCPM-SDHD, page 15, for more information.

Machine Control 
MCEs have machine control functions and can initiate pre-roll in selected media.

MasterConfig can enable machine control functions and pre-roll in the General Settings page.

MasterConfig sets machine control and pre-roll parameters in the Main Sources page and also in 
the Intuition XG page.

Master control uses the DC21 device controller to carry out machine control operations. Please 
refer to the DC21 Device Controller User’s Guide for information.

There are some methods and requirements for setting up machine control — in MasterConfig, in 
MCS Panel Configuration Editor, and in the DC20 itself. 
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MasterConfig Overview 
MasterConfig is the tool with which you configure MCPMs and MCEs. 

You create and edit configurations on your PC and store them in your PC’s file system.

You read and write the configurations you created to and from MCPMs or MCEs. A configuration 
can include logos you created in MasterLogo.

When you create a configuration, you designate the type of MCPM and its video frame rate. The 
configuration is “locked” to that MCPM type and rate.

The principal functions of the configuration are (1) to enumerate video and audio connections 
and their relationships, (2) to define video effects, and (3) to specify as far as possible what a 
panel operator can and cannot control for that MCPM type. 

The MCPMs and MCEs in a master control system can all have different configurations. Or, all 
MCPM of the same type can have the same configuration. Generally, there will be some amount 
of configuration overlap — I/O definitions, for example — and some differences, perhaps a set of 
logos, depending on the use of the MCPM or MCE. 

These are the MCPM/MCE features that MasterConfig addresses:

• The inputs at the rear of the master control frame.

• Router inputs and whether they are present.

• Source-to-button mapping.

• The audio associated with each video input.

• Definition of video effects.

• Identification of audio overs.

• Emergency bypass and the GPI inputs and outputs.

• Automation.

• Audio monitors.

• Default sources and default video effects.

• Wing outputs (for MCPM-HD2, and -SDHD).

• Squeezeback enhancement (for MCPM-SDHD and MCE).

• The aux buses A and B (for MCE).

• Interface to Intuition XG.

• Machine control and pre-roll.

MasterConfig also addresses a few other minor features.
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Chapter 3 provides orientation, and presents editing and operating instructions for the Master-
Config application. It presents the following topics:
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MasterConfig Summary
MasterConfig is the tool used for generating, editing, and uploading MCPM and MCE configura-
tion files.1 

MCPM and MCE configuration files exist in your configuration PC’s file system. Any configuration 
can be uploaded to as many MCPMs (or MCEs) as you like. All your MCPMs and MCEs can have 
unique configurations or several MCPMs can share a configuration. Several MCEs can share a 
configuration. 

You can also create and edit configuration files off-line.

MasterConfig supports 7 MCPM types, described in the Introduction:

MCPM-SD MCPM-MK-SD MCPM-SDHD
MCPM-HD MCPM-MK-HD MCE
MCPM-HD2

An MCPM or MCE configuration, when installed, affects what a master control operator can do at 
a master control panel. You, the configurer, should keep in mind the way the different control 
panels work.

An MCPM or MCE configuration might permit an operator to make changes to configuration 
data and optionally to save that data in the MCPM or MCE (in flash). Other panel operators who 
control the same MCPM or MCE will be affected by any change to the configuration. 

MasterConfig, MasterDiag, and MasterLogo all share a list of MCPM and MCEs (called the master 
control “tree”). The master control software folder contains a set of .XML files that implement the 
list. When you run MasterConfig, you can use to the “tree” to select MCPM and MCEs. You might 
want to build the tree if no one else has done so, but it is not necessary. MasterConfig allows you 

1. MCPM configurations are data describing the video and audio sources and processing effects of the 
MCPM. In contrast, MCPM applications — firmware, not data — execute the MCPM functions. MCPM ap-
plications are handled in MasterDiag. MCPM configurations are handled in MasterConfig.
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to add MCPMs and MCEs to the tree and to remove MCPMs and MCEs from the tree. MCPMs and 
MCEs are always identified by their IP address on the master control network.

During the configuration process, MasterConfig assembles various lists that define the choices 
an operator will see at a control panel. The operator might be able to change some configura-
tion values (such as the position of a logo) but the operator can never create or delete 
configuration entries, and typically cannot access the configuration file (on the configuration 
PC) in any way. 

MCPM and MCE configurations are typed (or tagged) according to a specific MCPM type. You are 
safeguarded1 against uploading the wrong configuration type to an MCPM. 

We recommend that you enter your MCPM or MCE configuration settings by progressing from 
general settings to detailed settings, approximately in the order presented in this user’s guide, 
applying and saving each change to the configuration, and finally, writing the configuration to 
the MCPM or MCE. Saving frequently allows you to recover easily from any mistakes you make. 
This approach provides exposure to all system options and you will avoid missing any required 
settings. 

The following sections in this chapter outline the available settings for each of the 18 configura-
tion pages. Chapter 4, Operation, presents all the configuration pages in detail. 

Starting MasterConfig 
There are 3 ways to start (or launch) MasterConfig:

• Use the Windows Start menu of your configuration PC.

Programs > Miranda > Master Control > MasterConfig - Configure MCPM (. . .)

• Double-click the actual program file. This is its default pathname:

C:\Program Files\Miranda\Master Control\bin\MasterConfig.exe.

• Double-click a shortcut (that you have created) to the actual program file. The PC desktop is 
a commonly accepted place to put a shortcut. 

This shows a typical MasterConfig shortcut: 

The locations of files in your system might differ.

1. You can defeat the safeguards, but we do not recommend it.
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Main Window
Figure 3-1 shows MasterConfig’s main window (with a configuration file open): 

Fig. 3-1: MasterConfig Main Screen (Sample) 

Figure 3-1 shows minimized or collapsed configuration pages. When you are working on a partic-
ular page, the page would be expanded. 

If you have no file open, the configuration pages do not appear and many of the menus are 
inactive (grayed out). Following are descriptions of each main window feature: 

1 Title bar

If you have a file open, the title bar shows the name of the configuration file that you are cur-
rently editing. It displays “[New]” if you have a new configuration that you have not yet 
saved. 

2 Tool bar

The tool bar contains icons that can be used as editing shortcuts if you wish. Some of the 
icons are always inactive. You can hide or show the tool bar by clicking ‘Tool Bar’ in the ‘View’ 
menu. See Tool Bar on page 37 for details.

1 3 4 5

6

2

8

7

1 Title bar 3 Menu bar 5 Workspace 7 Status bar

2 Tool bar 4 Configuration pages 
(minimized)

6 Master control tree 8 Target IP address
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3 Menu bar

The menu bar provides access to several important configuration functions. See Menus on 
page 27 for details.

4 Configuration pages

Figure 3-1 shows minimized or collapsed configuration pages. When you are working on a 
particular configuration page, the page would be expanded. 

The array of minimized pages typically falls at the bottom of the workspace. You can move 
and open and close these windows as you wish. (You cannot remove them.) You can arrange 
them (relative to your current workspace area) by clicking ‘Cascade’, ‘Tile’, or ‘Arrange Icons’ 
in the Window menu. 

5 Workspace

The workspace provides a working area for open configuration pages. (There are up to 19 
configuration pages, depending on MCPM type.) You can open, or minimize, any combina-
tion of configuration pages. Until you have opened or created a configuration file, no config-
uration pages are visible and certain menus are grayed out (disabled). See Menus on 
page 27 for details. 

6 Master control tree

The master control “tree” lists the IP addresses of the MCPMs and MCEs you have identified. 
The tree is a great convenience, although not strictly required. The tree may contain MCPMs 
and MCEs that do not exist yet. 

When you first launch MasterConfig, MasterDiag, or MasterLogo, the tree will be empty. You 
can add, remove, or change entries at any time in any of these 3 applications. 

When you highlight an IP address in the tree, that address becomes the current IP address 
and the various commands in the ‘File’ menu apply to that specific IP address (and its associ-
ated MCPM or MCE). If you have read a file from an MCPM or MCE or written a file to an 
MCPM or MCE, the file’s pathname appears under the IP address in the tree.

An MCPM or MCE need not appear in the tree. You can read from and write to an MCPM or 
MCE directly by entering its IP address independently. (See Communications Menu on 
page 31.)

This guide refers to the MCPM or MCE at the current IP address as the current MCPM.

You can adjust the width of the master control tree area by pointing to, and dragging, its 
right-hand border left or right. You can close the master control tree area by clicking the 
small X in the upper right corner of the tree area. You can redisplay the tree by choosing 
‘Master Control Tree’ from the ‘View’ menu.

7 Status bar

The Status Bar displays a brief line of “help” information for some of the menu and tool bar 
commands. You can hide or show the status bar by clicking ‘Status Bar’ from the ‘View’ 
menu.

8 Target IP address

At the right end of the status bar (if it is visible) MasterConfig displays the current IP address 
and also indicates (as a side effect) whether the keyboard functions ‘Caps Lock’, ‘Num Lock’ 
and ‘Scroll Lock’ are on.
26



MasterConfig
User’s Guide
Menus 
This is the menu bar: 

The following sections describe the menus:

File Menu Communications Menu Window Menu Help Menu
Actions Menu View Menu Tools Menu

File Menu
The ‘File’ menu lets you open and save configuration files and transfer configuration data to and 
from MCPMs or MCEs: 

Following are descriptions of the File menu commands.

New
Click ‘New’ to create a new configuration. If you have not saved changes to current configura-
tion data, you will be asked whether you want save changes.

When you create a new configuration, MasterConfig presents a dialog in which you specify the 
MCPM type and video standard: 

Thereafter, the configuration is locked to that MCPM type and video standard. 

The file extension for MCPM configuration files is .cfg.

Open
Click ‘Open’ to display the standard Open dialog, which allows you to open an existing configu-
ration for editing. If you have not saved changes to current configuration data, you will be asked 
whether you want save changes.
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Close
Click ‘Close’ to close the configuration that you are editing. If you have not saved changes to 
current configuration data, you will be asked whether you want save changes.

Save, Save As
Click ‘Save’ to save the current configuration file. Click ‘Save As’ to save the current configuration 
to a file with another name.

Read Config from MCPM
Click ‘Read Config from MCPM’ to get a configuration from the current MCPM. A “Read Configu-
ration from MCPM” dialog appears: 

The command transfers the MCPM or MCE configuration data to the file named in the dialog. 
You can browse to select or name a file.

The dialog shows the following:

• The “Save it to” field shows the pathname of the file in which to save the configuration.

• The “MCPM IP Address” field identifies the MCPM or MCE from which you will read the data.

Click ‘OK’ to start the read or click ‘Cancel’ to cancel the read. 

After it reads and saves the files, MasterConfig will ask whether you also want to open the file for 
editing. Click ‘OK’ if you wish to open the file.

Test config with MCPM
Click ‘Test Config with MCPM’ to test you present configuration against the features of an 
installed MCE. A dialog appears in which you may enter the IP address of the MCE: 

If you have selected an MCE in the master control tree, the dialog will suggest its IP address.
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If the IP address you enter is non-existent, you will see an Ethernet socket error message: 

If the IP address you enter does not correspond to an MCE, you will see an error message: 

If you have attempted to test a configuration for an MCPM other than an MCE, you will see an 
error message: 

If you are testing an MCE configuration against an existing MCE, you will see zero or more warn-
ings or errors messages followed by a summary report. These are samples of report messages: 

The summary report tells you the number of warnings and errors. 

The configuration you are testing matches the installed MCE if the number of warnings is 0 and 
the number of errors is 0.

There are a number of warnings and one error message that you might see. Please refer to 
Testing Configurations against Installed MCEs on page 207 for a complete list. 

Note that these tests are run automatically for any MCE configuration when you write the 
configuration to the MCE. 
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Write config to MCPM
Click ‘Write Config to MCPM’ to write a configuration to the current MCPM. A “Write Configura-
tion to MCPM” dialog appears: 

The command transfers configuration data from the file named in the dialog to the MCPM or 
MCE identified. You can browse to select or name a file. You can change the IP address in the 
dialog.

The ‘Configuration to Write’ field shows the pathname of the file whose data will be written to 
the MCPM or MCE.

The ‘MCPM IP Address’ field identifies the MCPM or MCE to which to write the data. You may 
specify the IP address in the dialog. If you specify an address that is not in the Master Control 
tree, MasterConfig will present a query that asks you whether you want to add the address to 
the tree. Click ‘OK’ if you wish to do so. That IP address becomes the current address (and 
appears in the lower right corner of the MasterConfig window.)

Finally, click ‘OK’ to write the file to the MCPM (or MCE) or click ‘Cancel’ to cancel the transfer. 

Configuration data differ for each MCPM type. Writing a configuration to an MCPM of the wrong 
type will have disastrous results. Accordingly, MasterConfig does not allow you to write a file of 
the wrong type. If you attempt it, it presents a message such as the following: 

A write to an MCPM can involve logos. If you have many logos and if they are large, the write can 
take several minutes. You have the choice of whether to include logos in the write. 

A write to an MCE can involve up to 400 logos. The write can take a long time. MCEs, unlike other 
MCPMs, store logos in non-volatile memory. Once loaded, the logos need not be reloaded. You 
have the choice of whether to include logos in the write. 

(Logos will have been defined in MasterLogo. MasterConfig, in fact, uses MasterLogo to transfer 
the logos.)

For MCEs, the ‘Write Config to MCPM’ command detects version discrepancies.

Exit
Click ‘Exit’ to quit MasterConfig. If you have not saved changes to current configuration data, 
you will be asked whether you want save changes.
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Actions Menu
The ‘Actions’ menu has two commands: 

Following are descriptions of the Actions menu commands.

Error Check Config...
Click ‘Error Check Config...’ to display the ‘Check for errors’ dialog: 

If you want MasterConfig to perform error checking, click ‘OK’. If MasterConfig detects errors, it 
produces a report such as the following: 

If it finds no errors, MasterConfig produce no report, but notifies you that the error check is 
finished: 

MasterConfig performs partial error checking any time you click an ‘Apply’ button to apply 
changes to the configuration.

Apply All Outstanding Changes
Click ‘Apply All Outstanding Changes’ to commit all uncommitted changes to the configuration. 

This command does not cause the configuration to be saved to a file. The configuration remains 
open for further editing.

Communications Menu 
The ‘Communications’ menu has just one command: 
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Click Ethernet to MCPM...’ to display the “MCPM IP Address” dialog: 

This dialog lets you enter an IP address for an MCPM or MCE. The address you enter here 
becomes the current IP address, representing the current MCPM. If the address is not in the 
master control tree, MasterConfig asks you whether you want to add it to the tree.

The current IP address is always displayed in the lower right corner of the MasterConfig window. 
It remains active until you select another address.

The current IP address must correspond to an actual MCPM or MCE only when you want to 
read from or write to an MCPM or MCE. It is in MasterDiag that you set the actual IP address. 

Check the ‘Log Comm Messages’ box if you want to create a log of all communications 
messages. 

View Menu
This is the ‘View’ menu: 

Following are descriptions of the View menu commands.

Toolbar
Click ‘Toolbar’ to show or hide the tool bar. This command is a toggle. (The check mark indicates 
that the tool bar is enabled.) See Tool Bar on page 37 for more information.

Status Bar
Click ‘Status Bar’ to show or hide the status bar. This command is a toggle. (The check mark indi-
cates that the status bar is enabled.). 

Master Control Tree 
Click ‘Master Control Tree’ to make the master control tree visible. This command is not a toggle. 
Once the tree is visible, the command has no apparent effect. To hide the master control tree, 
click the small X in its upper right corner of the tree area. 

You can resize the master control tree area by clicking and dragging its right-hand border.
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This is the ‘Window’ menu: 

The menu is partitioned: the first 3 commands control the appearance of the configuration 
pages in the work area. The other commands show various configuration pages. The list of 
configuration pages in the menu can vary. The number of configuration pages depends on the 
MCPM type specified in the configuration.

Cascade
Click ‘Cascade’ to cascade (and resize) all open configuration pages, with the current page on 
top so it is visible. All minimized pages remain minimized at the bottom of the screen.

Tile
Click ‘Tile’ to tile (and resize) all open configuration pages, based on the current width of the 
Main Screen. All minimized pages remain minimized at the bottom of the screen. 

(Tiling means that all open pages are distributed equally and visibly in the work area.)

Arrange Icons
Click ‘Arrange Icons’ to arrange all minimized pages in a compact array at the bottom of the 
work area, relative to the current width of the main window. Open pages are left unchanged.

The term “icon” here means a minimized page image.

The Other Commands
Choose one of the listed configuration pages (e.g., ‘Main Sources’) to open that page for editing. 
While you are editing, the ‘Window’ menu shows additional information: 

A check mark appears adjacent to the active configuration page.

Asterisks appear when unsaved changes are present.

Click this to get a list of all configuration pages

Item name
Asterisks — unsaved changesCheck Mark
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When edits are in progress, the menu shows the item being edited next to the page name.

Click ‘More Windows...’ to display the ‘Select Window’ dialog (which lists all1 configuration 
pages). 

Select the configuration page you want and click ‘OK’ to open that page for editing.

See Chapter 4, Operation on page 49, for details regarding configuration pages.

Tools Menu 
The ‘Tools’ menu has just one command: 

Click ‘Options’ to display the following dialog: 

Choose one of the 3 options in the drop-down list and click ‘OK’. Click ‘Cancel’ if you do not wish 
to choose an option. 

These options do not affect the MCPM, but control how MasterConfig applies changes to your 
configuration data:

• Not automatic.

1. Some configuration pages might not apply to the MCPM you are configuring and will not be listed.
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You must click the ‘Apply’ button to commit changes made in configuration pages. If you 
switch to another item in a list before applying changes, MasterConfig displays this dialog: 

You would click ‘Yes’ to apply the changes, ‘No’ to discard the changes, or ‘Cancel’ to discon-
tinue switching to the other list item.

If you save a configuration that has outstanding changes, MasterConfig displays this dialog: 

Click ‘Yes’ to save the file with the changes. Click ‘No’ or ‘Cancel’ stop the save operation, pre-
serving the changes but leaving the file unchanged.

• Automatic for all.

When you change any item, MasterConfig applies the changes to the item without a confir-
mation dialog. 

When you save the file, MasterConfig applies all changes and saves the file without display-
ing any confirmation dialog.

• Automatic for MainSrcs.

When you change a main source, MasterConfig applies the changes to the source without a 
confirmation. All other parameters require you to click ‘Apply’.

When you save the file, MasterConfig does display the “provisional changes” dialog if there 
are changes to items other than main sources.

Help Menu
The ‘Help’ menu has two commands: 

Click ‘About MasterConfig...’ to display the software version: 
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Click ‘Obtaining Technical Support’ to see technical support contact information: 
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Tool Bar
The Tool Bar provides an array of icons that are meant to be editing shortcuts. 

Many of the icons are not operational. You can show or hide the tool bar with the “Toolbar’ 
command in the ‘View’ menu. These are the icons, from left to right:

Editing Basics 
Following are general guidelines for editing in any of the configuration pages. 

See Chapter 4, Operation on page 49, for detail regarding each configuration page.

Making Changes 
MasterConfig’s configuration pages fall into two classes: 

Parameters Only
When you make a change to one or more parameters, click ‘Apply’ for the changes to take effect. 
Click ‘Cancel’ to discard your changes. Click ‘Default’ to obtain default values.

You also can click ‘Apply all outstanding changes’ from the ‘Actions’ menu. 

“Applied” changes do not affect the saved configuration file until you actually save the configu-
ration to the file.

List-Based Parameters
Configuration pages with lists (such as the ‘Keyer Sources’ page) require that you either select 
an entry in a list or create a new entry in a list. Click ‘New’ to create a new entry. Click ‘Delete’ to 
delete an entry. Click an entry in the list to select the entry. You might need to scroll the list to 
find the entry you want.

Same as File > New Paste, not implemented

Same as File > Open Print, not implemented

Same as File > Save Same as Help > About MasterConfig

Cut, not implemented Unimplemented function

Copy, not implemented

Parameters Only List-Based Parameters
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When you click ‘New’, or when you select an entry in the list, the configuration page expands to 
allow you make changes to your list entry. An additional button appears — ‘Apply’: 

After making changes, click ‘Apply’ for your changes to take effect. If you are creating a new list 
entry, you must click ‘Apply’ to add the new entry to the list. 

See the ‘Options’ command in the ‘Tools’ menu for information about applying changes.

Asterisks 
When you make a change to any setting within a configuration page, an asterisk appears in the 
header. This is a visual reminder that you have unapplied changes: 

If you have made any changes to a configuration, an asterisk appears next to the configuration 
file name in the Title Bar. This is a visual reminder for you to save the configuration file: 

Selection Numbers 
Many configuration pages refer to a “selection number” or “selno” in a list: 

Selection numbers define the position of items in a list. For example, the main sources belong to 
a list. When you add a main source to the list, its “selno” places it in the ordering of he list entries. 
The lists are used in MasterConfig and also appear in the menus of a control panel.

(In minimized header)
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By default, the selection number given to a new list entry is the lowest unused selection 
number. If the list is full, you cannot create a new source. 

Many lists allow gaps in the numbering. In all cases, the items in the list are ordered by the selec-
tion numbers, from lowest to highest. 

In the case of GPI inputs and outputs, selection numbers identify the actual GPI inputs or 
outputs as well as the position of the configuration in the GPI list. 

Be careful when numbering list items because it is a nuisance to renumber them. 

Numbering
In MasterConfig’s configuration pages, a zero (0) entered in a data field disables the function 
represented by the field, unless otherwise stated.

All numbered items start counting at 1, not 0.

MCPM Numbering
Main source inputs are numbered from 1 to 128, from 1 to 64, or from 1 to 16, depending on the 
MCPM. 

Discrete audio sources are numbered either from 1 to 128 or from 65 to 128, depending on the 
MCPM. An audio source is a stereo pair, comprising two channels, nominally left (L) and right (R). 
Each channel can be treated as an independent (mono) source, however.

Embedded audio sources have no connectors and therefore no connector numbers. MCPMs 
however accept up to 8 embedded audio channels, numbered from 1 to 8.

MCE Numbering
Main source inputs are numbered from 1 to 128, some of which can be obtained from connec-
tors 1–64 of the NV5100MC backplane. 

Discrete audio sources are numbered from 65 to 128. An audio source is a stereo pair, 
comprising two channels, nominally left (L) and right (R). Each channel can be treated as an 
independent (mono) source, however.

Embedded audio sources have no connectors and therefore no connector numbers. MCEs 
however accept up to 16 embedded audio channels, numbered from 1 to 16.

Audio Channel Numbering
Main sources can be associated with up to 16 audio channels. Over sources can use up 16 audio 
channels. There is an ‘Initial Values’ button in the Main Sources configuration page and in the 
Over Sources configuration page that automatically enables and fills all the audio channels. 

The details are specified in the descriptions of the pages.
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Source-to-Button Mapping 
A typical system has far more sources than panels have buttons. There are several ways to map 
sources to source buttons: 

• Button mapping

• Source groups

• Router preselect

A control panel’s button mapping menu provides source group selection when it is control-
ling an MCE for which source groups are enabled and supports main source button mapping 
when it is controlling an MCE for which source groups are disabled. 

Button Mapping
“Button mapping” is a feature you can enable or disable in the ‘General Settings’ page.

An NV5100MC master control frame supports up to 128 main sources and up to 4 over sources. 
Router pre-select further allows any router source (of perhaps thousands) to be mapped to any 
main source button or to any over source button. 

Master control panels have up to 24 main source buttons. Master control panels also have up to 
2 audio over buttons. 

Control panels must have a way to access any of up to 128 main sources on 16 buttons. They 
must have a way to access any of 41 over sources on 2 buttons. 

The method is called source-to-button mapping, or just button mapping. It is fairly simple. In 
MasterConfig, you designate one or more buttons as user-modifiable or system-modifiable, or 
both. The panel operator can then assign any main source to a user-modifiable button (by 
choosing the source from a menu) and automation can assign a main source to a system-modi-
fiable button. (The operator’s panel must be configured to support this.)

MasterConfig provides two button-mapping configuration pages, one for main sources, and 
one for over sources. 

Please note:

• Automation does not “care” about buttons. If a button is defined ‘system-modifiable’ then it 
will use the button; otherwise, it will use any other button. However, if any button has been 
assigned a source that automation is to use, automation will choose that button. Automa-
tion is not affected by program/preset button states.

• Automation uses an LRU (least-recently used) button selection scheme.

• (Unless or until something interferes with the automation, the LRU scheme is also round-
robin.)

• Where there is automation, it is advisable to designate more than one button as system-
modifiable. Four system-modifiable buttons are optimal.

• It is possible for the operator to turn automation off. 

1. (Or 5 overs.) An extra over is in use when dual squeezeback is enabled (in the MCE or MCPM-SDHD).
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See Button Mapping—Main Source (page 147) and Button Mapping—Over Source (page 150) 
in Chapter 4, Operation.

Source Groups
“Source Groups” can also be enabled or disabled in the ‘General Settings’ page.

You can define any number of source groups. A group defines what sources appear on a control 
panel and on which buttons they appear. Panel operators can select which source group they 
want on their panel at any time. 

A group may have up to 24 sources because that is the maximum number of source buttons on 
any panel. Typically, your source groups would be smaller. Source groups are defined for each 
MCE, so source groups can differ for panels that control different MCEs. 

Sources can be replicated in multiple source groups. For instance, you could have a particular 
source always available on source button 1, regardless of which group is selected. 

Router Pre-Select 
“Router Preselect” is a feature you can enable or disable in the ‘General Settings’ page.

If you have an NV9000 router control system connected to your master control system, you can 
define a main source or an over source as a “router preselect” source. When a source is a router 
pre-select source, the operator can assign one of potentially thousands of router sources to a 
button: 

Any router source can be routed to a router destination. The router destination is connected (by 
cable typically) to one of the master control inputs. That input will have been assigned to one of 
the panel’s main source button. 

Router preselection applies to sources whereas the terms “user-modifiable” and “system-
modifiable” apply to buttons.

A router pre-select source can also be a user-modifiable button. 

It is in the panel configuration software, not MasterConfig, that router source selection is 
configured. 

A master control frame can accommodate both a master control system and a multi-format 
router (MFR). The MFR and master control system can be used in conjunction. See applica-
tion note AN0004-xx Routing and Master Control for more information.
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If the router source (and 
destination) are multi-
level, there would be one 
cable for each level.
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External Router Sources 
“External router sources” is a feature you can enable or disable in the ‘General Settings’ page.

The concept of “external router sources” extends the notion of “router pre-select.” External 
router sources simplifies some of the panel operator’s tasks and adds a small amount of 
complexity to MCPM configuration. 

“External router sources” is like router pre-select, where an operator may select a router source 
as a main source, but note these differences:

• You, the configurer, decide which router sources are selectable and add those to the ‘Main 
Sources’ list or to the ‘Over Sources’ list as you deem appropriate. That way, the operator 
selects external router sources in exactly the same way as local sources (those connected 
directly to the NV5100MC frame.

• Key sources and squeeze image sources may be external router sources. 

• You can intermix external and local key sources in the ‘Key Sources’ list and you can intermix 
external and local squeeze images in the ‘Squeeze’ and ‘Squeeze 2’ lists.

• The numbers of external sources (main, over, key, squeeze) are limited by the size of the list 
in the MCPM (at most 128 list entries). 

‘ExtRtrSrc Settings’ Page
Use this configuration page to connect router destinations to master control inputs. The 
connections consume up to 30 input ports at the back of the master control frame, depending 
on which external router sources are enabled and how many discrete audio inputs are required. 

The ‘ExtRtrSrc Settings’ page differs for MCEs and other MCPMs. For MCEs, there are two sub-
pages, one that configures external connections to the program and preset buses, and another 
that configures external connections to the preview bus. For other MCPMs there is just a single 
page (that configures connections to the program and preset buses).

The router destinations are 

Main sources A and B Over sources A and B
Keyer sources 1, 2, and 3 Squeeze background and “image 2 video.” 

Some MCPMs do not have squeezeback and some do not have “image 2 video.” Some MCEs 
might lack certain video effects also.

Because there are two (active) buses, program and preset, the pool for main sources and the pool 
for over sources each have two members. Because there are 3 keyers, the pool of key destinations 
has 3 members. 

The use of the ‘ExtRtrSrc’ configuration page requires that you specify a virtual IP address for 
your NV9000 router control system. (The NV9000 you have must therefore support virtual IP 
addresses.)

Compared to Router Preselect
Compared with router pre-select, “external router sources” saves a few keystrokes (and time and 
thought) while the operator selects external main and over sources, but also allows the selec-
tion of external key sources and squeeze sources, which router pre-select does not allow. 

The drawback is this: external source selection is limited to the small number of sources the 
MCPM or MCE allows, not the entire space of the router system.
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IP Addresses
An MCPM’s IP address, once assigned in MasterDiag, cannot be changed except in MasterDiag. 

In MasterConfig, you can enter IP addresses or choose different IP addresses. There are several 
ways to do so:

1 Right-click “MCPM” in the master control tree: 

Click ‘Add MCPM’. You will get the MCPM Configuration dialog: 

Key in the address and optionally a name for the MCPM. Click ‘OK’.

2 Right-click an IP address in the Master Control tree: 

Click ‘Edit Name and IP Address’ to get the MCPM Configuration dialog: 

Key in the address and optionally a name for the MCPM. Click ‘OK’.

3 Choose Communications > Ethernet to MCPM to get a dialog: 
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Key in the address and click ‘OK’. If the address you specify is not in the master control tree, 
MasterConfig will displays this dialog: 

Click ‘Yes’ if you want to add the IP address to the master control tree.

4 Choose File > Write Config to MCPM. Enter a new IP address in the resulting ‘Write Configura-
tion to MCPM’ dialog: 

Operational Overview 
Following are three typical operating procedures for MasterConfig:

• New Configuration 

Create a new configuration
Edit 
Save to file
Write to the MCPM or MCE.

• Modifying an Active Configuration 

Read from MCPM
Edit 
Save to file
Write back to the MCPM or MCE.

• Modifying a Stored Configuration 

Open a file
Edit 
Save the file
(Optionally) write to the MCPM or MCE.

Please review these procedures before you continue with Chapter 4, Operation. 
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New Configuration
Follow these basic steps to create a new configuration file and write it to an MCPM:

1 Launch MasterConfig.

2 Click File > New to create a new configuration file.

3 Go through all configuration pages, entering all appropriate data for your audio and video 
sources, key sources, logos, squeezeback effects, etc. 

4 When you have completed all configuration pages, save the configuration file by clicking 
File > Save (or Save As). In the dialog, name the file and click ‘OK’. Browse if you need to select 
a folder for the file.

5 To send the configuration to the MCPM or MCE, click File >Write Config to the MCPM.

In the ‘Write Configuration to MCPM’ dialog, verify that the IP address correctly identifies the 
MCPM you want to configure. Double-check that the configuration file name displayed is the 
right file.
Click ‘OK’ to write the file to the MCPM or MCE.

6 At a control panel, systematically test the new configuration.

Make further changes to the configuration file if they are needed. Refer to Modifying an 
Active Configuration, next, for a basic procedure.

Modifying an Active Configuration 
Follow these steps to modify an existing active configuration (one that is running on an MCPM 
in the master control system):

1 Launch MasterConfig.

2 Select an MCPM. 

Either highlight the MCPM in the master control tree or choose Communications > Ethernet 
to MCPM... to select an MCPM.

3 Read the configuration data from the MCPM or MCE.

Click ‘File >Read Config from MCPM’ to get the configuration data. 

In the ‘Read Configuration from MCPM’ dialog, verify that the IP address correctly identifies 
the MCPM or MCE you want to read. Browse if you need to select a folder and file for the 
data. 

Click ‘OK’ to read the data.

4 Select and edit the parameters in all configuration pages applicable to your intended 
change. 

5 When you have finished editing, save the configuration file by clicking File > Save. 

6 Write the file back to the MCPM or MCE by clicking File > Write Config to MCPM.

In the ‘Write Configuration to MCPM’ dialog, verify that the IP address correctly identifies the 
MCPM or MCE you want to configure. Double-check that the configuration file name dis-
played is the right file.

Click ‘OK’ to write the file to the MCPM or MCE.

7 At a control panel, test the parameters of the new configuration.

Make further changes to the configuration file if they are needed.
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Modifying a Stored Configuration 
Follow these basic steps to edit an configuration that is stored on the configuration PC:

1 Launch MasterConfig.

2 Click File > Open. 

3 In the ‘Open’ dialog, select the configuration file that you want to edit. Browse if you need to 
select a folder for the file. 

Click ‘OK’ to read the file.

4 Select and edit the parameters in all configuration pages applicable to your changes. 

5 When you have finished editing, save the configuration file by clicking File > Save. 

6 Optionally, write the file to the MCPM or MCE by clicking File >Write config to MCPM. If all 
you want to do is change the file, you need not write to the MCPM or MCE.

In the ‘Write Configuration to MCPM’ dialog, verify that the IP address correctly identifies the 
MCPM or MCE you want to configure. Double-check that the configuration file name dis-
played is the right file.

Click ‘OK’ to write the file to the MCPM or MCE.

7 At a control panel, test the parameters of the new configuration.

Make further changes to the configuration file if they are needed.

Understanding Your System
Working with MasterConfig requires a detailed understanding of the physical structure of your 
system. Designing the physical structure of your system depends to some small degree on 
knowing what you can configure your MCPMs and control panels to do. 

These are some of the details you will have to know to configure an MCPM or MCE:

• The MCPM types in use in your system. 

What are their signal types?
How many inputs does each support? 
Which ones have Dolby decoders? 
Which have wing outputs and how are they to be used?

Which of the MCPMs are MCEs? How many cards do the MCEs have? How many DVEs? How 
many Dolby decoders?

• The input type and connector numbers for all inputs at the rear of the frame.

Which audio inputs are used with which video source?
Which inputs are for video keyers? 
Which inputs are audio overs?
Which inputs are for squeezeback?

• The number and type of all embedded audio signals

Which are Dolby?
How many audio channels do you want to embed as output?

• Whether an NV9000 router control system is in use.

Which router outputs are to be used for router-preselect?
What are the source devices (identified by category and index) to be used in master control.
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• Whether an Intuition XG graphics processor (with its companion software) is present.

Is the Intuition XG processor a single- or dual-channel processor?

How many XG layers (up to 4) do you want? 

XG keys operate using MCE keyers. Can you sacrifice an MCE keyer (or two) while an XG key is 
in effect? 

The presence of XG layer buttons on a panel mean that other functions must be sacrificed. 

• What are the machine control and pre-roll parameters of the devices in your system?

Do you have at least one DC21 Device Controller?

There are many other higher-level issues that cannot be addressed in this guide. You might wish 
to read Miranda’s application note AN0004 Routing and Master Control for information about 
building a master control system. 
47



Usage
Operational Overview
48



Operation
Chapter 4 provides operating instructions for the MasterConfig application. 

Topics
New Configurations  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  50
General Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  51
Machine Control  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  56
Main Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  58
Source Groups . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  87
Over Sources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  94
Audio Monitors and Meters  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  103
Keyer Sources . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  116
Logo Images  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  121
Logo Keyer Sources  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  124
Squeeze Settings1 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 130
Squeeze 2 Settings2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
RS-422 Communication Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  144
Button Mapping—Main Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  147
Button Mapping— Over Source  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  150
Misc. Settings . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  152
Video Effect and Over Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  157
Transition and Fade to Black Settings  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  161
GPI Inputs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  163
GPI Outputs  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  165
Wing Outputs3 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 169
Aux Outputs4  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 170
ExtRtrSrc Settings (for MCEs) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  172
ExtRtrSrc Settings (for MCPMs) . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  189
Intuition XG  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . .  196

These topics cover the 21 individual configuration pages. You should always start a new config-
uration by completing the general settings. (Most MCPMs use a subset of the 21 configuration 
pages.)

1. Not for MCPM-MK-SD or -MK-HD.
2. MCPM-SDHD and MCE only.
3. MCPM-HD, -HD2, and -SDHD only.
4. MCE only.
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New Configurations 
Choose ‘New’ from the ‘File’ menu to create a new configuration. The ‘New Configuration’ dialog 
appears: 

Fig. 4-1: New Configuration Dialog (Sample)

It is in this dialog that you specify the MCPM type for the configuration and the video standard 
for that MCPM type. MCEs are included in the list. The standards available in the drop-down 
menu depend on the MCPM type.

Click ‘OK’ to create the new configuration. Click ‘Cancel’ if you do not want to create a new 
configuration. Once you have created a new configuration, it becomes bound to the MCPM type 
and video standard you have chosen. If you make a mistake, you can simply discard the new 
configuration and start over.

As a reminder, there are 7 types of MCPMs:

MCPM-SD MCPM-MK-SD MCPM-SDHD
MCPM-HD MCPM-MK-HD MCE
MCPM-HD2

Also as a reminder, there are two categories for video standard:

For SD systems (MCE or other), you can select either 525 or 625. 

For HD systems, you can select 1080i 59.94 Hz, 1080i 50 Hz, or 720p 59.94 Hz. 

For HD MCEs, the choices are:

1080i 50 Hz 1080i 59.94 Hz
720p 50 Hz 720p 59.94 Hz

Configurations for one type/standard combination cannot be applied to MCPMs (or MCEs) of 
another type or standard.
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General Settings
The ‘General Settings’ configuration page defines fundamental MCPM attributes: 

Fig. 4-2: General Settings Page (Sample)

Follow these guidelines to enter your MCPM’s general settings: 

1
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Settings for MCPMs that are not MCEs

Settings for MCEs

19
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1 The ‘MCPM Name’ field displays the MCPM or MCE name, up to eight characters in length. 
This is simply a readable tag that is associated with the MCPM’s IP address. When you read a 
configuration from an MCPM or MCE, its name is displayed here. You can enter or change the 
name in this field. 

2 The ‘MCPM Type’ field displays the MCPM type. The MCPM type was specified when the con-
figuration was created. This setting identifies the MCPM(s) or MCE(s) to which this configura-
tion can apply.

3 The ‘Video Standard’ field displays the video standard for the MCPM or MCE. The video stan-
dard was specified when the configuration was created. 

For SD systems, you will have selected either 525 or 625. 

For HD systems, you will have selected 1080i 50Hz, 1080i 59.94Hz, or 720p 59.94Hz.

For an MCE, you will have selected 1080i 50Hz, 1080i 59.94Hz, 720p 50Hz, or 720p 59.94Hz.

This line rate must match the video reference signal supplied to the MCPM(s) or MCE(s) you 
want to configure. If the reference and the video rate do not match, the system might not 
pass video to the MCPM (or MCE) outputs. 

4 Check the ‘Enable NV9000 Preselect’ box if you want to use any NV5100MC backplane input 
as a router pre-select source. Router pre-selection applies to main sources and over sources 
only. Router pre-selection lets operators select video and audio signals from potentially 
thousands of router sources. 

When router pre-select is enabled, a “Pre-select” section appears in the ‘Main Sources’ con-
figuration page. We recommend you have an NV9000 router control system properly config-
ured and connected to the MC network when configuring these functions.

5 Check the ‘Enable External Router Source’ box if you want to use router sources as main 
sources, over sources, keyer sources, or squeeze image sources. See External Router Sources 
on page 42 for more information.

Checking this option enables the ‘ExtRtrSrc Settings (for MCEs)’ configuration page.

When this feature is enabled and you have enabled specific groups of router sources in the 
‘ExtRtrSrc Settings’ configuration page, “external router source” options appear in related 
configuration pages. We recommend you have an NV9000 router control system properly 
configured and connected to the MC network when configuring these functions.

6 Check the ‘Enable Main Source Button Mapping’ box if any of these points apply to you. 

• You have more than 16 main sources. 

• You want a specific source-to-button mapping, not the default.

• You want operators (or automation) to be able to assign main sources to a button. 

Checking this option enables the ‘Button Mapping - Main Source’ configuration page with 
which you define main-source-to-button mappings. If you do not check this option, that 
page will not be available.

We recommend that you check this option. You can also enable main button mapping later. 

The ‘Enable Main Source Button Mapping’ check box is absent if you check ‘Enable 
Source Groups’. Button mapping and source groups are mutually exclusive concepts that 
accomplish the same purpose.
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7 Check the ‘Enable Over Source Button Mapping’ box if any of these points apply to you:

• You have more than 2 audio over sources. 

• You want a specific source-to-button mapping, not the default.

• You want operators (or automation) to be able to assign over sources to a button. 

Checking this option enables the ‘Button Mapping - Over Source’ configuration page with 
which you define over-source-to-button mappings. If you do not check this option, that 
page will not be available.

We recommend that you check this option. You can also enable over button mapping later. 

8 ‘Enable Source Groups’.

(This option appears only when you are editing an MCE configuration.)

Check this option if you want the MCE to use source groups. Source groups are groups of 
main sources. The sources in the group are assigned to specific positions among a panel’s 
main source buttons. A panel operator can then select one source group or another and use 
the sources that appear subsequently on the panel’s buttons. 

Checking this option enables the ‘Source Groups’ configuration page, in which you can 
define the source groups for an MCE configuration.

In the MCE in which source groups are enabled, bank selection is disabled. In addition, 
the button mapping page of panels controlling the MCE has an entry for source groups, 
but lacks an entry for mapping main source buttons. For MCEs where source are not 
enabled, or for other MCPM types, the panels’ button mapping page has the entry for 
mapping main sources and lacks the source group function.

9 ‘Enable Monthly Log’.

(This option appears only when you are editing an MCE configuration.)

Check this option to enable a monthly log. Otherwise, there will be no monthly log. 

This option does not affect the startup log and the running log. You can browse the monthly 
logs using MasterDiag and save any log file to a directory where you can read the log.

10 In the ‘Maximum # of Audio Channels’ field, specify the maximum number of audio channels 
that you wish to control. MCPMs allow 2, 4, 6 or 8 channels. The MCPM has an 8-channel 
audio processor and embeds 8 audio channels in program output no matter how many 
channels you use. MCEs allow 2, 4, 6, 8, 10, 12, 14, or 16 channels. MCEs have 16 internal 
audio channels and allow up to 16 embedded audio channels. MCEs embed 16 channels in 
program output no matter how many channels you use. Any unused channels are forced to 
silence.

This entry affects the number of audio channels that appear in the ‘Audio Channels’ section 
of the ‘Main Sources’ configuration page, and the number of channels that appear in the 
audio menus of a control panel. 

11 ‘MCE is 16 Channel Capable’ (for MCEs only).

Under most conditions, this check box should be checked. What it does is enable all the 
advanced features of the MCE, including 2048 main sources and 16-channel audio. 

It is only when you want an MCE to be compatible with older MCPMs, for instance so that an 
MCE can be ganged with an MCPM, that you would uncheck this check box. 
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12 Check the ‘Enable Disembedders’ box if you want to use main sources having embedded 
audio. Clear the check box if the MCPM or MCE does not need to process embedded audio. 

When the disembedders are enabled, additional items appear in the ‘Main Sources’ page 
that allow you to configure and route the embedded audio sources. 

It is always safe to check this box, even if no sources have embedded audio.

13 Check the ‘Has DolbyE Decoders’ box if your MCPM includes the Dolby E decoder option. 
Clear the check box if the Dolby E option is not installed. 

Dolby E audio is not available in the MCPM-MK-SD or -MK-HD. If you have selected either 
of these as the MCPM type, MasterConfig does not display any Dolby E options.

MCEs can include up to 8 Dolby E modules.

Dolby E requires an interlaced video reference format. Dolby E is compatible with a 720p 
video source as long as the video reference is 525i, 625i, or 1080i.

14 If you check the ‘Has DolbyE Decoders’ box, an additional check box (‘Enable Backup Audio’) 
appears. Check this box if you wish to specify backup source(s) for your Dolby-E main 
sources. The actual backup source you choose depends on how your system hardware is set 
up.

When you check the ‘Has DolbyE Decoders’ box, an additional checkbox appears in the 
‘Main Sources’ configuration page, providing additional Dolby E options.

15 Check the ‘Enable AutoRestore of Audio Mixer Settings’ box to enable “Auto Restore” capa-
bility for all main sources. If you check this box, an ‘Auto Restore Audio Mixer Settings’ 
appears on the Main Sources configuration page. 

When it is enabled in the ‘General Settings’ page, ‘Auto Restore’ can be applied to main 
sources individually. What “Auto Restore” does is cause the main source to revert to its 
default audio settings every time it is chosen on the preset bus. 

16 Click ‘Apply’ to commit all changes, updating the configuration with the new general infor-
mation. Or click ‘Default’ to start over with default settings. 

You can change general settings at any time. (Note that some configuration data that 
depend on general settings can be affected.)

17 Dolby Decoder Options. This section appears only if you are configuring an MCE. Check the 
boxes in this section that apply:

As of software release 6.3.3, it is possible to use two Dolby decoders for a source. Thus, it is 
possible to have Dolby stream 1 assigned to audio output channels 1–8 and Dolby stream 2 
assigned to audio output channels 9–16.

Note that, for Dolby, the MCE requires an AXM board. The AXM board can have from 0 to 8 
Dolby decoders. 

If the MCE has no preview board, the AXM’s decoders might be enough to support unre-
stricted dual decoder operation. In such a configuration, 4 decoders are allocated to pro-
gram and preset main sources and 4 decoders are allocated to program and preset over 
sources. That accounts for all 8 decoders. 

If the MCE has a preview board, you can have dual decoders on either the program/preset 
overs or on preview main sources, but not both. These are the options: 
54



MasterConfig
User’s Guide
• No preview board. The option is simply whether you want dual Dolby decoders: 

This allows dual decoders for main sources and over sources on program and preset.

• Preview board plus dual decoders for main sources on program, preset, and preview. 

• Preview board plus dual decoders for main sources and overs on program and preset: 

This does not allow dual decoders for the preview bus.

Note that the dual Dolby decoder options allow an MCE with no preview board and 4 Dolby 
decoders (A–D) to support dual decoders for main sources but not over sources. 

The dual Dolby decoder options affect certain fields in the ‘Main Sources’ page.
18 MCE Configuration Options. This section appears only if you are configuring an MCE. Check 

the boxes in this section that apply:

a Has AXM board. Check this box if the MCE includes an MCE-AXM (audio expansion) card.

b Has PVW board. Check this box if the MCE includes an MCE-PVW (preview) card.

c Enable main squeeze. Check this box if the MCE has DVE cards appropriate for basic 
squeezeback. (The term “main squeeze” means the squeeze background image.)

d Enable P2 squeeze. Check this box if the MCE has the additional DVE cards appropriate 
for image 2 squeezeback. (The term “P2 squeeze” means squeeze image 2.)

19 NV9000 network address(es). 

This section does not appear unless you have checked ‘Enable NV9000 Preselect’ or ‘Enable 
External Router Source’ (and you have clicked ‘Apply’). 

If you have a NV9000 system connected to your master control system, you should enter the 
IP addresses of the primary (and optionally, secondary) NV9000 controllers here.

However, if your NV9000 system has a virtual IP address, enter that for the primary address. 

If you have enabled external router sources and not router pre-select, this section of the 
general settings page changes: 

In this case, you must enter a virtual IP address. (This requires that the NV9000 system sup-
port virtual IP addresses.) The ‘ExtRtrSrc’ page also requires you to enter the virtual IP 
address because external router sources require the use of a virtual IP address. 

20 Machine control settings. 

Machine control is available only for MCEs. See Machine Control, following, for information.
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21 Continue with the next page that you wish to edit. If you have a new configuration, that win-
dow would typically be the ‘Main Sources’ window.

Machine Control 
There are 2 somewhat related parts to this general settings section: 

• Machine Control.

• Pre-Roll. (Pre-roll also applies to Intuition XG operation.)

Machine Control
Place a check in the ‘Enable Machine Control’ checkbox to enable machine control features here, 
in the Main Sources configuration page, and ultimately in the MCE. 

When the box is checked, these machine control options appear:

• Cue Button.

• Device Controller IP Address. 

Cue Button 
This option controls an MCE function that is triggered when the operator presses a ‘Cue’ button 
on a panel. 

One choice is for the MCE to cue the device to the “marked point”— the beginning of the first 
frame of desired video. (A ‘Mark’ button on a control panel sets the “marked” point.)

The other choice is for the MCE to cue the device to the “pre-roll point”— the place at which to 
begin the pre-roll. (The pre-roll point is in advance of the mark point by a main source’s pre-roll 
value.) 

Device Controller IP Address 
The IP address given here is the address on the master control network of the DC21 device 
controller that performs machine control on behalf of the MCE. This field is not optional when 
machine control is enabled.

A DC21 is a requirement for machine control.

Pre-Roll 
Place a check in the ‘Enable Preroll’ checkbox to enable pre-roll features, here, in the Main 
Sources configuration page, and ultimately in the MCE. 

When the box is checked, the ‘System Preroll in Frames’ field appears. The system pre-roll value 
applies during all pre-roll transitions, whether under automation or under operator control. The 
system pre-roll is used this way: 

A transition’s pre-roll period is: 

max (effective pre-roll, system pre-roll) 

where effective pre-roll is:

max [ all (source pre-roll + source latency) ]

(More than one source might be subject to pre-roll during a transition.)
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A system pre-roll value of 0 essentially removes system pre-roll from calculations. If system pre-
roll is longer than any effective pre-roll supported by the MCE, then all pre-roll transitions will 
have exactly the same pre-roll period. 

If your MCE processes interlaced video, use a pre-roll time based on 25 or 29.97 frames per 
second. If it processes a progressive format, use a pre-roll value based on 50 or 59.94 frames 
per second. That is, the pre-roll value for progressive formats is double the pre-roll value for 
interlaced formats. 

(If pre-roll is enabled) each main source has a pre-roll value of its own, possibly 0. This pre-roll 
value defines the operating characteristics of that particular source. The MCE calculates the pre-
roll point for all devices used in a transition according to the maximum of (1) the pre-roll value of 
those devices and (2) the system pre-roll value. 

A system pre-roll value of 0 means that it is never considered in calculations. The maximum 
system pre-roll value is 300 (frames).

Pre-roll is used when media such as VTRs are present in your master control system. 

Devices subject to machine control do not necessarily have pre-roll values.
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Options 
Section

Audio 
Channels 
Section
Main Sources 
The ‘Main Sources’ page lets you define an MCPM’s or MCE’s main sources (video inputs with 
associated audio). This is a representative view of the page as it might appear for an MCE: 

The main sources governed by this configuration page can include:

• Local sources (video connections at the master control frame’s backplane).

• External sources (devices connected to routers under an NV9000 control system).

• External squeeze “background” images (i.e., squeeze 1 images).

• Local or external squeeze “image 2” images (i.e., squeeze 2 images).

The meanings of “main source” and “squeeze source” overlap. 

A main source can also be internally generated black/silence.

Main
Source

List

 Source
Section

 Bulk Add
and Delete

 Machine
Control
Section
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This is a view of the ‘Main Sources’ page as it might appear for an MCPM-SD: 

There are differences in the way MasterConfig handles the main sources of MCEs and MCPMs. 
The page for MCPM-SDs has fewer fields, only 8 audio channels, and no machine control fields. 
Machine control fields are available only for MCEs. 

The main source pages for other MCPM types are similar to the page for the MCPM-SD, with 
some variation. 

Purpose
In general, this is what the ‘Main Sources’ page does:

• Names the main sources. (The source names appear on the buttons of control panels.)

• Identifies the video input for a main source.

• Identifies the audio sources and describes the audio processing for a main source. 

• Creates a permanent association between the video and audio sources selected.

• For MCEs, defines the machine control (and pre-roll) characteristics of the main source.

Your master control system has video and audio devices connected to inputs at the rear of the 
frame. This are local devices or local sources. This configuration page tells the MCPM which of 
those inputs to use, and how they are used. 

This page also configures router pre-select sources. A router pre-select source identifies a router 
destination connected to the backplane of the NV5100MC frame. During operation, master 
control operators choose the router source to route to that destination. The router source 
becomes available — through the backplane — as a main source. (Router pre-select must be 
enabled in the ‘General Settings’ page.)

Main
Source

List

Source Section Audio Channels Section

Options 
Section
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This page also configures “external router sources”— those feeding one or more routers in an 
NV9000 router control system. The source’s connections are defined in the NV9000 configura-
tion. (External router sources must be enabled in the ‘General Settings’ page.)

The set of external router sources is determined during configuration (of the MCE or MCPM). The 
set of router pre-select sources is determined during NV9000 configuration and might vary 
during day-to-day operation.

The source list defined in this page can include squeezeback images. It must include squeeze-
back images if any squeezeback effect (regular or enhanced) uses a “main source.”

Regardless of the source type, the video portion of a main source appears as a video signal at a 
BNC connector at the backplane of the NV5100MC frame. Associated with the video source are 
(up to) 16 audio signals. Those audio signals can vary in type and origin. Thus, the audio 
portions of the ‘Main Sources’ configuration page vary and can be somewhat complex.

The video signals you select must be compatible with the type and video standard of the 
MCPM or MCE. 

Local sources for an MCPM-MK-HD are from the 16 BNCs on the -MK-HD’s own backplane 
module only.

Page Organization
The ‘Main Sources’ configuration page has 6 sections: 

1 The main source list shows sources that have already been created. They can be edited.

2 The source section specifies the video source and the type of audio to associate with the 
video. Choices for audio, which depend on options chosen under General Settings, include:

Discrete AES or discrete analog audio.

Audio embedded in the video source.

Dolby E format, discrete or embedded, single or dual decoders.

You can also specify the duration (in frames) of the pre-roll period for the selected source.

3 The audio channels section lets you specify the audio source and details of each audio chan-
nel to be associated with the video source. 

4 The machine control section lets you specify the machine control and pre-roll characteristics 
of the main source. 

(Machine control options assume the presence of a DC21 Device Controller in the master 
control system.)

5 The options section allows you to configure backup audio for embedded Dolby E and to 
enable or disable “auto restore” for the main source. Either or both of these options might 
not be enabled (visible).

6 The bulk add and delete section allows you to add multiple sources at one time and to 
delete multiple sources at one time. (It is available only for MCEs.)

Main Source List 
The main source list includes all the main sources you have defined for the MCE or MCPM. The 
list does not have to include all sources, only those sources relevant to the MCE or MCPM. As 
mentioned, main sources can include local, external, router pre-select, or squeeze image 
sources.
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If the list contains external router sources, the list shows the NV9000 configuration’s names for 
the sources, and their database IDs, in parentheses: 

To configure a source, it must be in the main source list. You can add entries to the list and 
remove or copy entries in the list. The mnemonic (name) of a source should be meaningful to 
control panel operators.

The list is ordered by selection number (selno). Be careful when numbering the sources because 
it is a nuisance to renumber them. Selection numbers may range from 1 to the maximum (128, 
64, or 16, depending on the MCPM, or 2048 for MCEs). Gaps in the numbering are permissible.

If you have not checked the ‘Enable Main Source Button Mapping’ option in the general 
settings page, the main source selection numbers are also button numbers. This de facto 
mapping places source n on button n where 1 < n < 16 and sources with other selnos are 
inaccessible. See Button Mapping—Main Source on page 147.

For MCEs, the ‘Enable Main Source Button Mapping’ option is not available if you have 
checked ‘Enable Source Groups’ in the general settings page. We recommend that you 
enable either button mapping or source groups. 

To Create a Single New Source
Click ‘New’. You may edit the source’s parameters now or at any time. Click ‘Apply’ to commit 
changes to the main source definition.

If you are developing an MCE configuration, you can create more than one source at time 
using the ‘Bulk Add Window’ button below the source list. See Bulk Add and Delete on 
page 62 following. 

To Delete a Source
Highlight the source in the list and click ‘Delete’. 

If you are developing an MCE configuration, you can delete more than one source at time 
using the ‘Bulk Delete Window’ button below the source list. See Bulk Add and Delete on 
page 62 following. 

To Copy a Source
Highlight the source in the list. Give it a new unused selection number (selno) and click ‘Apply’. If 
you choose an existing selection number, you will overwrite an existing source definition.
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To Edit a Source
Highlight the source in the main source list and modify the parameters you want to change. 
Click ‘Apply’ to confirm your changes at any time. If you wish to cancel your changes, either click 
another source or click ‘New’. A query appears: 

Click ‘No’ to discard your changes.

Not all changes can be undone. In particular, if you have clicked ‘Initial Values’ the audio 
channel defined for the main source cannot be undone, except by manually changing the 
values. 

Bulk Add and Delete 
If you are developing an MCE configuration, you can create more than one source at time using 
the ‘Bulk Add Window’ button below the source list. And you can delete more than one source 
at time using the ‘Bulk Delete Window’ button below the source list.

Bulk additions and bulk deletions are available only for MCEs.

When you click the ‘Bulk Add Window’ button, an ‘Add Sources’ dialog appears. There are two 
forms of the dialog, depending on whether you choose to add “master control” or external 
router sources. (Master control sources are those connected directly to the backplane of the 
NV5100MC frame. These are also called “local” sources.)

Either dialog allows you to specify 

• The number of sources to add

• A base name for the new sources

• Whether to choose the starting number for the new sources automatically

• Several other parameters that depend on whether you are adding a “master control” (or 
local) source or an external router source. 

When you click the ‘Bulk Delete Window’ button, a ‘Delete Sources’ dialog appears. In this dialog 
you can select the main sources to delete. Your selection does not have to be contiguous.

See Bulk Add for ‘Master Control’ Sources on page 63.

See Bulk Add for ‘External Router’ Sources on page 65.

See Bulk Delete on page 68.
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Bulk Add for ‘Master Control’ Sources 
This is the bulk add dialog for “master control” sources: 

Fig. 4-3: Add Sources Dialog for “Master Control” Inputs

At the top left is a drop-down menu that lets you select whether to add local (i.e., master 
control) sources or external router sources. The fields in the window change, depending on 
which mode you select. 

These are the fields of the window that are applicable to “master control” sources:

• Template

At the top right is a checkbox. If you check this box, the bulk add operation uses the (exist-
ing) source you have selected in the main sources window as a pattern, or “template,” for cre-
ating the new sources. That means the new sources will take on the audio configuration of 
the template. 

For master control (i.e., local) sources, if you choose a template, you should choose a local 
source as your template. 

• Starting Number

Below the upper checkbox is a second checkbox. If you check this box, the bulk add opera-
tion will use the lowest available unused “selno” as starting point and work upward from 
there, consuming only unused selnos. 

If you leave that checkbox unchecked, you should enter a valid selno in the ‘Starting Source 
Number’ field. 

Note that 0 (zero) is not a valid selno. 

• Four Letter Mnemonic

Enter up to 4 characters in this field. The name of each source created will have these charac-
ters as a base and a 4-digit numerical suffix. (If the 4th character of this string is a space, the 
bulk add operation will generate source names having a space between the base name and 
the suffix.)
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• Number of Sources to Add

In this field, enter the number of sources you want to add to the source list. 

• Starting Video BNC 

Enter the video connector number for the first of your new sources. The connector numbers 
for your new sources will start at this connector number and work upward from that. These 
connectors are at the backplane of the NV5100MC frame supporting the sources. The 
assumption is that there are, or will be, real cable connection for these sources. 

• Starting Audio BNC 

Enter the audio connector number for the first of your new sources. (If the new sources have 
no audio connectors, leave this field blank.)

The audio connector numbers for your new sources will start at this connector number and 
work upward from that. These connectors are at the backplane of the NV5100MC frame sup-
porting the sources. Again, the assumption is that there are, or will be, real cable connection 
for these sources. 

It is expected that you might have to make some minor adjustments to the configuration 
of the automatically generated sources. 

Operation 
Specify the parameters for your new sources and click ‘Add Sources’. The bulk add operation 
gives you a confirmation message about your addition before it continues: 

Click ‘Yes’ if you accept the confirmation statement. The operation will respond with a comple-
tion message: 

This is a typical result, and the result of the settings in Figure 4-3: 
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Undo
After you add sources, an ‘Undo Add Sources’ button appears in the bulk add window: 

If you make a mistake, you can “undo” the bulk add by clicking the ‘Undo Add Sources’ button. 

The button is persistent: it remains available unto you open another configuration or restart 
MasterConfig.

Bulk Add for ‘External Router’ Sources 
This is the bulk add dialog for “external router” sources: 

Fig. 4-4: Add Sources Dialog for External Router Sources

At the top left is a drop-down menu that lets you select whether to add local (i.e., master 
control) sources or external router sources. The fields in the window change, depending on 
which mode you select. 

These are the fields of the window that are applicable to “external router” sources:

• NV9000 Sources Pool

The external router sources to be added are the ones you select in the ‘NV9000 Sources Pool’ 
list. You can select any sources you want in this list. Your selection does not have to be con-
tiguous.

The sources you add are given local names consisting of a 4-letter mnemonic and a numeric 
index. The indexes are assigned to the sources in the order in which the appear in the 
‘NV9000 Sources Pool’ list.

The number of sources you choose is the number of sources that will be added.
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• Template

At the top right is a checkbox. If you check this box, the bulk add operation uses the existing 
source you have selected in the main sources window as a pattern or “template” for creating 
the new sources. The new sources will take on the audio configuration of the pattern. 

For external router sources, you should choose an existing external router source as your 
template. 

• Mnemonic

Enter up to 4 characters in this field. The name of each source created will have these charac-
ters as a base and a 4-digit numerical suffix. (If the 4th character of this string is a space, the 
bulk add operation will generate source names having a space between the base name and 
the suffix.)

• Starting Number

Below the upper checkbox is another checkbox. If you check this box, the bulk add opera-
tion will use the lowest available unused “selno” as starting point and work upwards from 
there. 

If you leave that checkbox unchecked, you should enter a valid selno in the ‘Starting Source 
Number’ field (which is not shown in the illustration). 

Operation 
Specify the parameters for your new sources, choose one or more sources from the NV9000 
source pool, and click ‘Add Sources’. The bulk add operation gives you a confirmation message 
about your addition before it continues: 

Click ‘Yes’ if you accept the confirmation statement. The operation will respond with a comple-
tion message: 
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This is a typical result: 

The new sources have individual names in the configuration and they also have names defined 
in the NV9000 configuration. In this example, the source named ERS 0001 is named Vid111 in 
the NV9000 system: 

You can choose whether the NV9000 names or the MasterConfig names appear on panel 
buttons in the ExtRtrSrc Settings (for MCEs)’ configuration page. 

Undo
If you make a mistake, you can “undo” the bulk add by clicking the ‘Undo Add Sources’ button 
that appears after a bulk add: 

The new sources added are named ERS 0001–ERS 
0006.

Here, the bulk add operation of this example had 
an automatic starting point, using the lowest 
unused “selnos.” The new sources appear in sepa-
rate places in the list, that is, wherever there were 
unused selnos. 

Local name

NV9000 name (and database ID)
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Bulk Delete 
When you click the ‘Bulk Delete Button’ in the main sources window, the ‘Delete Sources’ dialog 
appears: 

Figure 4-5. Bulk Delete Window

Highlight the sources that you wish to delete. Then click the ‘Delete Sources’ button. The 
following alert appears: 

Click ‘Yes’ if you accept the confirmation statement. The operation will respond with a comple-
tion message: 
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Source Section 
It is in the source section that you specify the type of main source and start to define the associ-
ation between video and audio sources. 

Parts of the source section vary according to choices you make in the ‘General Settings’ page 
and settings in the source section itself. 

Selection Number
Either use the supplied value or enter a value from 1 to the maximum allowed. This number 
defines the source’s position in the main source list. See Selection Numbers on page 38.

Mnemonic
Enter the name that you want to appear on a control panel’s main source button, up to 8 charac-
ters. Use alphanumeric characters, spaces, or underbars. Although you can enter other 
characters, the panels will not display them. 

Source Type Selection 
Directly beneath the mnemonic field is a drop-down list for source type: 

There are 3 choices:

• Master Control Input.

• Internal Black

• External Router Input.

Master Control Input
Choose ‘Master Control Input’ if you want a local video source — one that is connected directly 
at the NV5100MC backplane. The source section displays a ‘Video Input’ box: 

• Enter the BNC number of the input in the ‘Master Control Input’ field. (The BNC number is 
relative to the port numbering of the frame backplane unless you are configuring an MCPM-
MK-HD, in which case the numbering is relative to the -MK-HD’s backplane.)

• Check the ‘Is Analog’ box if the selected source is analog video. 

Analog inputs are converted to SD at the input card. If the video standard of the MCPM is HD, 
the ‘Is Analog’ box is not present. There is no analog-to-HD conversion. There is no analog 
option for MCEs. 

MCPM-SD MCE
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The choice you make in this field — if it is present — affects the content of the video input 
subsection and the audio channels section. Analog video does not contain embedded 
audio.

• If the general settings for the MCPM or MCE allow disembedded audio, the ‘Embedded 
Audio Input’ drop-down menu is present in the video input subsection. Otherwise it is 
absent. 

If the video source does not have embedded audio, choose ‘Not Embedded’. 

Otherwise, for MCEs, specify ‘May Be Embedded’. Which embedded channels are to be used 
is specified in the audio channels section at the right.

For other MCPMs, however, you must specify in which AES groups the audio is to be found. If 
the input as analog, ‘Not Embedded’ is the only choice allowed.

The choice you make in this field — if it is present — affects the content of the Dolby E sub-
section and the audio channels section. 

Internal Black
Choose ‘Internal Black’ if you want the main source to use the internal black/silence generator. If 
you do select this option, all other ‘Main Sources’ options disappear: 

Audio for these sources is internally generated silence.

The “mixer/keyers” (MCPM-MK-SD and -HD) do not provide an internal black signal. 

External Router Input
External Router Input is not available unless you have (1) enabled external router sources in 
the General Settings and (2) enabled external main sources in the ExtRtrSrc Settings (for 
MCEs) page. 

Choose ‘External Router Input’ if you want an external video source — one that is connected to 
routers in an associated NV9000 router control system. If you choose this option, the source 

MCPM-SD MCE
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section displays a drop-down list that allow you to select a source defined in the NV9000 
configuration. 

Fig. 4-6: External Main Source (Sample, MCPM-SD)

External router Input for MCEs and MCPMs is similar, but MCEs do not allow analog inputs and 
embedded audio for MCEs is handled in the audio channels section.

If you don’t have the NV9000 system connected during configuration, the drop-down list 
does not appear. In that case, you must enter by hand the database ID for the source you 
want.

• Check the ‘Is Analog’ box (if present) if the selected source is analog video.

Analog inputs are converted to SD at the input card. If the video standard of the MCPM is HD, 
the ‘Is Analog’ box is not present. There is no analog-to-HD conversion. There is no analog 
option for MCEs.

The choice you make in this field — if it is present — affects the content of the video input 
subsection and the audio channels section. Analog video does not contain embedded 
audio.

Dolby E Subsection
This subsection of the configuration page describes the audio input when it is Dolby E encoded. 
The subsection is not present unless you check ‘Has Main DolbyE Decoders’ in the general 
settings page. 

The appearance of the fields in this section change depending on what you have configured for 
‘Embedded Audio Input’.

The subsection has extra fields for MCEs that have dual Dolby decoders enabled (in the general 
settings). These samples illustrate some of the choices for MCPMs and MCEs that do not use 
dual Dolby decoders:

MCPM-SD
MCE

(A) (B) (C)
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Follow these guidelines: 

• Leave ‘Source has DolbyE Audio’ unchecked if the video source does not use Dolby E audio. 
No other options appear, as in sample (A). Otherwise you must specify the Dolby E source, as 
in samples (B) or (C). There are two choices:

• A discrete Dolby E input. The video input can be analog or digital, but it does not have 
embedded audio. You must specify the input connector number, as in sample (B). It 
might or might not be a BNC connector. 

• The video source does have embedded audio, and the Dolby E audio can either be 
embedded or discrete. Check the ‘Dolby E is Embedded’ checkbox if it is embedded and 
choose the channel pair that is to feed the Dolby E decoders in the MCPM, as in sample 
(C). An MCE allows Dolby E from any channel pair: 

If the Dolby E audio is not embedded, specify an input connector as for sample (B).

The following samples illustrate choices for MCEs that do use dual Dolby decoders:

Follow these guidelines for dual decoders: 

• Leave both ‘Source has DolbyE Audio’ and ‘Use Second DolbyE Dec.’ unchecked if the video 
source does not use Dolby E audio. No other options appear, as in sample (D). Otherwise you 
must specify the Dolby E source, as in samples (E) or (F). There are two choices for each 
decoder:

• A discrete Dolby E input. The video input can be analog or digital, but it does not have 
embedded audio. You must specify the input connector number, as in sample (E). It 
might or might not be a BNC connector. 

• The video source does have embedded audio, and the Dolby E audio can either be 
embedded or discrete. Check the ‘Dolby E is Embedded’ checkbox if it is embedded and 
choose the channel pair that is to feed the Dolby E decoders in the MCPM, as in sample 
(F). 

If the Dolby E audio is not embedded, specify an input connector as in sample (B) or (F).

(E) (F)(D)
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Notes:

1 If you have checked ‘Enable Main Backup Audio’ in the general settings, and the main source 
uses Dolby E audio, the ‘Has Backup Audio’ checkbox appears in the options section. Check-
ing that box enables further configuration options. 

2 If your MCE has dual Dolby decoders, they apply either (1) to main sources and overs on the 
program and preset buses or (2) to main sources on program, preset, and preview. 

Router Pre-Select Subsection
This section is present if (1) you have checked ‘Enable NV9000 Preselect’ in the general settings 
and (2) the source is a master control input, not an external router input. The pre-select options 
are the same for MCPMs and MCEs. These samples illustrate the choices: 

Leave the ‘Is Preselect’ checkbox unchecked (sample A) if the main source is not a router pre-
select source. 

If you check the ‘Is Preselect’ box, you must select an NV9000 destination ID in the drop-down 
list. The drop-down list shows all the NV9000 destinations. Sample B shows 4 router destina-
tions. (The numbers following the colons in the entries are the destination IDs in the NV9000 
database.)

This field will not be a drop-down list unless your master control system is connected to an 
NV9000 system. In this case, you must enter a source ID directly. 

Sample (C) shows a destination selected. The following points are two of the many factors to 
consider when connecting a router destination to the master control frame:

• An NV9000 destination often include signals on several “levels.” For example, a destination 
might include an HD video signal and 4 AES signals. In that case, 5 cables must connect to 
the backplane’s input section, one from an HD router and 4 from an AES router (or routers). 
The main source would be the video connector and the configuration for that main source 
would specify the 4 AES audio connectors.

• The destination might be SD or HD with embedded audio. In that case, a single video cable 
would connect to the backplane’s input section, and the main source would be configured 
for embedded audio. 

Control panel configuration in the MCS Panel Configuration Editor is required for router 
pre-select to work. 

(A)

(B)

(C)
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Audio Channels Section 
The audio channels section supports many options. The functions that appear in the audio 
channels section vary depending on the MCPM type, other choices you have already made in 
the Main Sources page, and choices you have made in the General Settings page.

The audio channels section differs for local sources and external sources. It is not available for 
internal black sources. (See Audio for External Router Sources on page 81 for more information.)

The audio channels section differs for MCEs and MCPMs. One major difference is that MCEs 
support 16 audio channels and MCPMs support 8 channels. MCEs also do not accept analog 
audio.

The audio channels section for external router sources is also different from the audio channels 
section for local sources. 

MCEs and HD MCPMs allow discrete audio inputs in the range 65–128. The MCPM-SD and 
MCPM-MK-SD allow audio inputs in the range 1–128.

These are audio formats supported: 

Discrete audio (at a backplane connector) is either AES, Dolby E, or analog (converted to AES). 
Connectors can be BNCs, Phoenix 3-pin (STP), or DB25.

Embedded audio (AES) is carried in a video signal in up to 16 channels (4 groups of 4 channels). 
MCPMs extract (disembed) 8 channels from any 2 of the groups. Your configured main source 
can either use the extracted audio or ignore it. MCEs extract (disembed) up to 16 channels from 
any of the 4 groups. Here too, your configured main source can either use the extracted audio or 
ignore it. 

All internally processed audio is AES. 

The MCE has an option where embedded audio can bypass internal processing and go directly 
to output. This is called pass-through. Discrete audio does not bypass internal processing. 

MCPMs do not have the pass-through option.

Dolby E is a compression format carried in a single AES channel pair. The Dolby E decoder, if 
present, extracts the signal data from an input pair, producing 5 AES channel pairs as input to 
the internal audio processor. Each of the 5 generated channel pairs, when selected during 
configuration, consumes 2 internal audio channels. 

With Analog Video (Converted to SD at the Input Card)

No audio

Discrete audio: any combination of analog, AES, or Dolby E audio

With Digital Video (HD or SD)

No audio

Discrete audio: any combination of analog, AES, or Dolby E audio

A combination of embedded AES, embedded Dolby E, and discrete audio (analog, AES, or Dolby E)

With Any MCE

No audio

Discrete audio: any combination of AES or Dolby E audio

A combination of embedded AES, embedded Dolby E, and discrete audio (AES or Dolby E)
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Automatic Channel Numbering
There is an ‘Initial Values’ button in this configuration page that automatically enables and fills 
all the audio channels. 

Audio channel changes made using the ‘Initial Values’ button cannot be undone. We 
recommend you save your configuration prior to using the button. 

There are 3 effects of clicking the ‘Initial Values’ button:

• When ‘Not Embedded’ is selected and no audio channels are enabled.

Clicking ‘Initial Values’ fills the entire audio channel list with default values, starting at con-
nection number 65 and incrementing by 1, with alternating “A” and “B” channels. 

• When ‘Not Embedded’ is selected and you have specified a starting number (at least 65) in 
the first channel. 

Clicking ‘Initial Values’ fills the entire audio channel list with default values, starting at con-
nection number you specified and incrementing by 1, with alternating “A” and “B” channels. 

• When ‘May Be Embedded’ is selected.

Clicking ‘Initial Values’ fills the entire audio channel list with default values for embedded 
channels, starting at channel 1 and incrementing by 1 for each channel. 

The operation completely overwrites any settings you previously assigned to the audio 
channels.

The number of audio channels is limited by the maximum you specify in the General 
Settings page.

Audio Section Structure
When you first create a main source, the audio channels section is empty: 

Audio
Channel

Numbers

“Use”
check
boxes

MCPMs

MCEs

Audio 
Channel 
Numbers

“Use” 
check 
boxes
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An audio channel is represented by a row in this section. To enable an audio channel for the 
main source, check the ‘Use’ box in the row. Leave a box unchecked if you do not want to use 
that audio channel. 

The number of rows in the section is equal to the maximum number of audio channels you set 
in the general settings. The illustration above shows all 8 or 16 channels. It is not necessary to 
use all available channels. Unused channels are forced to silence. 

When you enable an audio channel, its gain field and invert checkbox appear. 

The gain field expresses the default gain (audio level). Operators can generally adjust the gain, 
overriding this value. A gain of 0 dB is unity gain. Unity gain means the digital audio values are 
multiplied by 1 — essentially a no-op. 

Check the “invert” checkbox if you wanted to invert the audio signal. Internally, audio signals are 
PCM values. The MCE or MCPM multiplies the PCM data by –1 when it inverts the audio.

The word “phase” in the header is meaningless. Please ignore it. 

If you are configuring an MCE, you will see a column of ‘Pass-Thru’ checkboxes. Pass-through 
means that the audio goes directly to output with any internal processing. Consequently, the 
gain and invert options are absent for pass-through channels:

Audio Channel Types 
There are 3 basic types of audio channel data. They can be intermixed: 

• Discrete audio input (analog or AES).

• Disembedded AES.

• Dolby channel (discrete or disembedded).

Parts of the column headers in the audio channels section can become obscured when 
the channel types are intermixed. 

Although MCPMs accept analog audio, MCEs do not.

(For MCEs only, the gain and invert fields disappear when you check a 
‘Pass-Thru’ checkbox. Pass-through is available for embedded audio for 
which the embedding channels have been properly specified.)

Note

Audio sources should be applied to the MCPM or MCE at the correct level. Excessive 
use of internal gain can cause problems with overall headroom (clipping) or signal-
to-noise ratio.

Pass-through channels must be ordered 
pair-wise, as shown here. If the channel 
numbers are not ordered, the software 
removes the pass-through option for that 
pair.
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Discrete Audio
For a discrete audio input, specify the connector number and which of the two parts (L or R) of 
the input to use: 

Here, the left input channel of the audio input is called A and the right audio input channel is 
called B. This is for generality: you might be treating the inputs as mono signals, for instance. A 
typical stereo input uses two paired audio channels: 

Such a pairing is not a requirement.

The same method is used for both analog and AES inputs. 

Disembedded AES
For MCPMs, embedded audio occurs in 4 AES channel pairs (1/2, 3/4, 5/6, and 7/8). For MCEs, 
audio can be embedded in AES pairs 1/2, 3/4, and so on, up to pair 15/16. 

Here, check the box in the ‘from Disembedder’ column to specify disembedded audio. The row 
changes its appearance when you check the box: 

Then indicate, in the ‘Channel’ column, from which embedded channel to obtain the signal. 

Observe that this column allows you to form an arbitrary mapping between embedded chan-
nels and the internal audio channels. You could, for instance, direct a single embedded channel 
to any or all internal audio channels. 

Dolby Channel
To use Dolby E audio, you must have checked the ‘Has Main Dolby E Decoders’ in the general 
settings. (The MCPM or MCE must actually have the decoders if a Dolby configuration is to 
function.)

The “mixer/keyers” (MCPM-MK-SD and -MK-HD) do not support Dolby E audio. Sections of 
the ‘Main Sources’ configuration pages that pertain to Dolby E audio do not appear when 
you are configuring one of the mixer/keyers.

MCEs have a dual Dolby decoder option. If your MCE has dual Dolby decoders, they apply either 
(1) to main sources and overs on the program and preset buses or (2) to main sources on 
program, preset, and preview. The ‘Main Sources’ page can specify sources for each of the dual 
decoders (when they are enabled in the general settings). 
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A row in the audio channels section has a ‘From Dolby’ checkbox if you have checked ‘Source 
has Dolby E Audio’ and have given a Dolby E source. The Dolby E source can be discrete (if you 
entered a connector number) or embedded (if you checked ‘Dolby E is Embedded’ and selected 
a channel pair).

In either case, you must check the ‘from Dolby’ box if the internal audio channel is to obtain 
input from the Dolby E decoder. When you check the box, the row changes appearance: 

A Dolby decoder generates 5 AES outputs:

• Channels 1/2 — L (left) and R (right).

• Channels 3/4 — C (center) and LFE (low-frequency effects)

• Channels 5/6 — Ls (left surround) and Rs (right surround)

• Channels 7/8 — Lt, Rt. (Lt and Rt are a stereo downmix of channels 1–6.)

• Aux (Lt, Rt).

If you have an MCE configured for dual decoders, you can choose any of 10 output pairs in the 
drop-down list in the ‘Dolby Xpt’ column. For other MCPMs and MCEs not configured for dual 
decoders, you can choose any of five output pairs in the drop-down list in the ‘Dolby Xpt’ 
column: 

Because the outputs are paired, the Dolby output consumes two adjacent internal audio 
channels. 

The 5 outputs of the second of two decoders are prefixed with ‘2: ‘.

Although the MCPM produces video output with embedded audio channels, it does not 
embed Dolby E audio or emit Dolby E output. 

Single 
decoder

Dual 
decoders
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Mixed Audio Configurations 
You can combine audio types in many ways. The limits are what you can do with your hardware 
and signal types. This is a sample of a main source with mixed audio sources: 

Be aware that when audio channels are of mixed type, the column headers match only the first 
(used) row. Other rows might have data fields that do not match the header. If you need to 
remind yourself what the data fields mean, you can uncheck the ‘Use’ box in the rows above the 
row in which you are interested. The headers will then match the data in that row. Re-check the 
‘Use’ boxes to restore those rows to their former state.

You can hover your mouse over data fields to display contextual help messages: 

Backup Audio for Dolby E Signals
It is possible to lose the Dolby E signal. You can configure each source that uses Dolby E audio to 
have a backup audio source if loss occurs. 

Note that master control panels can have buttons that force Dolby E backup or display Dolby 
E backup status. 

For sources that use Dolby E audio, you will have checked ‘Source has DolbyE Audio’. You will 
have specified whether the Dolby E audio is embedded or discrete. You will also have checked 
‘Enable Main Backup Audio’ in the general settings page. When these 3 conditions are met, the 
‘Has Backup Audio’ checkbox appears in the options section of the ‘Main Sources’ page: 

There is an option in the ‘Video Effects and Over Settings’ page that controls the rate at which 
the backup audio takes over. The rate can either be a fast fade (4 frames) or a “hard cut.” If the 
MCE switches to backup audio and “hard cut” is enabled, there is no loss of audio.

Dolby (Output 1/2 Selected)

Two embedded channels

Pass-Through 

Discrete Input
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See Video Effect and Over Settings on page 157.

Check this box to enable backup audio. When you do, the ‘Main Sources’ page acquires addi-
tional buttons that allow you to toggle between the “main” and “backup” configurations: 

The sample main source in this illustration has Dolby E audio from a local source. It uses 3 Dolby 
E channel pairs and audio from one addition connector (81): 

Backup audio is enabled. Press ‘Go to Backup’ to switch to the backup view. The following illus-
tration shows the backup view for this main source: 

Only the audio channels that are assigned Dolby E input are enabled. In this sample, audio chan-
nels 1–6 carry Dolby E audio ordinarily. Therefore, audio channels 1–6 are enabled for backup. 
This sample uses audio from 3 connectors, 97–99, as backup for the Dolby E. 

Press ‘Go to Main’ to switch back to the “main” view.
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How you obtain the backup audio and synchronize it with the main Dolby E audio is a 
subject that MasterConfig does not address. 

Audio for External Router Sources
Main sources (other than those used as squeeze images) reach the MCE or MCPM through the 
master control frame’s A and B ports designated in the ‘ExtRtrSrc Settings ‘ page. The “A” ports 
include a principle video connector, 4 AES connectors, and an extra video connector for the case 
of embedded audio under breakaway. The “B” ports should be configured identically although 
the connector numbers differ. Not all audio connectors need be used. 

External router sources are available only for MCEs and MCPM-SDHDs. 

If the external source’s audio channels are not embedded (i.e., you chose “not embedded”) the 
audio channel use the discrete AES inputs specified in the ‘ExtRtrSrc Settings ‘ page. 

Audio channels 9–16 are not available on discrete AES inputs. Although there are fields for these 
channels in the page for an MCE configuration, you should not use them.

Some of the discrete channels might carry Dolby E: 

MCE MCPM-SDHD
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The typical MCE source that has embedded audio has 16 channels: 

For these sources, you should specify that audio ‘may be embedded the page’s ‘Embedded 
Audio Input’ field. (An MCPM-SDHD requires that you select in which groups the embedded 
audio can be found.) 
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When you choose ‘may be embedded’ for an MCE or a pair of groups for an MCPM-SDHD, you 
can mix audio options in the audio channels section as you wish: 

The channel specifications should match the router’s source characteristics and correspond 
correctly to the backplane connections you have made and the backplane connection defini-
tions in the ‘ExtRtrSrc Settings’ page.

Pre-Roll Section
Pre-roll is available only for MCEs.

The pre-roll section is absent if pre-roll is not enabled in the general settings. 

It specifies the pre-roll time (in frames) for the main source. A zero value means that pre-roll is 
turned off for the main source. The value must be in the range 0–300. When there is a non-zero 
pre-roll value among the preset sources, the pending transition becomes a pre-roll transition. 
Otherwise the transition is a normal transition. (However, when the system pre-roll value is non-
zero, all transitions are pre-roll transitions.)

If your MCE processes interlaced video, use a pre-roll value based on 25 or 29.97 frames per 
second. If it processes a progressive format, use a pre-roll value based on 50 or 59.94 frames 
per second. 
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Machine Control Section
Machine control is available only for MCEs.

The machine control section is absent if machine control is not enabled in the general settings: 

When it is present, the machine control section has these fields: 

• Type/Protocol.

• Control Port or GPIO Pair.

• Default Transition Type.

• Default Transition Rate.

Type/Protocol 
There are 3 choices in drop-down menu of this field: 

• None

This is your choice if the main source does not require machine control.

Machine control applies to VTRs and similar devices. If the main source device is not a VTR 
(or similar device), there is probably no need for machine control.

• Use GPIO

This choice allows you to choose a GPIO (output) port pair for machine control of this main 
source. There are 32 outputs so there are 16 pairs. 

The odd-numbered member of a pair represents a ‘Start’ command. The even-numbered 
member of a pair represents a ‘Stop’ command. The ‘Start’ and ‘Stop’ commands are 100 ms 
pulses.

This is the appearance of the machine control section for GPIO control: 

There is no time-code field as there is for serial control.

• Use serial protocol

This choice allows you to choose one of the 4 serial ports for machine control.

This is the appearance of the machine control section for serial control: 
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Choose an appropriate time-code “mode” for the device represented as the main source. 
The choices are 

Ctrl track LTC VITC VDCP elapsed time

Usually LTC is the best choice. Devices that use VDCP require ‘VDCP elapsed time’.

Other than ‘None’, the choices refer to ports at the rear of the DC21 Device Controller. If you 
have selected a serial port or a GPO pair for one main source, it becomes unavailable in the 
drop-down lists for other sources.

Control Port or GPIO Pair 
The drop-down menu in this field differs according to the choice you picked in the ‘Type/
Protocol’ field: 

If you picked ‘None’ for ‘Type/Protocol’, this field will not appear.

If you picked ‘Use GPIO’ for ‘Type/Protocol’, the drop-down menu is a list of GPIO port pairs that 
have not yet been assigned. You must choose a pair unless the list is empty (you’ve used up all 
the pairs). The limit is 16 sources that can do machine control through GPIO pairs for any partic-
ular MCE.

If you picked ‘Use serial protocol’ for ‘Type/Protocol’, the drop-down menu is a list of serial ports 
that have not yet been assigned. You must choose a port unless the list is empty (you’ve used up 
all the ports). (The limit is 4 sources that can do machine control through serial control for any 
particular MCE.)

In either of the latter cases, ‘Unassigned’ is a place-holder only and is not a viable choice.

Default Transition Type 
There are 6 choice in this field:

System Trans Type Cut VFade CutFade XFade FadeCut

If you choose ‘System Trans Type’ the MCE makes no change to its transition type (which is 
reflected on the transition control buttons of a connected panel).

If you choose any of the other 5 entries, for instance ‘VFade’, the MCE switches to that particular 
transition type when the operator chooses the main source. (The operator may override the 
MCE’s selection.)

Default Transition Rate 
You can enable a default transition rate by placing a check in the check box. If you leave this box 
unchecked, the MCE makes no change to its transition rate when the operator chooses the main 
source. 

If you do check the box, specify a rate in the associated field. The field value is actually the 
inverse of rate: it is the duration of the transition expressed as a number of frames. Larger values 
represent slower transitions. The range for the default transition rate is 3–300 frames.

When the operator chooses this main source, the MCE switches to the default transition rate. 
(The operator may override the default rate.)
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Options Section
The options section contains two checkboxes:

• Auto Restore Audio Mixer Settings. 

This checkbox is present only if you checked ‘Enable AutoRestore of Audio Mixer Settings’ in 
the general settings.

If you check this box in the ‘Main Sources’ page, the main source’s default audio settings are 
restored to their default values whenever the source is placed on the preset bus during 
operation. Otherwise, the source retains its current audio channel settings (which can 
include changes to gain, inversion, and channel swaps) until further changes are made. 

• Has Backup Audio. 

The ‘Has Backup Audio’ checkbox enables backup audio for the main source. See Backup 
Audio for Dolby E Signals on page 79.

Completing a Main Source Configuration 
Follow these steps to complete a main source configuration:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed source information. 

3 Save your configuration before continuing.

It is possible to define identical main sources (same name, same BNC, etc.) with different 
selection numbers. It is easy to do this inadvertently. We recommend that you save your 
file frequently and review your changes carefully.

The sources defined in the main source window are used in the Button Mapping—Main 
Source page (if you have checked ‘Enable Main Source Button Mapping’ in the General 
Settings window. They can also be used for Squeeze Settings and Squeeze 2 Settings.
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Source Groups 
The ‘Source Groups’ page lets you define source groups for an MCE configuration. Source 
groups are not available for other MCPMs. This is a view of the page: 

Source groups exist to provide a way for operators to be able to use hundreds, perhaps thou-
sands, of sources on a small set of source buttons. 

Source groups contain sets of sources, mapped to buttons. Each MCE configuration defines its 
own source groups. Different MCEs can also use the same source groups or have different source 
groups. A panel operator can select the source group that best suits the purpose at hand. 

There is no real limit to the number of source groups. 

However, the maximum number of sources in a group is 24. That is because the maximum 
number of source buttons on a panel is 24. An MCE’s source groups need only support the 
panels that can control it. If no panel has more than 10 source buttons, no source group needs 
more than 10 sources. 

Source groups can contain gaps. These gaps result in buttons that have no sources. 

If a source group has more sources than a panel has source buttons, some truncation occurs. For 
instance, when a panel having 10 source buttons is using a source group having 24 source 
“slots,” the uppermost 14 sources in the group are inaccessible to the operator. Any gaps in the 
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source group remain unchanged: the group is not reshaped in any way to fit a small number of 
buttons. 

For MCEs that support source groups, bank select is disabled. For these MCEs, also, a panel’s 
button mapping menu contains a source group button instead of a main source mapping 
button (and main source button mapping is disabled). 

Source groups are enabled in the general settings for the ‘Source Groups’ window to be 
available. 

Purpose
This is what the ‘Source Groups’ page does:

• Names the source groups. 

• Provides a list of main sources from which to draw. 

• Identifies the sources within the groups and specifies on which button the source is to 
appear. (The term “slot” in the ‘Source Groups’ page means a place in the group, but slots 
and buttons are in 1:1 correspondence. You can think of slots as buttons as the buttons are 
numbered from left to right on control panels. Slots that are empty correspond to panel but-
tons that have no source.)

• Allows you to add, remove, or change sources within a group. 

Page Organization
The ‘Source Groups’ configuration page has 8 sections: 

1 The ‘Apply’ button applies changes you have made to a new source group.

2 The source group list identifies the source groups you have defined. 

3 The add and delete buttons add and delete single groups. 

4 The group information section contains the name of the group and the number of slots in 
the group. The group is identified by its selection number which you can change in this sec-
tion.

5 The source pool section lists all the sources available. (These are the defined main sources.)

6 The member sources list the sources of a group, by slot. Slots can be empty. 

7 The function buttons allow you to manipulate the slots and sources of the selected source 
group. 

8 The bulk add and delete section allows you to add multiple source groups at one time and to 
delete multiple source groups at one time. 

Source Group List
The group list contains the names of the source groups you have already defined. If you have 
not defined any source groups, the list will be empty. The list is ordered by selection numbers 
(or “selnos”). 

The button legends for ‘Group Select’ buttons of a panel are the source group names 
defined in this list. 
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Add and Delete Buttons

Adding a Source
Click ‘New’ if you want to add a single source group. The fields of the source groups window 
become empty or blank and you may enter data in the fields of the ‘Source Group’ window. Use 
the ‘Add’, ‘Replace’, ‘Delete’, and ‘Clear All’ buttons to manipulate the sources in the ‘Member 
Sources’ list.

Deleting a Source
Select a source group and click ‘Delete’ if you want to delete a single source group. Repeat for 
other source groups that you want to delete one at time. 

Apply Button
Click the ‘Apply’ button to commit your changes at any time. The ‘Apply’ button applies the 
changes you have made to a (single) new source group definition.

(There is no “undo” for this. If you discover you have made a serious error, the only remedy is to 
discard the configuration without saving it. Click ‘Apply’ only when you are sure of your 
changes.)

Group Information
This cluster of text boxes displays information about the group you have selected in the group 
list. 

The term “slots in group” refers to the number of entries in the group. We call the entries source 
slots. A slot can be empty or it can contain the name of a main source. A group can have a 
maximum of 24 slots because that is the maximum number of source buttons to be found on 
any control panel. 

The slots in a group map 1:1 to the buttons of a master control panel, in order from left to right. 
If a group has more slots than a particular panel has buttons, the sources in the extra slots are 
ignored. Empty slots result in disabled (dark) source buttons.

Source Pool
The source pool is a list of the main sources defined in the configuration at hand. The list is the 
same as the source list of the ‘Main Sources’ window. The list is ordered by selection numbers (or 
“selnos”). 

Member Sources
This list displays the sources belonging to the selected group. The list is an array of slots, any or 
all of which can be empty or not. 

You can manage the member sources using the ‘Add’, ‘Replace’, ‘Delete’, and ‘Clear All’ buttons. 
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Function Buttons
The buttons in this section allow you to manipulate the member sources of the selected group. 
There are 4 buttons: 

• Add

The ‘Add’ button adds sources to empty slots. 

Select one or more entries in the source pool using click, shift-click, and ctrl-click methods. 

Click the ‘Add’ button. The software will add the sources to the member list starting at the 
first empty slot if you have no slot selected, or at the first empty slot in or above your selec-
tion if you have some slots selected. 

If you attempt to add more sources than there are empty slots, the software will present an 
alert telling you that it cannot add the sources. 

• Replace

The ‘Replace’ button replaces the entries in selected slots. 

Select one or more entries in the source pool using click, shift-click, and ctrl-click methods. 

Select one or more entries in the member sources using click, shift-click, and ctrl-click meth-
ods. 

Click the ‘Replace’ button. The software will overwrite your member slot selections with your 
source pool selections in ascending order. If you have selected more pool sources than you 
have selected member slots, the software will overwrite the member slots immediately fol-
lowing you member select. 

This can be a convenience. If for example, you want to add 12 pool sources to the group, 
starting at slot 10, it is sufficient merely to select slot 10. The 12 sources will fill slots 10–21. 

• Delete

Select one or more slots in the member sources list using click, shift-click, and ctrl-click 
methods. 

Click ‘Delete’. The selected slots become empty. 

• Clear All 

Click ‘Clear All’ to cause all member slots to become empty. 

Bulk Add and Delete
If you are developing an MCE configuration, you can create more than one source group at time 
using the ‘Bulk Add Window’ button next to the source group list. You can also delete more than 
one source group at time using the ‘Bulk Delete Window’ button next to the source group list.

Bulk additions and bulk deletions are available only for MCEs.

When you click the ‘Bulk Add Window’ button, an ‘Add Source Groups’ dialog appears. 

When you click the ‘Bulk Delete Window’ button, a ‘Delete Source Groups’ dialog appears. 

See Bulk Add, following.

See Bulk Delete on page 93.
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Bulk Add 
You can add multiple source groups easily. 

For example, if you have 80 sources in your source pool and the panels in your system all have 
10 source buttons, it is a matter of a few clicks to create 8 sources groups of 10 sources each. In 
this case, the sources in the groups would be consecutive in the order in which the main sources 
are defined. 

When you click the ‘Bulk Add Window’ button, the ‘Add Source Groups’ dialog appears: 

Fig. 4-7: Add Source Groups Dialog

These are the fields of the dialog: 

• Source pool

The ‘Source Pool’ field is the same as the source pool field in the ‘Source Groups’ window. It 
lists all the available sources, in the “selno” ordering defined in the ‘Main Sources’ window. 

To create source groups, you must select a number of sources in this list. Your selection does 
not have to be contiguous. It can be disjoint. Use click, shift-click, and ctrl-click techniques to 
make your selection. 

The number of sources you select is important to the bulk add operation. See Operation, fol-
lowing. 

• Automatically pick the start number

Check this box if you want the bulk add operation to assign unused “selnos” to the new 
source groups. If you do not want automatic numbering, be sure to enter a value in the start-
ing number field. 

• Starting source group selection number

If you leave the automatic numbering check box unchecked, enter a valid source group 
selno in this field. 

Available
Sources

Bulk Add Parameters
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• Four-Letter Mnemonic

Enter up to 4 characters in this field. The name of each group created will have these charac-
ters as a base and a 4-digit numerical suffix. (If the 4th character of this string is a space, the 
bulk add operation will generate source names having a space between the base name and 
the suffix.)

• Number of Sources in Each Source Group

Enter a numerical value in this field. The value must not be more than 24. The number of 
sources in each group is important to the bulk add operation. See Operation, following. 

Operation
The bulk add operation takes the sources you have selected in the source pool and distributes 
them across one or more groups according to the group size you specified. 

The number of source groups to be generated is this: 

N = ( P – 1) / S + 1  [ integer division ]

where P is the number of pool sources you have selected and S is the size of the groups being 
generated. 

For example, if you choose 34 sources and the size of the groups is 10 slots, then the bulk add 
operation will create 4 source groups of 10 slots, adding sources from the pool in selno order to 
each group successively. The last group will be only partially filled. 

Click the ‘Add Source Groups’ button to execute the operation.

When you click ‘Add Source Groups’, the software presents this alert: 

If you click ‘OK’, the software presents this completion message: 

The result is displayed in the source group list of the ‘Source Groups’ window: 
92



MasterConfig
User’s Guide
In this example (adding groups of 7 sources, for 47 sources), the first new group will have the 
first 7 sources selected. The second new group will have the second 7 sources selected. The third 
new group will have the third 7 sources selected, and so on. The seventh group will have the last 
5 sources selected and its remaining slots will be empty (blank). 

Bulk Delete 
When you click the ‘Bulk Delete Button’ in the main sources window, the ‘Delete Source Groups’ 
dialog appears: 

Fig. 4-8: Delete Source Groups Dialog

Highlight the sources that you wish to delete. Then click the ‘Delete Source Groups’ button. The 
following alert appears: 

Click ‘Yes’ if you accept the confirmation statement. The operation will respond with a comple-
tion message: 
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Over Sources 
The ‘Over Sources’ page lets you define an MCPM’s or MCE’s audio over sources. This is a view of 
the page as it might appear for an MCE: 

Fig. 4-9: Over Sources Page (Sample, MCE)

The over sources governed by this configuration page can include:

• Local sources (audio connections at the NV5100MC backplane).

• Main sources (for MCE configurations only).

• External sources (devices connected to routers under an NV9000 control system).

Audio overs can be used — and controlled — by Intuition XG keys. See XStudio Add-On 
Commands on page 205 or the Master Control Reference Manual.

Over
Source

List

Audio
Chann

Choice: loca
sources or 
external rou
sources

 Source
Section

Part 1

 Source
Section

Part 2

Optio
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The MCE, unlike other MCPMs, allows you to choose a main sources as an audio over source. The 
MCE also allows 16 audio channels for each audio over. Other MCPMs allow 8. This is a view of 
the page as it might appear for an MCPM-SD: 

Fig. 4-10: Over Sources Page (Sample, MCPM-SD)

Purpose
This is what the ‘Over Sources’ page does:

• Names the over sources. (The over names appear on the buttons, and in the menus, of mas-
ter control panels.)

• Identifies the audio sources and describes the audio processing for an over source. 

• Specifies the default over-to-main ratio for each over source.

This page also configures router pre-select sources. A router pre-select source identifies a router 
destination connected to a backplane connector. Master control operators choose the router 
source to route to that destination dynamically. The router source becomes available as an over 
source. (Router pre-select must be enabled in the ‘General Settings’ page.)

This page also configures “external router sources”— those connected to one or more routers in 
an NV9000 router control system. The source’s connections are defined in the NV9000 configu-
ration. You, the configurer, determine the set of external router sources during configuration. 
(External router sources must be enabled in the ‘General Settings’ page.)

Two audio “over” inserters are available in the MCPM or MCE. The MCPM or MCE mixes “over” 
audio with main audio (i.e., audio from the selected main source) at a certain ratio. The ratio can 
be changed by a control panel operator. 

Over
Source
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Audio 
Channe
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 Source
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 Source
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Audio overs are mutually exclusive: only one audio over can be on the program bus or on the 
preset bus. When one is on program, however, the other can be on preset. 

Most control panels have 2 audio over button pairs. Some control panels can be set up with one 
over button (pair) or none. When you configure over sources for your system, you might want to 
consider the control panels in your system.

Commonly, when an audio over is applied, the main program level is decreased by some 
amount, allowing the over audio to take precedence. Typical voice-overs are mixed at a ratio of 
75–80% over source and 20–25% main source.

An over-to-main ratios (or just “over ratio”) is perceptual and non-linear: 

Fig. 4-11: Non-Linear Over-to-Main Ratio

The default main-to-over ratio is 50/50. A 50/50 ratio is really 100% main and 100% over. 

The program/preset audio mixer behaves according to a linear model.

Page Organization
The ‘Over Sources’ configuration page has many of the features of the ‘Main Sources’ page. 
There are 4 sections: 

1 The over source list shows sources that have already been created. They can be edited.

2 The source section is split into two separate subsections. The first specifies the audio source. 
The second is an “NV9000 Preselect” subsection.

3 The audio channels section lets you specify the audio source and details of each audio chan-
nel. 

4 The options section allows you (1) to specify the default over ratio and (2) to enable or dis-
able “auto restore” for the over’s audio. Auto-restore must have been enabled in the general 
settings. Otherwise, the option is not present in the ‘Over Sources’ page.

Over Source List
The over source list includes all the over sources you have defined for the MCPM. 

To configure an over source, it must be in the list. You can add entries to the list and remove or 
copy entries in the list. The mnemonic (name) of a source should be meaningful to panel 
operators.

100%

0%
0% 100%0%

MAIN

OVER

50%

Let P = intended over percent, O = resulting 
over percent and M = resulting main percent
IF P = 50% 

M = O = 100%
ORIF P < 50%

O = P / (1–P) and M = 100%
ELSE P > 50%

M = (1–P) / P and O = 100%
P

M, O
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The list is ordered by selection number (selno). 

If you have not checked the over source button mapping option in the ‘General Settings’ 
page, the main source selection numbers are also button numbers. The de facto mapping 
places source n on button n where n is 1 or 2 and sources with other selnos are inaccessible. 
We strongly recommend that you use over source button mapping. See Button Mapping—
Over Source on page 150.

To Create a New Source
Click ‘New’. The window shows a set of default parameters. You may edit the parameters now or 
at any time. Click ‘Apply’ to commit changes to the over source definition.

To Delete a Source
Highlight the source in the list and click ‘Delete’. 

To Copy a Source
Highlight the source in the list. Give it a new unused selection number and click ‘Apply’. If you 
choose an existing selection number, you will overwrite an existing source definition.

To Edit a Source
Highlight the source in the list and modify the parameters you want to change. Click ‘Apply’ to 
confirm your changes. If you wish to cancel your changes, either click another source or click 
‘New’. A query appears: 

Click ‘No’ to discard your changes.

Source Section
It is in the source section that you identify the audio source. Part 2 of this section specifies 
whether the source is a router pre-select source. 

Selection Number 
Either use the supplied value or enter a value from 1 to 4. This number defines the source’s posi-
tion in the source list. See Selection Numbers on page 38.

Mnemonic
Enter the name that you want to appear on a control panel’s over source button, up to 8 charac-
ters. Use alphanumeric characters, spaces, or underbars. Although you can enter other 
characters, the panels will not display them. 
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Source Type Selection 
In an MCE configuration (only), directly beneath the mnemonic field is a drop-down list for main 
sources: 

Choose a main source in this field if you want the audio over to obtain its signal from a main 
source. Otherwise, choose ‘[none]’.

The ‘Over Sources’ page does not have this field for other MCPMs. 

Further, if the configuration has external over sources enabled (in the General Settings and ExtR-
trSrc Settings (for MCEs) pages), the Over Sources page also has, in the box at the bottom right, a 
drop-down list for source type: 

Here there are 2 choices:

• Master Control Input.

• External Router Input. 

Master Control Input
Choose ‘Master Control Input’ if you want a local over source — one that is connected directly at 
the NV5100MC backplane. 

When you choose ‘Master Control Input’, you must specify the audio inputs that form the source. 
This shows over sources for an MCPM-SD: 
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External Router Input
Choose ‘External Router Input’ if you want an external over source — one that is connected to 
routers in an associated NV9000 router control system. If you choose this option, the source 
section displays a drop-down list that allow you to select a source defined in the NV9000 
configuration. 

When you specify an external router input, you must select the channels that are to be enabled 
for the over source. 

Router Pre-Select Subsection 
This section is not present when the over source is external or when the over source is a 
main source.

For local sources, the section is present if you have checked ‘Enable NV9000 Preselect’ in the 
general settings. These samples illustrate the two choices: 

Leave the checkbox unchecked (sample A) if the over source is not a router pre-select source. 

If you check the box, you must select an NV9000 destination ID in the drop-down list. This field 
will not be a drop-down list unless your master control system is connected to an NV9000 
system. The drop-down list shows all the NV9000 destinations. Sample B shows 4 router destina-
tions. (The numbers following the colons in the entries are the destination IDs in the NV9000 
database.)

If you don’t have the NV9000 connected during configuration, 
the drop-down list does not appear. In that case, you must 
enter the database ID for the source you want.

(The connector numbers and router 
destination IDs for over sources are 
specified in the ExtRtrSrc Settings (for 
MCEs) page.)

The router source ID is specified (imme-
diately above this section) in the ‘Over 
Sources’ page.

(A)

(B)

(C)
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Sample (C) shows a destination selected. These are two of the many factors to consider when 
connecting a router destination to the master control frame:

• An NV9000 destination often include signals on several “levels.” For example, a destination 
might include an HD video signal and 4 AES signals. In that case, 5 cables must connect to 
the backplane input section, one from an HD router and 4 from an AES router. The main 
source would be the video connector and the configuration for that main source would 
specify the 4 AES audio connectors.

• The destination might be SD or HD with embedded audio. In that case, a single video cable 
would connect to the backplane input section, and the main source would be configured for 
embedded audio. 

Although you can choose this kind of destination, you cannot configure an over source that 
uses such a connection and the master control system cannot use such a destination for an 
over source.

Control panel configuration in the MCS Panel Configuration Editor is required for router pre-
select to work. 

Audio Channels Section 
The audio channels section is absent for over sources on MCEs that derive from main 
sources. 

There is a bug that causes the audio channels section to remain displayed sometimes even 
though you have chosen a main source. If you click ‘Apply’, the page refreshes properly.

The audio channels section supports many audio options. The functions (and check boxes) that 
appear in the audio channels section vary depending on the MCPM type, the choices you have 
already made in the ‘Over Sources’ page and the ‘General Settings’ page.

Local over sources must be discrete analog or discrete AES. Their connectors can be BNCs, 
Phoenix 3-pin (STP), or DB25. The configuration page uses the same method for both analog 
and AES inputs. (All internal audio processing is AES.) 

The audio channels section differs for local sources and external sources. 

Automatic Channel Numbering
There is an ‘Initial Values’ button in this configuration page that automatically enables and fills 
all the audio channels. 

There are cases for automatically numbering channels:

• For “master control” (i.e., local) sources.

If the channel list is empty, clicking ‘Initial Values’ fills the entire audio channel list with 
default values, starting at connection number 65 and incrementing by 1, with alternating “A” 
and “B” channels. 

If you have specified a connector number for the first channel, clicking ‘Initial Values’ fills the 
entire audio channel list, starting at the connection number you specified, incrementing by 
1, with alternating “A” and “B” channels. 

(Each initialized channel has the default gain and inversion setting.)
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• For external router sources. 

Clicking ‘Initial Values’ enables the entire audio channel list. (Each channel has the default 
gain and inversion setting.)

In either case, the operation completely overwrites anything settings you previously 
assigned to the audio channels.

The number of audio channels is limited by the maximum you specify in the General 
Settings page.

You cannot undo the result of pressing ‘Initial Values’. You should save your configuration 
before you use the ‘Initial Values’ button.

Audio for Local Sources
When you first create an over source, the default audio channels section appears: 

An audio channel is represented by one of the rows in this section. To enable an audio channel 
to the over source, check the ‘Over Enable’ box in the row. Leave the box unchecked if you do 
not want to use the channel.

The number of rows in the section is equal to the maximum number of audio channels you set 
in the general settings. It is not necessary to use all available channels. Unused channels are 
forced to silence. 

Each enabled audio channel has a connector input field, a gain field and invert checkbox, as 
shown in the illustration. The ‘Master Control Input’ column is where you specify the audio 
connector. 

The gain field expresses the default gain (audio level). Operators can generally adjust the gain. A 
gain of 0 dB is unity gain. Unity gain means the digital audio values are multiplied by 1— essen-
tially a no-op. 

Check the “invert phase” checkbox if you wanted to invert the audio signal. Internally, audio 
signals are PCM values. The MCPM multiplies the PCM data by –1 when it inverts the audio.

The default has no channels defined. 
This illustration is the default for an MCPM-
SD. An MCE has up to 16 audio channels.
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The word “phase” in the column header is meaningless. Please ignore it. 

Audio for External Sources
External over sources reach the MCPM through the master control frame’s A and B ports desig-
nated in the ExtRtrSrc Settings (for MCEs) page. The “A” ports include 4 AES connectors and a 
fifth connector for embedded audio. The “B” ports should be configured identically although 
the connector numbers differ. Not all audio connectors need be used.

An external over source uses either the “A” ports or “B” ports as required. Therefore you specify 
no connectors, but only which channels are to be used. (The gain and invert fields provide 
defaults for internal audio processing. Operators may generally override these values.) 

This is an example of an external source that uses discrete AES channels 1 and 2: 

Connector numbers are specified in the ExtRtrSrc Settings (for MCEs) page.

Options Section
The options section includes an ‘Auto Restore Audio Mixer Settings’ checkbox and subsection in 
which to enter the source’s default over-to-main ratio.

Auto Restore Audio Mixer Settings
This checkbox is present only if you checked ‘Enable AutoRestore of Audio Mixer Settings’ in the 
general settings.

If you check this box, the over source’s default audio settings are restore to their default values 
whenever the source is placed on the preset bus during operation.

Otherwise, the source retains its current audio channel settings (which can include changes to 
gain, inversion, and channel swaps) until further changes are made. 

Over-to-Main Ratio
Enter a percentage from 0 to 100%. The number you enter is the over part of the ratio. 

Because the ratio is non-linear, you might wish to use the graph and algorithm in Figure 4-11 on 
page 96 to compute a ratio. 

Note

Audio sources should be applied to the MCPM or MCE at the correct level. Excessive 
use of internal gain can cause problems with overall headroom (clipping) or signal-
to-noise ratio.

The check marks select the audio channels to 
be used for the specific source.

You should not use audio channels that are 
not enabled in the ExtRtrSrc Settings (for 
MCEs) page.
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The default value is 50% which means 100% main and 100% over. 

Completing an Over Source Configuration
Follow these steps to complete an over source configuration:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed source information. 

3 Save your configuration before continuing.

It is possible to define identical over sources (same name, same connector, etc.) with differ-
ent selection numbers. It is easy to do this inadvertently. For instance, if you change the 
selno of a source, MasterConfig creates a new main source, identical to the old with the new 
selno. If the new selno was used already for another source, the change overwrites the other 
source configuration completely and you have two copies of the same source with different 
selnos.

If you overwrite another source by mistake, there is no remedy except to discard your 
changes and reopen the file (or to re-enter the data you overwrote). 

We recommend that you save your file frequently and review your changes carefully.

The selection numbers defined in the over source window are used in the ‘Button 
Mapping—Over Source’ page (if you have checked ‘Enable Over Source Button 
Mapping’ in the general settings.

Audio Monitors and Meters 
The ‘Audio Monitor’ page lets you control the meter and monitor outputs of an MCPM or MCE. 

MCEs and MCPMs are substantially different in the way they produce audio monitor and 
metering output:

• MCPMs have 8 audio channels (4 AES pairs). MCEs have 16 channels.

• Some MCPMs provide analog audio output (represented by the ‘DtoA Input Channels’ sub-
section of the ‘Audio Monitors’ page). MCEs do not have analog audio output.

• MCPMs combine the monitor outputs A and B according to a partitioning scheme. MCEs 
deliver all 16 channels of monitor A on one connector and all 16 channels of monitor B on 
another connector. 

• MCEs can send preview bus audio to a monitor or meter. MCPMs do not have a preview bus.

Because of this difference, the following two sections discuss MCPMs (here) and MCEs 
(page 111) separately.
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MCPMs
This is a view of the page as it might appear for an MCPM-SD. The red letters in this view corre-
spond to sections of Figure 4-13 (page 105): 

Fig. 4-12: Audio Monitor Page (Sample, MCPM-SD)

The MCPM has several inter-related monitor and meter functions. Two monitor outputs are 
available (A and B). Meter outputs are available. 

All MCPMs except the mixer/keyers have built-in digital-to-analog converters that can be 
assigned to any of the monitor or meter outputs, eliminating the need for external conversion. 
(If you are configuring a mixer/keyer, the page has no ‘DtoA Input Channels’ subsection.)

MCPMs also have two auxiliary audio inputs. One is called “aux in” and the other is called “off-
air.” There is nothing special about the term “off-air.” The off-air and “aux in” inputs are identical. 
The off-air and aux in inputs do not contribute to program, preset, or preview output in any way.

The “aux in” input named here has no relationship to the “aux” buttons of the iMC-Panel-200, 
iMC-Panel-300, or iMC-Panel-GUI control panels or to the aux outputs of the MCE. Nor does it 
have any relationship to the “aux connector” at the backplane of many MCPMs or the 
“NVISION aux bus” at the back of NV5100MC frames. 

Purpose 
This is what the ‘Audio Monitor’ configuration page does for MCPMs that are not MCEs:

• Specifies the sources for up to 8 channels for the aux in input and 8 channels for the off-air 
input.

• Specifies the source (and gain) for monitors A and B.

• Specifies the source for the meter outputs.

• Selects the monitor outputs and their partitioning. 
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G
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• Selects the D-to-A outputs. 

This configuration page will not make much sense unless you understand the architecture of 
the MCPM’s audio section. You can read the Master Control Reference Manual to find out or 
read the following very brief discussion. 

Meters and Monitors Section
For most MCPMs, the audio meter and monitor section presents signals on DB25 connectors. 

Some MCPMs do not provide analog audio outputs. See MCPM Types on page 11 for more 
information. 

Figure 4-13 shows the organization of the audio metering and monitoring section of the MCPM. 
The letters in this illustration correspond to the letters marking places in Figure 4-12. 

Fig. 4-13: Audio Meters and Monitors (General View)

The meter and monitor section receives program and preset inputs as the output from each of 
the 8 channel processors. Those outputs have undergone prior disembedding, decoding, and 
mixing. It also receives 8 aux in and 8 off-air inputs from the audio crosspoint. The section treats 
each of these sources as 4 AES pairs (1/2, 3/4, 5/6, and 7/8).
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The metering multiplexer delivers either program, preset, “aux in,” or “off air,” to the metering 
output connectors. It does not recombine program, preset, “aux in,” or “off air” in any way. It 
does not apply any gain to the meter outputs. 

The monitor section allows you to combine any two of the program, preset, aux, and off-air 
sources on the monitor outputs. There are two monitor “buses” named A and B (both evident on 
master control panels). Each bus selects one of the 4 sources. The A and B buses are distributed 
to the monitor outputs in one of 4 ways, as illustrated by the A/B distribution block in Figure 4-
13. Monitor A might, for example, play program audio and monitor B might play aux audio. 

An additional crosspoint allows you to interchange the monitor’s 4 channel pairs prior to 
output. Note that the meter output does not have such a crosspoint.

You can configure monitor and meter outputs so that a panel operator can select any of the 4 
sources (program, preset, aux, or off-air) to meter or monitor and adjust the gain of the monitor 
outputs. If an operator is allowed to change the monitor or meter setup, the values you enter in 
the fields are the default values. (Operators can store changed values as new defaults.)

On a control panel, each monitor, A and B, has an independent “dim” function (either a menu 
button or a physical button). When an operator presses the monitor’s “dim” button at a control 
panel, the monitor level decreases buy an amount that you specify in the ‘Audio Monitor’ page. 
The operator cannot change this value.

The analog audio output section (if the MCPM model has one) receives AES signals in pairs from 
both the meter and monitor outputs. You can assign any of those 8 pairs to each of the four D-
to-A pairs. Internal DACs convert those AES signals to analog signals. Thus, any analog audio 
output pair can reproduce any meter or monitoring pair. (This feature allows you to use analog 
speakers.)

Please note: the number of monitoring channels available is limited by the “Max # of Audio 
Channels” setting in the ‘General Settings’ page.
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Page Organization
The ‘Audio Monitor’ page has 6 sections: 

1 The monitor distribution section specifies the gain and source of each of the monitors and 
specifies the partitioning of the monitor buses on the outputs. Additionally you can specify 
whether the panel operator may change the monitor setup.

2 The dim level section specifies the attenuation for a panel’s dim buttons.

3 The monitor crosspoint section specify the monitor crosspoint.

4 The analog output section specifies which meter and monitor outputs are output as analog 
signals.

5 The meter source section specifies the source for the meter output. 

6 The aux in and off air inputs section comprise up to 8 discrete channels of one auxiliary input 
and up to 8 discrete channels of the other auxiliary input. 

Audio input connectors can be BNC, Phoenix 3-pin, or DB25.

Monitor Distribution
There is a subsection for monitor A and a subsection for monitor B. They have the same features. 
At the bottom of this section is the A/B partition subsection.

Gain

Enter a value for the default monitor level (gain). The range of values is –108 dB to +12 dB.

Input

In the drop-down list, choose a source for the monitor: program, preset, aux in, or off-air.

Monitor
Distribution

“Aux In” and “Off-Air” 
Connectors

Analog Out-
put

Meter 
Source

D

M
C
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Bug: the drop-down list includes a “preview” option. This is not a valid choice for MCPMs 
that are not MCEs.

Operator Can Modify

Check the box if you want the operator to be able to select a source at the panel or to change 
the monitor level.

Monitor A/B Partition

Choose one of the 4 settings in the drop-down list. The choices are

A, A, A, A, 
A, A, A, B,
A, A, B, B,
A, B, B, B

What this means is that monitor A appears on as many outputs pairs as there are letters in the 
row. The same is true for monitor B. In row 2, for example, there are 3 A’s and 1 B. Monitor A 
appears on the first 3 outputs and monitor B appears on the last. 

Which output pairs are A and which are B depends on the monitor crosspoint. If the crosspoint is 
diagonal, row 2 will appear at:

Output 1/2 = A 1/2
Output 3/4 = A 3/4
Output 5/6 = A 5/6
Output 7/8 = B 7/8

If you wanted B 1/2 to appear, you might change the fourth output to 1/2 in the ‘Monitor Input 
Channels’ section.

Monitor Crosspoint
This section represents a crosspoint where you can route AES pairs from the monitor buses A 
and B to the output connectors. Each row in this section represents a monitor output pair. The 
entry in the drop-down list in a row represents the input pair for the row. 

Consider, for example, the monitor partition “A, A, B, B”. The first two outputs (1/2 and 3/4) are 
committed to monitor A; the last two outputs (5/6 and 7/8) are committed to monitor B. 

In the drop-down list for the first output, you can choose any of 4 AES pairs. Because this output 
is assigned to monitor bus A, if monitor bus A was assigned program output, then you will hear 
the chosen AES pair from program on the first monitor output. This is true for the other A output 
too.

The preceding holds true for both of the B outputs. This diagram illustrates the example: 

Monitor output 1/2 = Program 1/2
Monitor output 3/4 = Program 3/4
Monitor output 5/6 = Preset 1/2
Monitor output 7/8 = Preset 3/4

Mon. A

Mon. B
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If you check ‘Operator can modify’ in the monitor section, what the operator chooses for 
monitor A will be audible on monitor outputs 1/2 and 3/4, and whatever the operator chooses 
for monitor B outputs will be audible on monitor outputs 5/6 and 7/8. 

Dim Level
This section represents the attenuation (in dB) applied to either monitor’s audio level when the 
operator presses a ‘Dim’ button. The operator can never change this value.

The range of values is –108 dB to +12 dB. 

If, for example, the current gain for the monitor is +14 dB, applying a dim value of –20 dB results 
in a gain of –6 dB.

Analog Output
The analog output feature allows you to connect analog speakers directly to your MCPM. 

If your MCPM has no analog outputs, the ‘Audio Monitor’ configuration page does not have 
this section.

Each row in this section represents one analog output pair. The output accepts an AES pair as 
input (which is why the rows are labelled as AES pairs) and converts the data to an analog signal 
pair.

You may choose which of 4 meter input pairs or 4 monitor input pairs to assign to each of the 
analog output pairs. 

Meter Source
This section represents meter outputs. As for the monitor outputs, you can choose the source to 
meter: program, preset, aux, or off air, and you can let the operator choose the source as well.

Unlike monitor outputs, the meter output path is direct. The source goes directly to the output, 
channel for channel. There are no crosspoints to configure.

Aux In and Off Air Inputs
This section lets you specify the sources for the “aux in” input and the “off-air” input: 

The section has 8 rows representing up to 8 channels. The section has fewer rows if you chose 
fewer than 8 audio channels in the ‘General Settings’ page.
109



Operation
Audio Monitors and Meters
Each input field represents a single audio connection (BNC, Phoenix 3-pin, or part of a DB25) on 
the master control frame.

The buttons in the ‘A’ and ‘B’ columns represent one of the two channels on the connector. 
Button A is for the lower numbered channel and B is for the higher-numbered channel (as for 
AES 1 and 2, respectively). 

When you start a new MCPM configuration, these fields are filled with suggested values. 
Enter a zero (0) for the channels that you want to disable. You need not use any suggested 
value.

You can use inputs more than once or for more than one purpose. 

Completing the Audio Monitor Configuration
Follow these steps to complete audio monitor configuration:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Click ‘Default’ to revert to default values. There is no “cancel” or undo function.
110



MasterConfig
User’s Guide
MCEs
This is a view of the page as it might appear for an MCE. The red letters in this view correspond 
to sections of Figure 4-15 (page 112): 

Fig. 4-14: Audio Monitor Page (Sample, MCE)

The MCE has relatively simple monitor and meter functions. Two monitor outputs are available 
(A and B). Meter outputs are available. 

MCEs also have two auxiliary audio inputs. One is called “aux in” and the other is called “off-air.” 
There is nothing special about the term “off-air.” The off-air and aux in inputs are identical. The 
off-air and aux in inputs do not contribute to program, preset, or preview output in any way.

The “aux in” input named here has no relationship to the “aux” buttons of the iMC-Panel-200, 
iMC-Panel-300, or iMC-Panel-GUI control panels or to the aux outputs of the MCE. Nor does it 
have any relationship to the “aux connector” at the backplane of the MCE-CORE or the 
“NVISION aux bus” at the back of NV5100MC frames. 

A A
E

C

D

D

C

B

B

D

B
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Purpose 
This is what the ‘Audio Monitor’ configuration page does for MCEs:

• Specifies the sources for up to 16 channels for the aux in input and 16 channels for the off-air 
input.

• Specifies the source (and gain) for monitors A and B.

• Specifies the source for the meter outputs.

This configuration page will not make much sense unless you understand the architecture of 
the MCE’s audio section. You can read the Master Control Reference Manual to find out or read 
the following very brief discussion. 

Meters and Monitors Section
The audio meter and monitor section presents signals on 3 coaxial (1.0/2.3) connectors, labeled 
‘Mon A Out’, ‘Mon B Out’, and ‘Mtr Out’. 

Figure 4-15 shows the organization of the audio metering and monitoring section of the MCE. 
The letters in this illustration correspond to the letters marking places in Figure 4-14. 

Fig. 4-15: Audio Meters and Monitors (General View)

The meter and monitor section receives program and preset inputs as the output from each of 
the 16 channel processors. Those outputs have undergone prior disembedding, decoding, and 
mixing. It also receives 16 ‘aux in’ and 16 ‘off-air’ inputs from the audio crosspoint. The section 
treats each of these sources as 8 AES pairs.

The audio monitor and meter outputs can also include a video signal: internal black, program 
output, or preset output. The default is internal black.
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Dim 
Level
There are two monitor “buses” named A and B and one metering bus (all of which are evident 
on master control panels). Each bus delivers 16 audio channels and one video channel. A panel 
operator can adjust the gain of the monitor outputs, but not of the metering output. 

You can configure monitor and meter outputs so that a panel operator can select any of the 5 
sources (program, preset, preview, aux in, or off-air) to meter or monitor. If an operator is 
allowed to change the monitor or meter setup, the values you enter in the fields are the default 
values. (Operators can store changed values as new defaults.)

On a control panel, each monitor, A and B, has an independent “dim” function (either a menu 
button or a physical button). When an operator presses the monitor’s “dim” button at a control 
panel, the monitor level decreases buy an amount that you specify in the ‘Audio Monitor’ page. 
The operator cannot change this value.

Please note: the number of monitoring channels available is limited by the “Max # of Audio 
Channels” setting in the ‘General Settings’ page.

Page Organization
The ‘Audio Monitor’ page has these sections: 

C

D

E

Monitor
and Meter

Control

Aux In Audio 
Connectors

Off-Air 
Audio Con-

AES Output 
Section
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1 The Monitor and Meter Control section specifies the gain and source of the monitor and 
meter outputs. You can specify a video source to accompany the audio output. You can also 
specify whether the panel operator may change the monitor or meter setup.

2 The Dim Level section specifies the attenuation for a panel’s dim buttons.

3 The AES Output Section section specifies the source for the meter output. 

4 The Aux In and Off Air Inputs section comprise up to 16 discrete channels of one auxiliary 
input and up to 16 discrete channels of the other auxiliary input. 

Audio input connectors can be BNC, Phoenix 3-pin, or DB25.

Monitor and Meter Control
There is a subsection for monitor A, a subsection for monitor B, and a subsection for meters. The 
monitors have the same controls. The meters subsection is similar to the monitor subsections, 
but the meters do not have a gain control.

Gain

Enter a value for the default monitor level (gain). The range of values is –108 dB to +12 dB.

Input

In the drop-down list, choose a source for the monitor: program, preset, preview, aux in, or off-
air.

Operator Can Modify

Check the box if you want the operator to be able to select a source at the panel or to change 
the monitor level.

On Video

In the drop-down list, choose a video source: (internal) black, program, or preset.

The video source you select is carried in the audio monitor or meter output to be used (or not) 
as you require.

Dim Level
This section represents the attenuation (in dB) applied to either monitor’s audio level when the 
operator presses a ‘Dim’ button. The operator cannot change this value.

The range of values is –108 dB to +12 dB. 

If, for example, the current gain for the monitor is +14 dB, applying a dim value of –20 dB results 
in a gain of –6 dB.

AES Output Section
This section supports 48 AES output channels (24 AES pairs) that appear on three DB25 connec-
tors on the MCE’s AXM backplane module. (It lets you configure outputs whether they exist or 
not.)

Each group of 8 output channels (4 pairs) can be configured to follow audio from any of these 12 
sources: 

• Program Channels 1–8 • Program Channels 9–16

• Preset Channels 1–8 • Preset Channels 9–16

• Preview Channels 1–8 • Preview Channels 9–16
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• Monitor A Channels 1–8 • Monitor A Channels 9–16

• Monitor B Channels 1–8 • Monitor B Channels 9–16

• Meter Channels 1–8 • Meter Channels 9–16

The connector labels on the AXM backplane module do not reflect these choices. 

Aux In and Off Air Inputs
This section lets you specify the sources for each of the 16 channels of the aux in input and the 
off-air input: 

The section has 16 rows representing up to 16 channels. The section has fewer rows if you chose 
fewer than 16 audio channels in the ‘General Settings’ page.

Each input field represents a single audio connection (BNC, Phoenix 3-pin, or part of a DB25) on 
the master control frame.

The buttons in the ‘A’ and ‘B’ columns represent one of the two channels on the connector. 
Button A is for the lower numbered channel and B is for the higher-numbered channel (as for 
AES 1 and 2, respectively). 

When you start a new MCE configuration, these fields are filled with typical values. Enter a 
zero (0) for the channels that you want to disable. You need not use any “typical value.”

You can use inputs more than once or for more than one purpose. 

Completing an Audio Monitor Configuration
Follow these steps to complete audio monitor configuration for any MCPM or MCE:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Click ‘Default’ to revert to default values. There is no “cancel” or undo function.
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Keyer Sources
This is the ‘Keyer Sources’ configuration page as it might appear for an MCE: 

Fig. 4-16: Keyer Sources Page (Sample, MCE)

This is the ‘Keyer Sources’ configuration page as it might appear for an MCPM-SD: 

Fig. 4-17: Keyer Sources Page (Sample, MCPM-SD)

The difference between the MCE page and the pages for MCPMs is that for MCEs, the page 
allows up to 2048 keyer sources and provides a bulk add and a bulk delete button. For MCPMs, 
the limit is 8 keyer sources. 

An MCPM or MCE has, among its video effects, 3 independent (and linear) keyers. A key (the 
image processed by a keyer) comprises 2 video sources. One source is called the “fill” and the 
other is called the “key.” The luminance of pixels in the ‘key’ video frame form a mask for the 

Keyer
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Parameters
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pixels in the ‘fill’ video frame. The resultant masked fill pixels are mixed with the pixels of the 
upstream video on the program or preset bus. The resulting mix might be further modified by 
other downstream video effects. 

The key’s key signal is labeled “Key Cut” in this configuration window and the key’s fill signal 
is labeled “Key Fill.”

Keys can be either opaque or partially transparent.

It is possible to use the luminance values in the ‘fill’ source as key values. In such cases, the key 
video source is not required.

The mixing function can be “additive” or “normal.”

The 3 keyers of the MCPM or MCE share the set of defined keyer sources defined in this page.

In MCEs, one or two of 3 keyers might be assigned to Intuition XG channels. 

There is a clean-feed tap after each keyer. The tap is selected in the Misc. Settings page. 
(MCEs have two clean-feed outputs, A and B. MCPMs have one clean-feed output.)

The keyer sources governed by this configuration page can include:

• Local sources (video connections at the NV5100MC backplane).

• External sources (devices connected to routers under a NV9000 control system).

Purpose
This is what the ‘Keyer Sources’ page does:

• Names the keyer sources. (The keyer names appear on the buttons, and in the menus, of 
master control panels.)

• Identifies the video sources and specifies the processing parameters for the keyer. 

Page Organization
There are 3 sections: 

1 The keyer source list shows sources that have already been created. They can be edited.

2 The source selection section is split into two subsections. The first specifies the “fill” source. 
The second specifies the “key” source and contains a checkbox that indicates whether the 
second source is required.

3 The keyer parameters section allows you to specify (1) the appearance of the keyer, (2) the 
behavior of the keyer, and (3) whether the panel operator can change any of the parameters. 

Keyer Source List
The keyer source list includes all the keyer sources you have defined for the MCPM. The sources 
you define are shared by all 3 keyers. 

To configure a keyer source, it must be in the list. You can add entries to the list and remove or 
copy entries in the list. The mnemonic (name) of a source should be meaningful to panel 
operators.

IMPORTANT

The meaning of some of the keyer parameters is not obvious. Refer to the video 
effects section of the Master Control Reference Manual for details
117



Operation
Keyer Sources
You can define up to 8 sources. Gaps in the numbering are permissible.

You can assign each of the 3 keyers a default setting that takes effect at system startup. The 
defaults are specified in the Video Effect and Over Settings page.

To Create a New Source

Click ‘New’. The page shows a set of default parameters. You may edit the parameters now or at 
any time. Click ‘Apply’ to commit changes to the keyer source definition.

To Delete a Source

Highlight the source in the list and click ‘Delete’. 

To Copy a Source

Highlight the source in the list. Give it a new unused selection number and click ‘Apply’. If you 
choose an existing selection number, you will overwrite an existing source definition.

To Edit a Source

Highlight the source in the list and modify the parameters you want to change. Click ‘Apply’ to 
confirm your changes. If you wish to cancel your changes, either click another source or click 
‘New’. A query appears: 

Click ‘No’ to discard your changes.

Source Selection
It is in the source section that you identify the fill and key sources. 

To edit an existing source, highlight it in the keyer sources list. To edit a new source, simply click 
‘New’. 

Selection Number 
Either use the supplied value or enter a value from 1 to 8. This number defines the source’s posi-
tion in the source list. See Selection Numbers on page 38.

Mnemonic
Enter the name that you want to appear on a control panel’s keyer button, up to 8 characters. 
Use alphanumeric characters, spaces, or underbars. Although you can enter other characters, 
the panels might not display them. 

Source Type Selection 
To the right of the selection number is a drop-down list for source type: 

There are 2 choices:

• Master Control Input.

• External Router Input.
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Master Control Input

Choose ‘Master Control Input’ if you want a local keyer source — one that is connected directly 
at the backplane. 

This is the default keyer source type. 

• Check the ‘Self Key Enable’ box if the video fill is to use its own luminance values as key (or 
cut) values. If you check this box, the ‘Key Cut’ subsection disappears. 

If there is no key signal available for a fill, you should enable self-key mode. The appearance 
of the keyer in self-key mode depend heavily on the composition of the fill signal.

• Enter the connector number for the fill input. Check the ‘Video Input is Analog’ box if the 
input is analog. The MCPM will then apply timing compensation to account for the A/D con-
version. 

• If you have not checked the ‘Self Key Enable’ box, enter the connector number for the key 
input. Check the ‘Video Input is Analog’ box if the input is analog. The MCPM will then apply 
timing compensation to account for the A/D conversion.

The MCE does not allow analog keyer input. The analog checkboxes are not displayed for 
MCEs.

The MCPM-MK-HD is unique: Its local inputs, including its fill and key sources, use the 16 
connectors on its own backplane module. 

External Router Input

External Router Input is not available unless you have (1) enabled external router sources in 
the General Settings and (2) enabled external keyer sources in the ExtRtrSrc Settings (for 
MCEs) page. 

Choose ‘External Router Input’ if you want an external keyer source — one that is connected to 
routers in an associated NV9000 router control system. If you choose this option, the source 
section displays a drop-down list that allow you to select a source defined in the NV9000 
configuration. 

An external key comprises a fill source and a key source just as local keys do (unless of course it is 
a self-key). The source is identified by a single device having two (virtual) levels for key and fill.

• Check the ‘Self Key Enable’ box if the video fill is to use its own luminance values as key val-
ues. If you can determine that there is no key signal available for a fill, you should enable self-
key mode. The appearance of the keyer in self-key mode depend heavily on the composition 
of the fill signal.

If you don’t have the NV9000 system connected 
during configuration, the drop-down list does not 
appear. In that case, you must enter the database ID 
for the source you want directly.
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• Check the ‘Video Input is Analog’ box if the input is analog. The MCPM will then apply timing 
compensation to account for the A/D conversion. 

(The MCE does not allow analog keyer input. The analog checkbox is not displayed for 
MCEs.)

Keyer Parameters 
Opacity
The ‘Opacity %’ field specifies the maximum opacity of the keyer. Every pixel in the keyer has its 
own (computed) opacity. The MPCM multiplies the pixel opacity by this maximum value. 

Enter a value from 1.0 (nearly transparent) to 100.0 (opacity fully dependent on pixel opacity). 

Pixel opacity depends on the luminance of the ‘key’ pixel, the video gain and clip values, and 
whether other parameters such as S-shaping are applied. 

Video Clip, Video Gain
To understand clip and gain, refer to the Master Control Reference Manual. The clip and gain 
values are parameters that shape the key function and they are not at all obvious.

Enter a value from 0.0 to 100.0 (percent) in the ‘Video Clip’ field. Enter a number from 0 to 1023 
in the ‘Video Gain’ field. 

For MCEs, gain is expressed in integers in the range [0,1023] representing gain values in 
discrete multiples of 1/16 from 0 to 63 15/16. Unity gain therefore has a value of 16. 

For other (and older) MCPMs, gain is not scaled by 16: a value of 1 means unity gain and the 
maximum gain is 1023. In these MCPMs, there are no fractional gain values.

Operator Can Adjust Settings 
Check the ‘Operator Can Adjust Settings’ box if you want to allow the panel operator to adjust 
keyer settings (e.g., clip, gain, or opacity) and possibly save new default values. 

If you check this box, the operator can adjust all parameters of this setting, including whether 
the keyer operates in ‘self key’ mode, and the values in the keyer setting are its default values. 

S Shape Enable
Check the ‘S Shape Enable’ box to activate “S Shaping.” Set this parameter according to the keyer 
source’s configuration: if the external key signal is “S” shaped, turn “S Shaping” off. 

(S shaping smooths the key function.)

Luma and Chroma Filter Bypass
Check the ‘Luma Filter Bypass’ box to remove the luminance filter from the key processing chain. 
Check the ‘Chroma Filter Bypass’ box to remove the chroma filter from the key processing chain. 
These filters might prove useful if self-key mode is enabled, or if key signals are noisy.

Additive Key Mix Enable
Check the ‘Additive Key Mix Enable’ box to activate additive key mode. The mix of video from 
either the program or preset bus and the key fill changes:
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This is normal (or multiplicative) mixing:

Pixel′ = Fill × Key′ + Pixel (1 – Key′)
This is additive: 

Pixel′ = Fill + Pixel (1 – Key′)
(Key′ is the computed key value.)

Completing the Keyer Settings Configuration
Follow these steps to a complete keyer setting configuration:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or, cancel your changes either by clicking ‘New’ or by clicking any other keyer source in the 
list. MasterConfig will ask whether you want to apply changes. Respond ‘No’ if you do not.

Logo Images 
This is the ‘Logo Images’ configuration page: 

Fig. 4-18: Logo Images Page (Sample)

Logo images are used in the Logo Keyer Sources configuration page. 

The MCPM-MK-SD and MCPM-MK-HD have 1 logo keyer.1 Other MCPM types have 2 logo keyers. 
A logo image is a file stored within the MCPM that contains both a “fill” pixel map and a “key” 
pixel map. The stored logo image can either be a static logo or an animation. The luminance of 
pixels in the key portion form a mask for the pixels in the fill portion. The resultant masked 
image pixels are mixed with the pixels of the upstream video on the program or preset bus. The 
resulting mix might be further modified by downstream video effects. 

Tip

Until the keyer can be checked visually, (1) leave the clip at its default value, (2) leave 
the gain at its default, and (3) leave the S-shaping parameter unchecked.

Logo Image InformationLogo
Image

List

1. A logo keyer is firmware that mixes a logo with upstream video.
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A logo (comprising a logo image and a set of display parameters) can be positioned within the 
video frame. A logo can be opaque or partially transparent.

Before you can use a logo image in the MCPM, you must convert the logo’s original graphic 
artwork to the format required by MCPMs. Use MasterLogo to convert logo graphics. Master-
Logo is actually the tool that loads logos into the MCPM and is activated when MasterConfig 
writes a configuration to the MCPM. 

For MCEs, the logo keyers share a pool of up to 400 defined logo keyer settings. The logo keyer 
settings share a pool of up to 400 logo images. 

For other MCPMs, the logo keyers share a pool of up to 64 defined logo keyer settings. The logo 
keyer settings share a pool of up to 64 logo images. 

Purpose
This is what the ‘Logo Image’ page does:

• Names the logo images. (The logo names do not appear on the buttons and in the menus of 
master control panels. What appears on a logo button is the name of the logo keyer setting.)

• Specifies the type of logo: static or animated.

Page Organization
The ‘Logo Images’ page has 2 sections: 

1 The logo image list shows images that have already been created (in MasterLogo). They can 
be edited.

2 The logo image information section is simple: it names the image and specifies whether the 
logo is static or animated.

The Logo Keyer Sources configuration page specifies additional parameters such as opacity and 
position in the frame.

Logo Image List
The logo image list includes all the logo images you have defined for the MCPM or MCE. The 
images you define are shared by all logo inserters. 

A logo must be in the list before you can associate, using MasterLogo, a logo file with the 
logo list entry.

You can add entries to the list and remove or copy entries in the list. The name of an image need 
not be meaningful to panel operators. Operators see only the names of logo keyer settings. 

You can define up to 64 images for MCPMS and 400 for MCEs. Gaps in the numbering are 
permissible.

To Create a New Logo Image
Click ‘New’. You may edit the list entry now or at any time. Click ‘Apply’ to commit changes to the 
logo image definition.

This creates a new list entry, not a new logo file.

To Delete a Source
Highlight the image name in the list and click ‘Delete’. 
122



MasterConfig
User’s Guide
To Copy a Source
Highlight the image name in the list. Give it a new unused selection number and click ‘Apply’. If 
you choose an existing selection number, you will overwrite an existing image definition.

Logo Image Information
This section names the logo image and specifies whether the logo is static or animated. 

To edit existing image information, highlight it in the list. To edit a new image, simply click ‘New’. 

Selection Number 
Either use the supplied value or enter a value from 1 to 64. See Selection Numbers on page 38.

Mnemonic
Enter the name that you want to appear on a control panel’s logo button, up to 8 characters. Use 
alphanumeric characters, spaces, or underbars. Although you can enter other characters, the 
panels will not display them. 

Type
Choose ‘Single Image’ or ‘Animation’ in the drop-down list. (A single image is a static logo.) The 
logo file you associate (in MasterLogo) with this list entry should match the type you select.

An animated logo can (1) run once, (2) loop indefinitely, or (3) loop indefinitely with a pause 
between each pass of the loop. These characteristics are specified in the Logo Keyer Sources 
configuration page.

Completing a Logo Image Configuration 
Click ‘Apply’ to commit changes that you have not already applied. This action updates the 
configuration records with the changed information. 

Or

Cancel your changes either by clicking ‘New’ or by clicking any other keyer source in the list. 
MasterConfig will ask whether you want to apply changes. Respond ‘No’ if you do not. 

In all MCPMs but the MCE, the first logo is stored in MCPM flash memory. Remaining logos 
are stored in RAM and must be reloaded after an MCPM reset. The first logo must be static, 
not animated. (The first logo is the one identified by selno = 1.) The limit is 64 logos.

MCEs have no such logo restriction. Presently the limit is 400 logos (whether static or ani-
mated). Refer to the Master Control Reference Manual for more information. The total amount 
of storage available for logos is approximately 3 GB. The actual storage available varies 
according to the particular version of software in the MCE.
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e-
Logo Keyer Sources
This is the ‘Logo Keyer Sources’ configuration page: 

Fig. 4-19: Logo Keyer Sources Page (Sample)

The ‘Logo Keyer Sources’ page defines logo keyer settings by combining parameters such as 
opacity with logo images. The panel operator may select among the defined logo keyer 
settings. If you allow it, the operator may also change logo position and opacity. 

MCEs allow 400 logo keyer settings. Other MCPMs allow 64.

You can create many logo keyer settings from a single logo image, simply by varying position or 
any of the other parameters. (After being defined in MasterLogo, a logo’s size does not vary.)

There is a clean-feed tap after each logo. The tap is selected in the Misc. Settings page. (MCEs 
have two clean-feed outputs. MCPMs have one.)

Purpose
This is what the ‘Logo Keyer Sources’ page does:

• Names the logo keyer settings. (The names appear on the buttons and in the menus of mas-
ter control panels.)

• Identifies the logo image for the setting and specifies the processing parameters for the 
logo. 

Page Organization
There are 3 sections: 

1 The settings list shows settings that have already been created. They can be edited.

2 The logo selection section is simple: it names the setting and selects a logo image to use. 

Settings
List

Logo Param
ters

Logo Selection
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3 The logo parameters section allows you (1) to specify the appearance of the logo keyer and 
whether the panel operator can change any of the parameters. 

Settings List
The settings list includes all the logo keyer settings you have defined for the MCPM. The settings 
you define are shared by all logo inserters. 

To configure a setting, it must be in the list. You can add entries to the list and remove or copy 
entries in the list. The mnemonic (name) of a source should be meaningful to panel operators.

You can define up to 400 settings for MCEs and 64 settings for all other MCPMs. Gaps in the 
numbering are permissible.

You can assign each of 1 or 2 logo inserters a default setting that takes effect at system startup. 
The defaults are specified in the Video Effect and Over Settings configuration page.

To Create a New Setting
Click ‘New’. The page shows a set of default parameters. You may edit the parameters now or at 
any time. Click ‘Apply’ to commit changes to the keyer source definition.

To Delete a Setting
Highlight the setting in the list and click ‘Delete’. 

To Copy a Setting
Highlight the setting in the list. Give it a new unused selection number and click ‘Apply’. If you 
choose an existing selection number, you will overwrite an existing setting.

To Edit a Setting
Highlight the setting in the list and modify the parameters you want to change. Click ‘Apply’ to 
confirm your changes. If you wish to cancel your changes, either click another source or click 
‘New’. A query appears: 

Click ‘No’ to discard your changes.

Logo Selection
It is in the logo selection section that you identify the logo image for the setting. 

To edit an existing setting, highlight it in the settings list. To edit a new setting, simply click 
‘New’. 

IMPORTANT

The meaning of some of the logo parameters is not obvious. Refer to the video 
effects section of the Master Control Reference Manual for details
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Selection Number 
Either use the supplied value or enter a value from 1 to the maximum number allowed. See 
Selection Numbers on page 38.

Mnemonic
Enter the name that you want to appear on a control panel’s keyer button, up to 8 characters. 
Use alphanumeric characters, spaces, or underbars. Although you can enter other characters, 
the panels will not display them. 

Logo Image
Select one of the logo image names from the drop-down list in this section.

Logo Parameters 

Opacity
The ‘Opacity %’ field specifies the maximum opacity of the logo keyer. Every pixel in the keyer 
has its own (computed) opacity. The MPCM multiplies the pixel opacity by this maximum value. 

Enter a value from 1.0 (nearly transparent) to 100.0 (opacity fully dependent on the pixel 
opacity). 

A logo’s pixel opacity depends on the luminance of the ‘key’ pixel and the video gain and 
clip values. 

Video Clip, Video Gain
The term “video” in these two fields is misapplied. However, the clip and gain for logos work 
the same way as clip and gain for video keyers.

To understand clip and gain, refer to the Master Control Reference Manual. The clip and gain 
values are parameters that shape the logo key function and they are not at all obvious.

Enter a value from 0.0 to 100.0 (percent) in the ‘Video Clip’ field. Enter a number from 0 to 1023 
in the ‘Video Gain’ field. 

For MCEs, gain is expressed in integers in the range [0,1023] representing gain values in 
discrete multiples of !/!6 from 0 to 63 !5/!6. Unity gain is therefore expressed by a value of 
16. 

For other (and older) MCPMs, gain is not scaled by 16: a value of 1 means unity gain and the 
maximum gain is 1023. In these MCPMs, there are no fractional gain values.

Behavior
Choose one of the behaviors in the drop-down list:

• Static

• Animation (once)

• Animation (loop).
126



MasterConfig
User’s Guide
When you choose the loop option, an additional field appears in which you can specify the 
number of frames between passes of the loop:

A value of 0, of course, means no pause.

Operator Can Adjust Settings
Check the ‘Operator Can Adjust Settings’ box if you want to allow the panel operator to adjust 
logo keyer settings and possibly save new default values. 

If you check this box, the operator can adjust position and opacity but cannot adjust gain and 
clip values.

If the operator can adjust the settings, the parameter values you specify form the default values 
for the keyer setting and the operator can update the default settings at any time. 

Logo Image Position on Screen
You can specify the position of the logo by locating its top, left corner as a percentage of the 
video frame. It is possible to position the logo so that a portion of it is out of the video frame. 

If you click the ‘Modify Position Visually’ button, a configuration subpage appears in which you 
can see a “proxy” of the logo at it would appear in the video frame. 

Here, you can enter numeric values that express the position and opacity of the logo. (Press the 
keypad buttons to display a keypad on which to enter the numbers.) The white proxy will 
change position according to your entries.

The logo proxy itself does not change size. MasterConfig does not know what the size of the 
specified logo image is. The only parameters you can control here are position and opacity. 
Position values can range from 0 to 100% (of the screen). Logos are allowed to exceed the 
right and bottom edge of the screen. 
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Completing the Logo Keyer Settings
Follow these steps to a complete a logo keyer settings configuration:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or
Cancel your changes either by clicking ‘New’ or by clicking any other logo keyer setting in the 
list. MasterConfig will ask whether you want to apply changes. Respond ‘No’ if you do not. 

Logo Keyer Notes 
Please read the following important advice regarding logo keyers:

• Logo Storage 

• Logos and Automation 

• Alternative Logo Positioning Methods 

Logo Storage

MCE
MCEs have approximately 3 gigabytes of storage for logos. At present, the number of logos is 
limited to 400. At present, there is no information regarding the size of a logo file or the number 
of frames in an animation in an MCE. 

Other MCPMs
The logo store in the MCPM is 128MB for SD and 512MB for HD MCPMs. The maximum number 
of logos is 64. The maximum number of frames for an animated logo is 256.

The first logo image (selno=1 in the Logo Images page) must be static, not animated, and must 
be less than 1.7MB in size. This logo image is stored in the MCPM’s non-volatile memory and will 
always be available for use. The maximum file size for other logo images is 2.3MB. 

All other logos reside in RAM and are lost if the MCPM is reset or looses power. These logos must 
be sent to the MCPM after it has finished booting before they can be used. MasterLogo (a 
configuration utility) is used to perform this function. 

Logos and Automation
If you have an automation system driving the MCPM, the logos in the preset list can be accessed 
under the Miranda extended protocol. 

If a logo has been saved with the ‘Operator Can Adjust Position’ option checked, and if the auto-
mation system calls for the logo, there is no guarantee that the logo will appear in the 
“expected” position, with the expected opacity. The operator might have modified its position 
or opacity. 

Tip
Until the logo can be checked visually, (1) leave the clip at its default value, and 
(2) leave the gain at its default.
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If you want to permit operators to modify a logo’s parameters and also guarantee the logo’s 
characteristics under automation, create a clone of a protected logo keyer source. Then let the 
operator adjust the clone’s settings.

Alternative Logo Positioning Methods
The logo keyer “positioning” method in the ‘Logo Keyer Sources’ page is a coarse adjustment. 
Use a preview or preset monitor for precise logo positioning: 

1 Start with the “coarse” positioning method outlined in the previous section. Save the config-
uration, and write it to the MCPM.

2 On a control panel, call up the logo on the preset or program bus.

3 Edit the logo keyer on the panel to make fine position and opacity adjustments, while view-
ing the changes on your preview (or preset) monitor.

4 Method 1:

a Write down the numbers for position and opacity.

b Return to MasterConfig and, in the ‘Logo Keyer Sources’ page, enter the adjusted num-
bers for the desired logo keyer preset. 

5 Method 2:

a Press ‘Save as Default’ at the panel to store the modified parameters as logo keyer’s 
default in the MCPM.

b Return to MasterConfig and read the MCPM’s configuration (File > Read Config from 
MCPM).
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Squeeze Settings
This is the ‘Squeeze Settings’ configuration page: 

Fig. 4-20: Squeeze Settings Page (Sample)

This configuration page defines (1) the squeeze background and (2) the type and boundary of 
squeeze image 1. (Squeeze image 1 is what the panel operator chooses as the main source 
itself.) 

Squeezeback is a spatial transformation of video on the preset or program bus. Squeezeback 
reduces the size of the program image, either scaling or cropping the image to a region of the 
video frame, and providing a video underlay (which is the “squeeze background”). 

Squeezeback carries out the scaling or cropping effect gradually over the transition period — on 
the program bus — unless the transition type is a cut or a PB cut, in which case the squeezeback 
is (nearly) instantaneous. The preset bus (and preview bus if you are working with an MCE) 
shows only the final size of the squeezeback transition.

Enhanced squeezeback provides (1) squeezeback image borders and (2) an additional video 
source that can be scaled (but not cropped) to a second region. The additional video source 
provides audio that can be mixed with program output as an audio over. The second video 
source can be hidden (in which case, its audio is presumably all that is desired) or displayed in 
front of or behind the primary squeezed image. That is, you can control the visual priority of the 
two squeezed images. The second squeezeback image can be opaque, transparent, or partially 
transparent.

Border Options
(only for MCE an
MCPM-SDHD)

Squeeze
Settings

List

Basic 
Parameters

Source 
Selection
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Squeezeback and overs can be used — and controlled — by Intuition XG keys. See XStudio 
Add-On Commands on page 205 or the Master Control Reference Manual.

The squeezeback effect (when available) occurs in the middle of the video effect order. It 
squeezes the main source plus active upstream video effects. Effects downstream of the squee-
zeback generator are not affected by squeezeback. 

There is a clean-feed tap after the squeezeback generator. The clean-feed tap is selected in 
the Misc. Settings page. (MCEs have 2 clean-feed outputs. MCPMs have one.)

MasterConfig allows up to 32 squeeze settings (whether normal or enhanced).

Variations
Different MCPMs have different squeeze features:

• The MCPM-SD, MCPM-HD, and MCPM-H2 provide basic squeezeback functions (only). 

• The MCPM-MK-SD and MCPM-MK-HD do not have a squeezeback generator. The ‘Squeeze 
Settings’ page is not available for these MCPM types. 

• The MCPM-SDHD has an enhanced squeezeback generator. 

• The MCE also has an enhanced squeezeback generator but does not support distinct 
squeeze background inputs. For MCEs, squeeze background inputs must be main sources 
(or internally generated black/silence). 

For the MCPM-SDHD and MCE, MasterConfig provides an additional configuration page 
(Squeeze 2 Settings) and additional options under Video Effect and Over Settings. 

Purpose
This is what the ‘Squeeze Settings’ page does:

• Names the squeezeback settings. (The setting names appear on the buttons and in the 
menus of master control panels.)

• Specifies whether the setting is a scaling or cropping effect.

• Identifies the background video source for the setting and specifies the position and size of 
the final squeezeback region. 

• Specifies the color and border width of the region (for MCPM-SDHD and MCE which have 
enhanced squeezeback).

Use the Squeeze 2 Settings configuration page to specify the second image of enhanced squee-
zeback settings. 

Page Organization
There are 4 sections: 

1 The squeeze settings list shows settings that have already been created. They can be edited.

2 The source selection section specifies the video source for the squeeze background image. 

3 The basic parameters section specifies the type, position, size, and background source of the 
setting. It also specifies whether the panel operator can change the parameters. 

4 The border options section specifies the color and border width of the squeeze region. 
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Squeeze Settings List
• The settings list includes all the squeeze settings you have defined. 

• To configure a setting, it must be in the list. You can add entries to the list and remove or 
copy entries in the list. The mnemonic (name) of a source should be meaningful to panel 
operators.

• You can define up to 32 settings. Gaps in the numbering are permissible. 

Squeeze 2 settings must be associated with the entries in this list. That is, a squeeze 2 
setting is associated with a squeeze 1 setting if their selnos are the same.

You can assign the squeezeback generator a default setting that takes effect at system startup. 
The defaults are specified in the Video Effect and Over Settings configuration page.

To Create a New Setting
Click ‘New’. The page shows a set of default parameters (that has squeezeback borders 
disabled). You may edit the parameters now or at any time. Click ‘Apply’ at any time to commit 
changes to the squeezeback definition.

To Delete a Setting
Highlight the setting in the list and click ‘Delete’. 

To Copy a Setting
Highlight the setting in the list. Give it a new unused selection number and click ‘Apply’. If you 
choose an existing selection number, you will overwrite an existing setting.

To Edit a Setting
Highlight the setting in the list and then modify the parameters you want to change. Click 
‘Apply’ to confirm your changes. If you wish to cancel your changes, either click another setting 
in the list or click ‘New’. A query appears: 

Click ‘No’ to discard your changes.

Source Selection
To edit an existing setting, highlight it in the settings list. To edit a new setting, simply click 
‘New’. 

Selection Number 
Either use the supplied value or enter a value from 1 to 32. See Selection Numbers on page 38.
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Mnemonic
Enter the name that you want to appear on a control panel’s keyer button, up to 8 characters. 
Use alphanumeric characters, spaces, or underbars. Although you can enter other characters, 
the panels will not display them. 

Background Source 
The “background” is the image that fills the space vacated by the squeezed (or cropped) 
program image(s). The background source appears “behind” the squeeze 1 region. 

Directly beneath the mnemonic field is a drop-down list for the background source type: 

There are 2 choices for MCEs and 3 choices for other MCPMs:

• Master Control Input.

• Internal Black.

• Main Source.

The main sources provide access to external squeeze background sources (i.e., sources com-
ing from an NV9000 router control system). 

MCEs do not allow master control inputs for squeeze backgrounds. 

Master Control Input
You can choose ‘Master Control Input’ if you are not configuring an MCE and want a local 
squeeze background source — one that is connected directly at the NV5100MC backplane. 

This is the default keyer source type. 

Enter the connector number for the squeeze background input. Check the ‘Video Input is 
Analog’ box if the input is analog. The MCPM will then apply timing compensation to account 
for the A/D conversion. 

Internal Black
Choose ‘Internal Black’ if you want the squeeze background source to use the internal black 
generator: 

Note that a source that uses internally generated black cannot be selected on the aux bus as a 
preset or preview squeeze image.

Other MCPMsMCEs
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Main Source
Choose ‘Main Source’ if you want to use a main source as a squeeze background. 

Main sources include squeeze background images and squeeze 2 (i.e., image 2 or “P2”) images 
as well as strictly main sources (those sources that can be used on main source buttons as 
program content). 

Main sources can include local sources, external router sources, and router pre-select sources.

There is no intrinsic distinction between the different kinds of main sources. It is up to you and 
the operator (and your facility) to manage your squeeze images. 

Squeeze 2 images can be accompanied by audio. Squeeze background images cannot. 

Main sources that are used as squeeze sources and that are external come through the BNCs 
specified for external squeeze sources, and not through the BNCs for external main sources. 
Although this distinction is “transparent” to the panel operator, it might be of concern when 
you are configuring the MCPM or MCE.

Basic Parameters

Effect Type
Choose ‘Squeeze’ or ‘Crop’ in the drop-down list. ‘Squeeze’ means the program image is scaled 
to the squeeze region. ‘Crop’ means the program image is trimmed, but not scaled, to the 
squeeze region.

Operator Can Adjust Position
Check the ‘Operator Can Adjust Position’ box if you want to allow the panel operator to adjust 
squeeze settings and possibly save new default values. 

If you check this box, the operator can adjust position, size, border width, and border color, and 
other options. If the operator is using an enhanced squeeze effect, the operator can change the 
opacity of the second squeeze region and its video source.

If the operator can adjust the settings, the parameter values you specify are the default values 
for the squeeze setting. The operator can save new settings as the default.

Position and Size
A ‘squeeze’ setting is specified by top, left, height, and width values. A ‘crop’ setting is specified 
by top, left, right, and bottom values. Squeeze or crop values are expressed as a percentage of 
the video frame. 
134



MasterConfig
User’s Guide
If you click the ‘Modify Position’ button, a secondary configuration page appears in which you 
(the configurer) can see a “proxy” of the squeezeback at it would appear in the video frame. 

Fig. 4-21: Squeezeback Position Edit (Sample)

Here, you can enter numeric values that express the position and size of the squeezeback 
region. (Press the keypad buttons to display a keypad on which to enter the numbers.) The 
white proxy will change position and size according to your entries.

The ‘Lock Aspect’ button is a toggle: press it to maintain the existing aspect ratio of the squeeze 
region. The ‘Width’ field becomes disabled and the size is specified by height only. When the 
aspect ratio us unlocked, the ‘Width’ field becomes active. 

This lock applies only when you are creating the squeeze setting. If you allow operator 
changes, the operator can lock or unlock the aspect ratio at will.

The ‘Crop Position Edit’ page is similar to the Squeeze Position Edit page, except that (1) you 
specify four edge positions, and not size, and (2) there is no ‘Lock Aspect’ button.

Border Options
Squeezeback borders are available only for MCEs and MCPM-SDHDs. 

If you are configuring an MCE or MCPM-SDHD, check the ‘Border Enabled’ box if you want the 
squeeze region to have a border. Color and thickness subsections appear under the ‘Border 
Enabled’ checkbox. The four border widths — all independent — are expressed as a percentage 
of the video frame — from 0% (not visible) to 5% (moderately thick) in 0.1% increments. (If the 
operator is viewing a squeeze window proxy on a panel LCD, the borders are always red. If the 
operator is viewing a squeeze effect on a preview monitor, the borders are of course, true color.)

Unlocked
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Border colors are expressed as HSB (hue, saturation, brightness) values. Express hue as a decimal 
number from 0.0 to 359.9 (degrees). The angles are positions on a “color wheel”:

Saturation is generally the amount of “color” in the color. Express “saturation” from 0 to 100% 
where 0% means completely absence of color and 100% means maximum color. 

In master control, brightness values adjust the amount of black in a color. A value of 0% repre-
sents a color that is completely black and a value of 100% represents a color that has no black. 

The concepts of saturation and brightness are not completely independent. It is a combination 
of the “saturation” and “brightness” values that yield various gray levels, tints, and shades of 
color. See Color Values on page 202.

Completing a Squeeze Setting
Follow these steps to a complete a squeeze setting configuration:

1 Review all changes.

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or

Cancel your changes either by clicking ‘New’ or by clicking any other squeeze setting in the 
list. MasterConfig will ask whether you want to apply changes. Respond ‘No’ if you do not. 

Squeeze 2 settings (for enhanced squeezeback) must be associated with the squeeze 
settings defined in this configuration page. See Squeeze 2 Settings, following.

Please note the following points regarding squeezeback:

• The same background video input may be used in more than one squeeze setting. It is also 
possible to use a different background video input for every setting.

• You cannot place the squeezeback region so that it goes outside the video frame. 

For a scaled region, the sum of the left and width values must be no more than 100%; the 
sum of the top and height values must be no more than 100%. The minimum height or 
width is 30%.

For a cropped region, each of the ‘crop from left’, ‘crop from right’, ‘crop from top’, and ‘crop 
from bottom’ values may range from 0 to 100%. Thus, the minimum height or width is 0%.

The borders (if any) may exceed the video frame.
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Squeezeback Notes
Please read the following important notes regarding squeezeback effects:

Squeezeback and Automation 
If you have an automation system driving the MCPM, the squeezeback effects in the preset list 
can be accessed under the Miranda extended protocol. 

• If a squeezeback effect has been saved with the ‘Operator Can Adjust Position’ option 
enabled, and if the automation system calls for the effect, there is no guarantee that the 
effect will appear in the “expected” position. The operator might have modified its position. 

• If you want to permit operators to change a squeezeback effect’s parameters and also guar-
antee the effect’s characteristics under automation, create a clone of a protected effect. Then 
let the operator adjust the clone’s settings.

Alternative Squeezeback Positioning Methods
The squeezeback “positioning” method in the ‘Position Edit’ page is a coarse adjustment. Use a 
preview monitor for precise squeezeback positioning: 

1 Start with the “coarse” positioning method outlined in the previous section. Save the config-
uration, and write it to the MCPM.

2 On a control panel, place the squeezeback effect on the preset or program bus.

3 Use the ‘Edit/Modify’ function on the panel to make fine adjustments, while viewing the 
changes on your monitor.

4 Method 1:

a Write down the numbers for position, size, crop, etc., as appropriate.

b Return to MasterConfig, and in the squeezeback ‘Position Edit’ page, enter the adjusted 
numbers for the desired squeezeback effect. 

5 Method 2:

a Press Save as Default’ to store the modified squeezeback effect as the preset’s new 
default value in the MCPM.

b Return to MasterConfig, and read the MCPM’s configuration (File > Read Config from 
MCPM).

Note

The MCPM (or MCE) applies an edge crop, as part of the squeeze, to conceal any edge 
artifacts that might occur as the image is squeezed. This crop is not the same as a 
squeezeback crop effect. This additional crop is applied inside the MCPM’s squeeze-
back region. See Video Effect and Over Settings on page 157. 
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Squeeze 2 Settings
This is the ‘Squeeze 2 Settings’ configuration page: 

Fig. 4-22: Squeeze 2 Settings Page (Sample)

This configuration page defines (1) the type and boundary of squeeze image 2 and (2) the visual 
relationship of the 2 squeeze images and the squeeze background. 

Squeeze 2 settings apply only to the MCPM-SDHD and the MCE. If you are not configuring an 
MCPM-SDHD or an MCE, the squeeze 2 settings are not available. (The configuration page is 
absent.)

The ‘Squeeze 2 Settings’ page configures squeezeback enhancements. Enhanced squeezeback 
adds a second video image (which is a main source) possibly with audio. Image 2, as it is called, 
can be transparent or partially transparent, and can be (1) invisible, (2) in front of the primary 
image, or (3) behind the primary image (i.e., image 1 or squeeze 1). That is, you can control the 
visual priority of the two squeezed images. The primary image is what the panel operator chose 
as the main source. 

Image 2 can be opaque, transparent, or partially transparent. It cannot be a crop effect. 

Image 2 comes from one of the main sources. An operator (if allowed to change the setting) can 
select any main source. The main source’s audio — discrete, embedded, Dolby, etc. — can be 
part of the squeezeback effect. The audio for the effect is handled as an audio over. Squeeze-
back audio must be enabled or disabled on this page and also on the Video Effect and Over 
Settings page.

Border 
Options

Squeeze 2
Settings

List

Parame
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A squeeze 2 setting must be associated with a basic squeeze setting for it to be usable. When a 
squeeze 2 setting has the same selno as a basic squeeze setting, they are associated. If you 
create a squeeze 2 setting with a selno that does not match a squeeze 1 selno, you will see a 
warning message.

Whether an operator can adjust the squeeze 2 parameters is determined by the associated 
squeeze 1 setting — its “operator can adjust settings” option.

Purpose
This is what the ‘Squeeze 2 Settings’ page does:

• Names the squeezeback 2 settings. (Panel operators do not see these names.)

• Identifies the video source (one of the main sources, previously defined) for the second 
image.

• Specifies the opacity and layering of the squeeze 2 image.

• Provides an audio option and specifies the audio mix.

• Specifies the position and size of the final image 2 region. 

• Specifies the color and border width of the region.

Page Organization
There are 3 sections: 

1 The squeeze 2 settings list shows settings that have already been created. They can be 
edited.

2 The squeezeback 2 parameters section specifies the layering, opacity, position, size, and 
main source of the squeeze 2 image. It also enables or disables the squeezeback audio for 
the image. 

3 The border options section specifies the color and border width of the squeeze region. 

Squeeze 2 Settings List 
The settings list includes all the squeeze 2 settings you have defined. 

To configure a setting, it must be in the list. You can add entries to the list and remove or copy 
entries in the list. The name of a squeeze 2 setting need not be meaningful to panel operators.

You can define up to 32 settings. Gaps in the numbering are permissible. 

To be useful, a squeeze 2 setting must be associated with a basic squeeze setting. A squeeze 
2 setting and a basic squeeze setting are associated when they have the same selno.

You can assign the squeezeback generator a default setting that takes effect at system startup. 
The defaults are specified in the Video Effect and Over Settings configuration page.

To Create a New Setting

Click ‘New’. The page shows a set of default parameters (with borders disabled). You may edit 
the parameters now or at any time. Click ‘Apply’ at any time to commit changes to the squeeze 2 
definition.

To Delete a Setting

Highlight the setting in the list and click ‘Delete’. 
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To Copy a Setting

Highlight the setting in the list. Give it a new unused selection number and click ‘Apply’. If you 
choose an existing selection number, you will overwrite an existing setting.

To Edit a Setting

Highlight the setting in the list and modify the parameters you want to change. Click ‘Apply’ to 
confirm your changes. If you wish to cancel your changes, either click another setting in the list 
or click ‘New’. A query appears: 

Click ‘No’ to discard your changes.

Setting Selection
To edit an existing setting, highlight it in the settings list. To edit a new setting, simply click 
‘New’. 

Selection Number 
Either use the supplied value or enter a value from 1 to 32. See Selection Numbers on page 38.

Mnemonic
Give a name to the setting, up to 8 characters. Squeeze 2 setting names do not appear on panel 
buttons. The names of the associated squeeze settings do appear on buttons.

Squeezeback 2 Parameters 

Opacity
The ‘Opacity %’ field specifies the opacity of image 2. The MPCM multiplies every pixel value in 
every frame of image 2 by this value. 

Enter a value from 0.0 (fully transparent, or invisible) to 100.0 (fully opaque). 

Video Layering
Image 2 can be controlled with respect to image 1 and to the background video chosen in the 
basic squeeze settings. Choose one of the 3 options in the drop-down list:

• Not visible. (This allows the audio, if any, and not the video.)

• Under primary squeeze. (Image 1 has visual priority.)

• Over primary squeeze. (Image 2 has visual priority.)

(The “primary squeeze” is image 1, that is, what the operator chose as the main source.)

Modify Position and Size
A squeeze 2 setting is specified by top, left, height, and width values. These values are expressed 
as percentages of the video frame. The position and size values listed are for display only. You 
cannot modify the position and size in these boxes. To change the position and size, click the 
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‘Modify Position’ button. A second configuration page appears in which you can see a “proxy” of 
the squeezeback at it would appear in the video frame. 

Fig. 4-23: Squeeze 2 Position Edit (Sample)

Here, you can enter numeric values that express the position and size of the squeezeback 
region. (Press the keypad buttons to display a keypad on which to enter the numbers.) The 
white proxy will change position according to your entries.

The ‘Lock Aspect’ button is a toggle: press it to maintain the existing aspect ratio of the squeeze 
region. The ‘Width’ field becomes disabled and the size is specified by height only. When the 
aspect ratio us unlocked, the ‘Width’ field becomes active. 

Main Source
Choose a squeeze 2 image from the drop-down list of the main sources. 

Image 2 can appear in front of or behind image 1, or it can be invisible.

Main sources include squeeze 1 and squeeze 2 images as well as strictly main sources (those 
sources that can be used on main source buttons as program content). 

Main sources can include local sources, external router sources, and router pre-select sources.

There is no intrinsic distinction between the different kinds of main sources. It is up to you, the 
panel operators (and your facility) to manage your squeeze images. 

Use Audio from Main Source
Check the ‘Use Audio from Main Source’ box if you want to use the audio from the main source 
in the squeeze effect. When you check the box, an ‘Over %’ field appears: 

Unlocked
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Specify the over-to-main ratio in this field. Note that the ratio is non-linear. A ratio of 50% means 
that audio is a mix of 100% main and 100% over. 

The squeezeback audio is handled as an audio over. The operator must select the squeeze-
back audio on an over button for it to be heard.

You must enable squeeze 2 audio in the ‘Squeeze Image 2’ section of the Video Effect and 
Over Settings configuration page described on page 157.

Border Options
Squeezeback borders are available only for MCEs and MCPM-SDHDs. 

If you are configuring an MCE or MCPM-SDHD, check the ‘Border Enabled’ box if you want the 
squeeze 2 region to have a border. Color and thickness subsections appear under the ‘Border 
Enabled’ checkbox. The four border widths — all independent — are expressed as a percentage 
of the video frame — from 0% (not visible) to 5% (moderately thick) in 0.1% increments. (If the 
operator is viewing a squeeze window proxy on a panel LCD, the borders are always red. If the 
operator is viewing a squeeze effect on a preview monitor, the borders are of course, true color.)

Border colors are expressed as HSB (hue, saturation, brightness) values. Express hue as a decimal 
number from 0.0 to 359.9 (degrees). The angles are positions on a “color wheel”:

Saturation is generally the amount of “color” in the color. Express “saturation” from 0 to 100% 
where 0% means completely absence of color and 100% means maximum color. 

In master control, brightness values adjust the amount of black in a color. A value of 0% repre-
sents a color that is completely black and a value of 100% represents a color that has no black. 

The concepts of saturation and brightness are not completely independent. It is a combination 
of the “saturation” and “brightness” values that yield various gray levels, tints, and shades of 
color. See Color Values on page 202.

Completing a Squeeze 2 Setting
Follow these steps to a complete a squeeze 2 setting configuration:

1 Review all changes. 

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or

Cancel your changes either by clicking ‘New’ or by clicking any other squeeze setting in the 
list. MasterConfig will ask whether you want to apply changes. Respond ‘No’ if you do not. 

A squeeze 2 setting (for enhanced squeezeback) must eventually be associated with a 
basic squeeze setting if the squeezeback enhancements are to be effective. 
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Please note the following points regarding squeezeback:

• The same main source may be used in more than one squeeze 2 setting. 

• The same (special) audio over is used for all enhanced squeezeback audio.

• You cannot place the squeezeback region so that it goes outside the video frame. The mini-
mum height or width is 30%. The borders (if any) may exceed the video frame.

Squeezeback 2 Notes
Although you, the configurer, define enhanced squeeze settings and basic squeeze settings 
separately, the settings are merged at a control panel. The operator controls both squeezeback 
images under one menu. The operator does not necessarily know which squeezeback effects 
are dual-image and which are not.

The operator’s squeezeback menus for MCPM-SDHDs and MCEs are different from the squeeze-
back menus of other MCPMs. 

Squeezeback and Automation 
If you have an automation system driving the MCPM, the squeezeback effects in the preset list 
can be accessed under the Miranda extended protocol. 

• If a squeezeback effect has been saved with the ‘Operator Can Adjust Position’ option 
enabled, and if the automation system calls for the effect, there is no guarantee that the 
effect will appear in the “expected” position. The operator might have modified its position. 

• If you want to permit operators to change a squeezeback effect’s parameters and also guar-
antee the effect’s characteristics under automation, create a clone of a protected effect. Then 
let the operator adjust the clone’s settings.

Alternative Squeezeback Positioning Methods
The squeezeback “positioning” method in the ‘Position Edit’ page is a coarse adjustment. Use a 
preview monitor for precise squeezeback positioning: 

1 Start with the “coarse” positioning method outlined in the previous section. Save the config-
uration, and write it to the MCPM.

2 On a control panel, place the squeezeback effect on the preset or program bus.

3 Use the ‘Edit/Modify’ function on the panel to make fine position adjustments, border width 
and color adjustments, opacity adjustments, etc., while viewing the changes on your moni-
tor.

4 Method 1:

a Write down the numbers for position, size, opacity, etc., as appropriate.

b Return to MasterConfig, and in the squeezeback ‘Position Edit’ page, enter the adjusted 
numbers for the desired squeezeback effect. 

5 Method 2:

a Press Save as Default’ to store the modified squeezeback effect as the setting’s new 
default in the MCPM. 

b Return to MasterConfig, and read the MCPM’s configuration (File > Read Config from 
MCPM). 
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RS-422 Communication Settings
This is the ‘RS422 Communication Settings’ configuration page: 

Fig. 4-24: RS-422 Communication Settings Page (Sample)

Use the ‘RS422 Communications Settings’ page to define important automation parameters. 
(What you enter in this page depends, of course, on your automation system.)

Purpose
This is what the ‘RS422 Communication Settings’ page does:

• Enables the MCPM’s automation port (RS-422, DE9). 

• Specifies the port’s Baud rate.

• Presents options regarding when and whether automation is on or off.

• Specifies the behavior of the MCPM when automation is turned off. 

• Optionally, maps XG layers to selected video effect bits.

Parameters 
RS422 Port Enabled
Check the ‘RS422 Port Enabled’ box if you want to enable automation for the MCPM. Specifically, 
this option enables RS422 communication. When you check this box, other automation options 
appear in the page. Otherwise, the page is largely blank.

Port Disabled Port Enabled

XG Layer Mapping Bits
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RS422 Baud Rate
When RS422 communication is enabled, you must choose a Baud rate from the drop-down list. 
There are 5 choices:

9600 19,200 38,400 57,600 115,200

The default rate is 38,400 Baud.

Automation
There are 3 checkbox options:

• Default state is on. 

• Check this box if you want to the reset state of the MCPM to have automation on. 
Uncheck the box if you want the reset state to have automation turned off. 

• State change enabled. 

Check this box if you want the panel operator to be able to turn automation on and off. (This 
option presumes that the panel has an ‘Automation Off’ button.)

If you do not check this box, automation remains in its reset (or default) state.

• Disabled during lever arm operation. 

A transition lever arm (TLA, or T-bar) is an option that lets operators perform manual transi-
tions. If your system includes control panels with attached transition lever arms, you might 
want your MCPM to disable automation while a manual transition is in progress. 

Manual transitions are of indefinite duration.

Behavior when Off
“Automation off” means that the MCPM does not execute automation commands. It does not 
mean that the automation system is turned off. The automation may continue to issue 
commands. The MCPM can have one of 3 behaviors when automation is “off.” Choose a behavior 
from the drop-down list:

• Do not reply to commands. 

The MCPM neither executes nor acknowledges commands. 

• Reply to commands normally but do not execute. 

Although the MCPM does not execute commands, it does send a normal reply. 

• Reply to commands with ‘error’ or ‘disabled’. This is the default behavior. 

In this mode, the MCPM does not execute the command and sends an error response so that 
the automation system can take action. 

Keyer Layer Remapping 
The remapping options allow the automation protocol to control XG layers. 

N.B. There are 4 Intuition XG layers. 

These options are for “experts”— those who are familiar with the master control automation 
protocol and with other system matters. 
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There are 4 commands in the automation protocol affected by the remapping (and which moti-
vated the remapping):

Name Code Description
Key mod 0x0A Assign a specific effect to a selected effect processor

and optionally assigns characteristics to the effect.
Key enable 0x0B Enable the selected effect processors.
Video effect select 0xA1 Similar to ‘key mod’ but has a 16-bit operand and no

options.
Video effect take 0xA2 Same as ‘key enable’ but has a 16-bit operand.

In these commands, the first argument is a bit mask in which different effect processors are 
selected. Presently only the first 6 bits are in use: 

Bit Default Effect Bit Default Effect
1 Keyer 1 5 Squeezeback
2 Keyer 2 6 Logo B
3 Keyer 3 7 (unused)
4 Logo A 8 (unused

(Bits 9–16 in the 16-bit commands are also unused.)

The RS-422 configuration page allows you to assign any of these bits to Intuition XG layers. The 
mapping presently allows you to select layers 1–8, but only layers 1–4 are available. Layers 5–8 
are for future expansion.

Example: assign bit 4 (representing, by default, logo A) to XG layer 4. Whenever the MCE 
receives a ‘key mod’ command (for instance) with bit 4 set, it will modify XG layer 4 instead of 
logo A. 

If, before, a command was 

‹keymod› ‹logo A› ‹logo 6› 

the same exact command would now mean 

‹keymod› ‹XG layer 4› ‹XG recall ID 6›. 

XG layer mapping applies only to MCEs that are integrated with Intuition XG and that are 
subject to automation. 

Bit remapping is for experts only. You can cause serious problems if you get it wrong. The prob-
lems can be corrected — you will not actually damage anything. Using the protocol bits is 
elementary, but the side effects in your system can be unpredictable. Note also that when you 
do a mapping, automation loses the video effect that was reassigned. You must remap only 
those effects you can afford to sacrifice.

Completing the RS-422 Configuration
Follow these steps to a complete the RS-422 port configuration:

1 Review all changes. 

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or

Click ‘Default’ to discard your changes and revert to default values. 
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Button Mapping—Main Source
The ‘Button Mapping — Main Source’ configuration page is available only if you checked ‘Enable 
Main Source Button Mapping’ in the General Settings page: 

Fig. 4-25: Button Mapping — Main Source Page (Sample) 

If you choose not to use main source mapping, you will get the default: source n on button n 
where 1 < n < 16. If source n is not defined, button n will be unassigned (blank). A source 
whose selno is greater than 16 will not be usable.

For panels controlling MCEs for which source groups are enabled, button mapping for main 
sources is disabled. Source groups take the place of button mapping.

An MCPM supports up to 128 main sources.1 A control panel has 16 (pairs of ) main source 
buttons2 that correspond to the layers. (Generally, the operator can use one main source at a 
time, although one can be selected on preset and another can be selected on program.)

Button mapping allows access to all defined main sources. This button mapping page allows 
you to specify how the main sources buttons on a panel behave. The behavior is actually 
internal to the MCPM; the panel buttons reflect that behavior.

Mapping 
Section

Button
List

1. Some MCPMs support only 64 main sources. The MCPM-MK-HD supports 16 main sources and those are 
from its own backplane module.

2. Not all master control panels have 16 physical main source buttons. Those that do not have exactly 16 
“virtual main source buttons.”
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The ‘Operator can modify’ option lets the operator choose the source to be selected by a button 
press. Thus, the operator has access to all the sources that you have defined, either on the bus or 
in a button map menu. 

If a source is already on the bus, it does not appear as a operator’s choice in a menu list. 
Automation can select it however.

Checking ‘System can modify’ lets automation choose the source. 

You can configure any or all of the main source buttons as modifiable. (The operator must know 
which buttons are operator-modifiable. Automation does not need to “know” which buttons are 
system-modifiable.) 

Reminder: main sources include squeeze 1 (background) and squeeze 2 (image 2) images as 
well as strictly main sources (those sources that can be used on main source buttons as 
program content). 

Main sources can include local sources, external router sources, and router pre-select 
sources.

There is no intrinsic distinction between the different kinds of main sources. It is up to you 
and the operator (and your facility) to manage your main sources. 

Purpose
This is what the ‘Button Mapping — Main Source’ page does:

• Specifies whether the main source button is “modifiable” — whether its main source can be 
changed during operation.

• Identifies the default main source for modifiable buttons. 

• Identifies the fixed main source for non-modifiable buttons. 

Page Organization
The ‘Button Mapping — Main Source’ configuration page has 2 sections: 

1 The button list represents the 16 main source buttons of a control panel. 

2 The mapping section allows you to specify (1) whether a button is modifiable and (2) the 
default (or fixed) main source assigned to the button.

Button List
The button list is not modifiable. To select a button, highlight it in the list.

• • •

(1) 2 35 • • • 95 112

12741

Automation may always choose any 
defined source. The operator may 
choose any of the sources listed in the 
menu of the control panel.

Pre-Assigned Sources

All Defined Sources

Program/Preset Buttons

• • •
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Mapping Section

Default Source 
Choose a main source from the drop-down list. That is the default source for that button.

A different kind of default main source — with a different meaning — can be named on the 
Misc. Settings page. 

Check Boxes
There are two check boxes in this section:

• Check the ‘Operator can modify’ box if you want the panel operator to be able to select the 
main source controlled by the button.

• Check the ‘System can modify’ box if you want automation to be able to select the main 
source controlled by the button. If your system has no automation, this option is irrelevant.

If you check neither box, the button is “fixed” and the main source you chose in the drop-
down list is a fixed main source. 

If you check either box, the button is “modifiable” and the main source you chose in the drop-
down list is the default main source — the main source assigned when the MCPM resets. 

If automation selects a main source not mapped to one of the 16 main source buttons and 
one of the buttons has ‘system can modify’ enabled, the main source selected by automa-
tion will be assigned to that button. 

If you are using automation, we recommend making at least one, preferably four, main 
source buttons system-modifiable. The system chooses the least recently used modifiable 
button. Having four dynamic buttons facilitate automated video/audio breakaway on the 
preset and program buses.

Completing the Button Mapping Configuration 
Click ‘Apply’ when you have finished specifying the button mapping. There is no “cancel” 
function.
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Button Mapping—Over Source 
The ‘Button Mapping — Over Source’ configuration page is available only if you checked ‘Enable 
Over Source Button Mapping’ in the General Settings page: 

Fig. 4-26: Button Mapping — Over Source Page (Sample)

If you choose not to use over source mapping, you’ll get the default: over 1 on button 1 and 
over2 on button 2. If source n is not defined, button n will be unassigned (blank). A source 
whose selno is greater than 2 will not be usable.

An MCPM or MCE has 2 audio over “layers” and a control panel has 2 (pairs of ) audio over 
buttons that correspond to the layers. (The operator can use one audio over at a time, although 
one can be on preset and the other can be on program.)

Some panels can be configured with only one over button; others might have none.

An MCPM or MCE supports up to 4 over sources. Button mapping allows you to access all 
defined over sources on 2 or fewer buttons. Some panels might be configured with just one 
audio over button or none at all. 

An additional over source ‘Squeeze Image 2 Over Source’ is defined if squeeze audio is 
enabled (in the Video Effect and Over Settings page).

This button mapping page allows you to specify how the audio layers (and the audio over 
buttons on a panel) behave. 

The ‘Operator can modify’ option lets the operator choose the source to be selected by a button 
press. Thus, the operator has access to all the sources that you have defined, either on the bus or 
in a button map menu:. 

If a source is on the bus, it does not appear as a operator’s choice in a menu list. Automation 
can select it however.

Mapping 
Section

Button
List

1 2 (3) 4

41

Pre-Assigned Sources

All Defined Sources

Over Buttons

3

Over Buttons
Sources mapped to button 2: the syst
may choose any one of these. The op
tor may choose any but source 3 (whic
already on a button).

Without Button Mapping With Button Mapping
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Checking ‘System can modify’ lets automation choose the source. 

Reminder: over sources can include local sources, external router sources, and router pre-
select sources. There is no intrinsic distinction between the different kinds of over sources. It 
is up to you, the operators (and your facility) to manage your over sources. 

The pre-defined audio overs (one for Intuition XG audio, and one for squeeze image 2 audio) 
are also mapped to over buttons.

Purpose
This is what the ‘Button Mapping — Over Source’ page does:

• Specifies whether the button is “modifiable”— whether its over source can be changed dur-
ing operation.

• Identifies the default over source for modifiable buttons. 

• Identifies the fixed over source for non-modifiable buttons. 

Page Organization
The ‘Button Mapping — Over Source’ configuration page has 2 sections: 

1 The button list represents the two audio over buttons of a control panel. 

2 The mapping section allows you to specify (1) whether a button is modifiable and (2) the 
default or fixed source assigned to the button.

Button List
The button list is not modifiable. To select a button, highlight it in the list.

Mapping Section

Default Source 
Choose an over source from the drop-down list. That is the default source for that button.

If audio for enhanced squeezeback (MCPM-SDHD only) is enabled, an additional over source 
is available. It is called “Squeeze Image 2 Over Source.”

Check Boxes
There are two check boxes in this section:

• Check the ‘Operator can modify’ box if you want the panel operator to be able to select the 
over source controlled by the button.

• Check the ‘System can modify’ box if you want automation to be able to select the over 
source controlled by the button. If your system has no automation, this option is irrelevant.

If you check neither box, the button is “fixed” and the over source you chose in the drop-
down list is a fixed over source. 

If you check either box, the button is “modifiable” and the over source you chose in the drop-
down list is the default over source — the over source assigned when the MCPM resets. 
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If automation selects an over not mapped to one of the two over buttons and one of the 
buttons has ‘system can modify’ enabled, the over selected by automation will be assigned 
to that button. (Remember that an over button corresponds to one of the MCPM’s over 
layers.)

If you are using automation, we recommend at least one system-modifiable over button.

Completing the Button Mapping Configuration 
Click ‘Apply’ when you have finished specifying the button mapping. There is no “cancel” 
function.

Misc. Settings
This is the ‘Misc Settings’ configuration page for an MCPM: 

Fig. 4-27: Misc Settings Page (Sample, MCPM-SD)

The ‘Misc Settings’ page lets you define the default main source (at power-up), the point from 
which the clean feed output originates, the active video area, loss of signal (LOS) options, and 
Dolby metadata options. 

Emergency Bypass 
Option

LOS Section

Source
Section

Active
Video Sec-

tion

Dolby
Metadata

Section
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This is the ‘Misc Settings’ configuration page for an MCE: 

Fig. 4-28: Misc Settings Page (Sample, MCE)

It has additional sections: 

• Two clean feed taps.

• Source specification for each of the 8 Dolby metadata outputs. (These fields are not present 
when the MCE does not have an AXM card.)

Purpose
This is what the ‘Misc Settings’ page does:

• Identifies the (single) default main source. 

• Selects the clean-feed tap(s). 

• Enables or disables external control of the emergency bypass state.

• Specifies the first and last lines of active video.

• Selects the behavior of the program main source under LOS.

• Selects the behavior of Dolby metadata outputs.

• Specifies the LOS matte color.

Emergency Bypass 
Option

LOS Section

Source
Section

Dolby
Metadata

Section

Active Video 
Section
153



Operation
Misc. Settings
Page Organization
The ‘Misc Settings’ configuration page has 5 sections: 

1 The source section specifies the default main source and the clean-feed taps. 

2 The active video section specifies the first and last lines of active video. 

3 The metadata section specifies the behavior of Dolby metadata output 2 (for MCPMs) and all 
metadata outputs for MCEs. 

4 The emergency bypass option whether external control of the emergency bypass relay is 
allowed.

5 The LOS section specifies the MCPM’s behavior under LOS and the color to use for the LOS 
matte.

Source Section

Default Main Source
The default main source is the main source selected immediately after the MCPM resets. Choose 
any of the entries from the drop-down list. The entries in the list are the sources defined in the 
‘Main Sources’ configuration page. If you want black/silence to be the default, define at least 
one main source as black/silence. You can choose the entry ‘[none]’.

MasterConfig asks you to specify a default source at some point before saving or sending 
your configuration file. 

This default is not the same as the several default sources applied to modifiable main source 
buttons. 

Main sources can include squeezeback sources. Main sources can include local sources, 
external router sources, and router pre-select sources.

Clean Feed Source
An MCPM provides a clean-feed output. MCEs provide two clean-feed outputs, A and B. To 
configure a clean-feed output, choose one of the sources (“taps”) in the drop-down list. The 
clean-feed “tap” can be any of 7 points in the chain of video effects:

• After the preset/program mixer (i.e, before any effect).

• After keyer 1.

• After logo A. *

• After squeezeback. *

• After keyer 2.

• After keyer 3.

• After logo B (i.e., after all effects).

The MCPM-MK-SD and MCPM-MK-HD do not have a logo A inserter or squeezeback gener-
ator. MasterConfig does not list those taps for these MCPMs.

The “squeeze cut” tap that appears in the drop-down list for MCPM-SD and -HD does not 
actually exist. Please ignore this choice.
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Active Video
Use the ‘Active Video’ section if you need to change the first and last lines of active video.

For interlaced formats, there are 2 data entry fields for each of the 2 video fields. For progressive 
formats, there are 2 data entry fields for the single video frame.

You can press the ‘Set to Default’ button to revert to default values for the video standard you 
chose when you created the configuration.

Use this diagram for reference: 

Fig. 4-29: Active Video

These are general rules:

• The first line of field 1 must be greater than the last line of field 0.

• Field 0 starts at line 1.

• The last line of field 1 should be the last line defined in the television standard, e.g., 525 for 
NTSC or 625 for PAL.

Metadata

MCPM
You can select the source of Dolby metadata output 2. Choose one of the sources in the drop-
down list. The options include:

• Follow the audio from the preset main source.

• Follow the audio source presented on monitor A.

The MCPM-MK-SD and MCPM-MK-HD do not have Dolby decoders. For these MCPMs, the 
Dolby metadata section of the page is absent.

Dolby metadata output 1 is not modifiable. It follows the audio from the program main 
source.
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MCE
The MCE presents all 8 Dolby metadata outputs on the top DB25 connector of its AXM back-
plane module. (If the MCE does not have an AXM card, the metadata section is empty.)

Each of the 8 metadata outputs can be configured. The drop-down menu for each output 
presents the following 12 choices: 

• Follow program main audio • Follow program over audio

• Follow preset main audio • Follow preset over audio

• Follow preview main audio • Follow preview over audio

• Follow monitor A main audio • Follow monitor A over audio

• Follow monitor B main audio • Follow monitor B over audio

• Follow meter main audio • Follow meter over audio

Emergency Bypass 
Check the checkbox in this section if you want to allow external control of the MCPM’s emer-
gency bypass relay (or emergency bypass state).

External control means that an emergency bypass control function can be assigned to a GPI 
input.

An Miranda emergency bypass control panel (EBCP) can be connected to the MCPM’s GPI input. 
Refer to the Master Control Reference Manual for information.

LOS
You can specify the behavior of the MCPM when loss of signal (LOS) occurs:

• Use the LOS matte in place of the program main source.

• Use internally generated black (in place of the program main source). 

You can also specify the color of the LOS matte, as a Y, Cr, Cb value. The range for Y is 64–940. The 
range for Cr and Cb is 64–960. See Color Values on page 202 (Appendix A) for more information. 

LOS is not to be confused with a non-sync condition. 

Completing the ‘Misc Settings’ Configuration 
1 Review all changes. 

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or

Click ‘Default’ to discard your changes and revert to default values. 
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Video Effect and Over Settings
This is a representative ‘Video Effect and Over Settings’ configuration page: 

Fig. 4-30: Video Effect and Over Settings Page (Sample)

The ‘Video Effect Settings’ page lets you specify default keyer sources and logo, keyer, squeeze-
back, and audio over behavior.

The MCPM-MK-SD and MCPM-MK-HD do not have a logo A inserter or squeezeback gener-
ator. The ‘Video Effect Settings’ page does not display options for logo A or squeezeback if 
you are editing an MCPM-MK-SD or MCPM-MK-HD configuration. It also calls Logo B simply 
“Logo.”

Only the MCPM-SDHD and MCE have enhanced squeezeback. Image 2 options are absent 
from this page unless you are configuring an MCPM-SDHD or an MCE.

Purpose
This is what the ‘Video Effect Settings’ page does:

• Specifies the default keyer settings for each of the 3 keyers. The default settings are the set-
tings selected when the MCPM resets.

• Specifies the transition behavior of the keyers, logos, and squeezeback. 

• Specifies the LOS behavior for squeezeback and enhanced squeezeback.

• Specifies the minimum “edge crop” for squeezeback.

Video 
Effect 
Behavior

Default
Keyer

Sources

Squeeze
Edge
Crop

 Squeeze
Audio

Audio O
Behavior
(MCE On

Dolby
Backup
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• Specifies the change-over rate for Dolby backup.

• Enables over audio for enhanced squeezeback. 

Page Organization
The ‘Video Effect Settings’ configuration page has 4 sections: 

1 The default keyer sources section specifies the default keyer settings for each of the 3 keyers. 

2 The squeezeback edge crop section specifies the first and last lines of active video. 

3 The squeeze image 2 section enables or disables over audio for enhanced squeezeback.

4 The dolby backup section selects either a fade or cut transition to Dolby backup.

5 The video effect behavior section specifies transition behavior for the keyers, logos, and 
squeezeback. It also specifies the behavior of squeezeback when LOS occurs.

6 The video effect behavior section specifies transition behavior for the keyers, logos, and 
squeezeback. It also specifies the behavior of squeezeback when LOS occurs.

Default Keyer Sources
This section allows you to specify a default keyer setting for each of the MCPM’s 3 keyers. Choose 
one of the defined keyer settings in the drop-down list. You may also choose ‘None’. You can 
choose the same default for all 3 keyers.

Keyer settings are chosen in this page section, not keyer sources.

Squeezeback Edge Crop
Squeezeback edge crop exists to prevent edge effects while a squeezeback transition is in 
progress. Edge crop is not the same as a squeezeback crop effect.

You can adjust the four edge crop values in this section. 

(These settings compensate for blanking irregularities or for sources that do not adhere to NTSC 
or PAL specifications.)

We recommend applying an edge crop using the default settings shown in Figure 4-31. If you 
make changes, use a waveform monitor to verify that the signal meets your required specifica-
tion before placing the system in service. 

Figure 4-31. Crop Settings (NTSC Field 0 Shown) 

The edge crop affects where squeeze borders (for MCEs and MCPM-SDHDs) appear.
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Squeeze Image 2 
Enhanced squeezeback allows audio for image 2. The audio is treated as a special audio over.

In addition to enabling (or disabling) audio for certain enhanced squeezeback effects, you must 
enable it globally by checking the ‘Enable Over Audio from Squeeze Image 2’ box in this section.

Also enter a name for the audio over in the ‘Squeeze Image 2 Over Name’. This name appears on 
the over button when the operator selects the audio over for squeezeback. 

This section is absent unless you are working on a configuration for MCPM-SDHD or an MCE.

Dolby Backup
Whenever the MCE or MCPM switches to backup audio for Dolby sources, it can perform either a 
4-frame fade or a hard cut. 

Check the checkbox for a hard cut; leave it unchecked for a quick fade: 

If the MCE switches to backup audio and “hard cut” is enabled, there is no loss of audio.

Video Effect Behavior
This section has 2 or 3 subsections, one for video keyers, one for logo keyers, and — if the MCPM 
has a squeezeback generator — one for squeezeback. 

Note that some control panels might be configured without certain video effects. 

Choose one of 3 transition behaviors in the drop-down lists for each effect. 

• Normal. 

The video effect transitions normally to program. In flip-only mode, the effect remains on 
the preset bus until the panel operator clears the effect from the preset bus. If the MCPM is in 
flip-flop mode, the content of the program bus transfers to the preset bus. 

• Disabled. 

The video effect is disabled. Video effect buttons are dim. The operator cannot change this. 
Only loading another configuration can change this.

• Clear Preset after Program Transitions to On.

The video effect transitions normally to program. In flip-only mode, the effect is removed 
from the preset bus at the completion of the transition.

If the MCPM is in flip-flop mode, the content of the program bus transfers to the preset bus, 
overriding this option. 

Hard Cut Fade
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You can also specify how squeezeback will behave under LOS conditions. There are 2 options for 
the squeeze background:

• Turn off squeeze.

• Use internal black.

and 3 options for image 2:

• Turn off squeeze.

• Use internal black.

• Turn off squeeze image 2 only.

Choose the options from the drop-down lists. 

The image 2 options are absent unless you are working with an MCPM-SDHD or MCE.

Audio Over Behavior
This section controls the behavior of audio overs. It exists for MCEs only.

There are 2 choices:

• Normal. 

The audio over transitions normally to program. In flip-only mode, the over remains on the 
preset bus until the panel operator clears the over from the preset bus. If the MCE is in flip-
flop mode, the content of the program bus transfers to the preset bus. 

• Clear Preset after Program Transitions to On.

The audio over transitions normally to program. In flip-only mode, the over is removed from 
the preset bus at the completion of the transition.

If the MCE is in flip-flop mode, the content of the program bus transfers to the preset bus, 
overriding this option. 

Completing the ‘Video Effect Settings’ Configuration 
1 Review all changes. 

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or

Click ‘Default’ to discard your changes and revert to default values. 
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Transition and Fade to Black Settings 
This is the ‘Transition and Fade to Black Settings’ configuration page: 

Fig. 4-32: Transition and Fade to Black Settings Page (Sample)

This configuration page lets you set the default states (i.e., the values when the MCPM resets) for 
transitions and fades to black (FTB).

“Fade to black” really means fade to matte and silence.

Purpose
This is what the ‘Transition and Fade to Black Settings’ page does:

• Specifies the default transition type.

• Specifies the default transition rate (slow, medium, fast).

• Specifies the number of frames for slow, medium, and fast transitions.

• Specifies the transition matte color.

• Specifies the FTB matte color.

• Specifies the number of frames for a fade to black.

Page Organization
The ‘Transition and Fade to Black Settings’ configuration page has 2 sections: 

1 Transition Parameters. 

2 Fade-to-Black Parameters. 

Transition Parameters
Although these parameters are set within the MCPM, they are not noticeable except at a control 
panel.

Default Transition Type
Choose one of the 9 transition types in the drop-down list. Your choice will be the default transi-
tion type when the MCPM resets. 

Transition
Parameters

Fade to Black
Parameters
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The choices include 5 “normal” transition types and 4 “preset black” transition types.

Refer to the Master Control Reference Manual for more information.

Default Transition Rate
Choose one of the 3 transition rates (slow, medium, fast) in the drop-down list. Your choice will 
be the default transition rate when the MCPM resets. 

The named rates are affected by the 3 durations specified in the ‘Transition Rates’ subsection.

Transition Rates
Specify in this section the duration of the 3 transition rates. The values are specified in number 
of frames. Larger values yield slower transitions. The range of values is 3 to 300 frames.

Transition Matte
Specify the transition matte in this section. The transition matte occurs in transitions that fade 
(such as V-fade and fade/cut). The color is specified as Y, Cr, Cb. 

The range for Y is 64–940. The range for Cr and Cb is 64–960. See Color Values on page 202 
(Appendix A) for more information. 

Fade-to-Black Parameters

Fade to Black (FTB) Matte
Specify the FTB matte in this section. The FTB matte occurs when a panel operator presses a FTB 
button. (A control panel might not have an FTB button.)

The color is specified as Y, Cr, Cb. The range for Y is 64–940. The range for Cr and Cb is 64–960. 
See Color Values on page 202 (Appendix A) for more information. 

Fade to Black Rate
Specify the duration of the FTB as a number of frames. A larger values yields a slower fade. The 
range of values is 3 to 300 frames.

Completing the Configuration 
1 Review all changes. 

2 Click ‘Apply’ to commit any changes that you have not already applied. This action updates 
the configuration records with the changed information. 

Or

Click ‘Default’ to discard your changes and revert to default values. 
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GPI Inputs
This is the ‘GPI Inputs’ configuration page: 

Fig. 4-33: GPI Inputs Page (Sample)

The MCPM has two configurable GPI inputs. The inputs are level-sensitive and optically isolated 
circuits. The inputs’ terminals are present on the MCPM’s aux connector. Refer to the Master 
Control Reference Manual for connection details.

You can use either of the inputs to control emergency bypass relay — here abbreviated EBR. The 
two states of the EBR are “bypass” and “normal.” (See the Master Control Reference Manual for 
information regarding bypass and the EBR.)

Several hardware error conditions can set the EBR to “bypass.” Under those conditions, the 
MCPM will ignore any GPI input configured to control the EBR. The GPI input will not be able 
to set the EBR to normal. When the emergency bypass switch on the front of the MCPM is set 
to “bypass,” the MCPM will also ignore any GPI input configured to control the EBR.

When the MCPM is reset or power-cycled, the GPIs also reset. During reset, the MCPM 
remains in bypass mode until it determines that it is “healthy.”

The ‘GPI Inputs’ page lets you select a GPI input and specify one of 5 behaviors for the input:

Purpose
This is what the ‘GPI Inputs’ page does:

• Names the input. (The name is largely irrelevant.)

• Selects a GPI behavior.

Page Organization
The ‘GPI Inputs’ configuration page has 2 sections: 

1 GPI Input List. 

2 GPI Input Mode. 

GPI Input 
Mode

GPI
Input

List
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GPI Input List
You can configure one or both GPI inputs. 

The GPI input list includes any GPI input configurations you have defined for the MCPM. You can 
add entries to the list and remove or copy entries in the list. The mnemonic (name) of a configu-
ration is used in no other place.

The list is ordered by selection number (selno) but it has only two entries. The selno identifies 
the GPI input. 

To Create a New GPI Input Configuration
Click ‘New’. The window shows a default setting. You may edit the setting now or at any time. 
Click ‘Apply’ to commit changes to the setting.

To Delete a Configuration
Highlight the configuration in the list and click ‘Delete’. 

To Edit a Configuration
Highlight the configuration in the list and modify the setting or its name. Click ‘Apply’ to confirm 
your changes. If you wish to cancel your changes, either click another configuration or click 
‘New’. A query appears: 

Click ‘No’ to discard your changes.

GPI Input Mode
Aside from the configuration name, the only option is the GPI’s mode of behavior. Choose one of 
the five modes in the drop-down list:

• Toggle control of emergency bypass relay.

When the GPI input has transitioned from off to on, the MCPM toggles the state of the emer-
gency bypass relay. Otherwise the MCPM does nothing.

• Level control of emergency bypass relay.

While the GPI input is on, the MCPM sets the EBR to “bypass.” While the GPI input is off, the 
MCPM sets the EBR to “normal.” 

• Set the EBR to “bypass.”

Note that this behavior is used in conjunction with the emergency bypass control panel 
(EBCP).

Note

When a GPI input is configured in this mode, the other GPI input cannot be config-
ured to control the EBR. The other GPI input must be configured as ‘disabled’.
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• Set the EBR to “normal.”

Note that this behavior is used in conjunction with the emergency bypass control panel 
(EBCP).

• Disabled. The MCPM ignores the GPI input.

Completing the Configuration 
1 Review all changes. 

2 Click ‘Apply’ to commit changes that you have not already applied. This action updates the 
configuration records with the changed information. 

Or

Click ‘Delete’ to delete the configuration. 

Or

Click ‘New’ to discard changes. Answer ‘No’ when asked whether you want to save changes. 

GPI Outputs
This is the ‘GPI Outputs’ configuration page: 

Fig. 4-34: GPI Outputs Page (Sample)

The MCPM has two configurable GPI outputs. The GPI outputs are SPDT relays (24VDC, 100mA). 
The outputs’ terminals are present on the MCPM’s aux connector. Refer to the Master Control 
Reference Manual for connection details.

The ‘GPI Outputs’ page lets you configure the MCPM’s two GPI output ports. 

Purpose
This is what the ‘GPI Outputs’ page does:

• Names the output. (The name is largely irrelevant.)

• Selects a GPI behavior.

GPI Output 
Mode

GPI
Output

List
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Page Organization
The ‘GPI Outputs’ configuration page has 2 sections: 

1 GPI Output List. 

2 GPI Output Mode. 

GPI Output List
You can configure one or both GPI outputs. 

The GPI output list includes any GPI output configurations you have defined for the MCPM. You 
can add entries to the list and remove or copy entries in the list. The mnemonic (name) of a 
configuration is used in no other place.

The list is ordered by selection number (selno) but it has only two entries. The selno identifies 
the GPI output. 

To Create a New GPI Output Configuration
Click ‘New’. The window shows a default setting. You may edit the setting now or at any time. 
Click ‘Apply’ to commit changes to the setting.

To Delete a Configuration
Highlight the configuration in the list and click ‘Delete’. 

To Edit a Configuration
Highlight the configuration in the list and modify the setting or its name. Click ‘Apply’ to confirm 
your changes. If you wish to cancel your changes, either click another configuration or click 
‘New’. A query appears: 

Click ‘No’ to discard your changes.

GPI Output Mode
Aside from the configuration name, the only option is the GPI’s mode of behavior. Choose one of 
the 7 modes in the drop-down list:

1 Disabled. The GPI output is “off.” (That is, its COM and NO terminals are disconnected.)

2 Controlled from UI. Enables manual control from a control panel. 

Use the MCS Panel Configuration Editor to assign a GPI output to a configurable panel button.

3 Video Effect Status. 
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The GPI output relay is active while a specified video effect is present on the preset bus or on 
the program bus. When you choose this mode, two new options appear: 

Using the ‘Bus’ pull-down list, choose whether the preset bus or program bus will trigger the 
GPI output.

Using the ‘Video Effect Type’ pull-down list, select the type of effect that, when called up on 
the selected bus, triggers the GPI output. In general, the choices are Keyer 1, Keyer 2, Keyer 3, 
Logo A, Logo B or Squeeze, however, for some MCPMs, the list has fewer choices.

Example: If you select ‘Program’ and ‘Squeeze’, the GPI output will be active when any 
squeezeback effect is on to the Program bus. 

4 Transition Status. 

The GPI output relay is active for the duration of any transition. 

5 Main Source. 

The GPI output relay is active while a specific main source is selected on either the preset or 
the program bus. 

Using the ‘Bus’ pull-down list, choose whether the preset bus or program bus will trigger the 
GPI output.

Using the ‘Main Source’ pull-down list, select the main source that you want to trigger the 
GPI. The list of choices is defined by the entries in the ‘Main Sources’ configuration page. 

6 Over Source. 

The GPI output relay is active while a specific audio over source is selected on either the pre-
set or the program bus. 

Using the ‘Bus’ pull-down list, choose whether the preset bus or program bus will trigger the 
GPI output.
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Using the ‘Over Source’ pull-down list, select the over source that you want to trigger the 
GPI. The list of choices is defined by the entries in the ‘Over Sources’ configuration page. 

7 Dolby Decoder. 

The GPI output relay is active while the Dolby decoder is in use by any main source selected 
on either the preset bus or program bus. 

Using the ‘Bus’ pull-down list, choose whether the preset bus or program bus will trigger the 
GPI output.

This option is absent for the MCPM-MK-SD and MCPM-MK-HD which do not have Dolby 
decoders. In other cases, your MCPM might or might not have a Dolby decoder. It is a 
purchase option.

Completing the Configuration 
1 Review all changes. 

2 Click ‘Apply’ to commit changes that you have not already applied. This action updates the 
configuration records with the changed information. 

Or

Click ‘Delete’ to delete the configuration. 

Or

Click ‘New’ to discard changes. Answer ‘No’ when asked whether you want to save changes. 
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Wing Outputs
This the ‘Wing Outputs’ configuration page:

Fig. 4-35: Wing Outputs Page (Sample)

The ‘Wing Outputs’ page is available for the MCPM-HD2 and -SDHD. It is not available for other 
MCPMs.

The MCPM-HD2 has two wing slots; it is the right slot (viewed from the front) to which this page 
applies. The MCPM-SDHD has a single wing slot (also at the right). 

The MCPM-HD also has two wing slots; neither of those slots are configurable. The page is not 
available for the -HD.

The slots accept EM0465 SWB router output cards. The SWB output cards provide outputs 
for a multi-format router present in the same frame. 

This configuration page allows the MCPM to control certain router outputs.

Purpose
This is what the ‘Wing Outputs’ page does:

• Presents a list of SWB router outputs.

• Allows you to select a behavior for each output.
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Options
The options for the router outputs differ for the MCPM-HD2 and the MCPM-SDHD. These 3 
options apply for both:

• Controlled by the router control card (one of the control cards in the frame).

• Follow (emit) program main video.

• Follow (emit) preset main video.

There are 2 additional options for the MCPM-SDHD:

• Follow (emit) program main audio (when it is embedded).

• Follow (emit) preset main audio (when it is embedded).

These options can be of some help when the frame includes a multi-format router in addition to 
its master control components.

Aux Outputs 
The ‘Aux Outputs’ page is available for MCEs: 

“Aux” is an abbreviation for “auxiliary.”

The MCE has two aux output connectors on its core backplane. They are labeled A and B. This 
configuration page directs video or audio to the choice you make in the drop-down lists for Aux 
A output and Aux B output: 

These are the choices:

• Aux Bus A (Panel Control)

The aux output (whichever one you choose) carries the main source chosen on the control 
panel’s aux bus when the panel operator presses the “Aux A Bus” delegate button.

• Aux Bus B (Panel Control)

The aux output (whichever one you choose) carries the main source chosen on the control 
panel’s aux bus when the panel operator presses the “Aux B Bus” delegate button.

• Program Video (follow Program Main Video)

The aux output (whichever one you choose) carries the video and audio of the main source 
chosen on the control panel’s program bus. 

Under breakaway, the aux audio output still comes from the video source.

Aux 
Options
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• Preset Video (follow Preset Main Video)

The aux output (whichever one you choose) carries the video and audio of the main source 
chosen on the control panel’s preset bus. 

Under breakaway, the aux audio output still comes from the video source.

• Program Audio (follow Program Main Audio when Embedded)

The aux output (whichever one you choose) carries the video and audio of the main 
source(s) chosen on the control panel’s program bus. 

Under breakaway, the aux audio output comes from the audio source.

This option does not appear unless you have checked ‘Enable Main Disembedders’ in the 
general settings. 

• Preset Audio (follow Preset Main Audio when Embedded)

The aux output (whichever one you choose) carries the video and audio of the main 
source(s) chosen on the control panel’s preset bus. 

Under breakaway, the aux audio output comes from the audio source.

This option does not appear unless you have checked ‘Enable Main Disembedders’ in the 
general settings. 

The aux outputs cannot replicate program audio or preset audio unless it is embedded. The aux 
outputs pass through whatever audio is embedded — all 16 channels, Dolby-encoded or not. 

Aux Bus 
The iMC-Panel-200 and iMC-Panel-300 (control panels) provide what is labeled an “Aux Bus” as 
well as a “Preview Bus.” The aux and preview buses work in conjunction with an MCE. They are 
inoperative for other MCPMs. 

The aux bus include a set of main source buttons and 6 “aux delegate” buttons. The delegate 
buttons select different functions for the aux bus. These are the delegate functions:

Aux A Bus Preset Squeeze Background Preview Squeeze Background
Aux B Bus Preset Squeeze Image 2 Preview Squeeze Image 2

When a panel operator presses “Aux A Bus,” the main source selected on the aux bus is sent to 
whichever aux output corresponds to the aux A bus. If neither aux output was configured for 
aux bus A, the aux output is unaffected. 

The same is true for the “Aux B Bus” panel button.

The other 4 delegate types — conveniences for the panel operator, and not relevant to Master-
Config — are discussed in the operator’s guides, and in the MCS Panel Configuration Editor User’s 
Guide.
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ExtRtrSrc Settings (for MCEs)
The ‘ExtRtrSrc Settings’ page becomes available if you check the ‘Enable External Router Source’ 
checkbox in the ‘General Settings’ page. There are two forms of the ‘ExtRtrSrc Settings’ page, 
one for MCEs and one for other MCPMs. This section describes the page for MCEs. 

This is a representative sample of the ‘ExtRtrSrc Settings’ page. This particular illustration shows 
connections for the program and preset bus: 

The ‘ExtRtrSrc Settings’ page defines the connections between router destinations and the 
inputs at the backplane. 
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Refer to the NV9000 documentation for information regard routers, levels, sources, destinations, 
and other concepts.

Purpose
This is what the ‘ExtRtrSrc Settings’ page does:

• Identifies the NV9000 router control system from which to obtain external source signals. 

• Specifies the router connections for main sources, key sources, squeeze image sources, and 
over sources.

• Configures options for the router connections.

Page Organization
The ‘ExtRtrSrc Settings’ configuration page has 6 sections: 

1 NV9000 IP Address. 

2 Naming Option.

3 Bus Switch.

4 Main Source Connections.

5 Key Source Connections.

6 Squeezeback Source Connections.

7 Audio Over Source Connections. 

NV9000 IP Address
This address is the same as the address specified in the general settings page. If it is not, specify 
the IP address of either the primary NV9000 system controller or the virtual IP address of the 
NV9000 system. The virtual IP address is defined in NV9000-SE Utilities. You need not specify the 
secondary controller (if you have one). 

If there is a secondary (backup) system controller, the NV9000 fails over to the backup controller 
without any effect on the master control system.

Naming Option
The ‘Use NV9000 Mnemonics’ checkbox option changes the way source names are presented 
on control panels. 

When you check the box, the panels display the mnemonics defined for the sources in the 
NV9000 configuration.

When you uncheck the box, the panels display the mnemonics defined in the MCE configuration. 

Bus Switch
One of the two “radio buttons” here selects the external router sources page for the program 
and preset buses. The other selects the external router sources page for the preview and aux 
buses. 

Only one page is visible at a time. Be careful not to overlook the other page. 
173



Operation
ExtRtrSrc Settings (for MCEs)
Note that some configuration options made in the program/preview page carry over into the 
preview/aux page.

The following sections discuss the program/preset and preview/aux pages in some detail. 

Connectors
A port connector is a BNC, a Phoenix 3-pin quick-release connector, or a 3-wire shielded twisted 
pair (STP) group on a DB25. They are numbered in the range 1 to 128. See the Master Control 
Reference Manual for connector details.

The entries you make in the ExtRtrSrc Settings’ page must match the actual connections you 
make if you expect your system to function properly. 

Program/Preset Page
The program/preset page is visible when you select the ‘Pgm/Pst’ radio button: 

The external connections for the program and preset buses apply to main sources, key sources, 
squeezeback sources, and over sources. There are two connection sets, A and B, for main 
sources, and similarly for over sources. There are 3 sets (fill and key) for keys. There is one set 
(background and image 2) for squeezeback.

Each section of the page has a corresponding checkbox with which to enable the section. If you 
check the box, the section becomes enabled — and visible. If you do not check the box, the 
section remains invisible. (Checking the boxes on this page enables the section(s) in the 
preview/aux page too.)

Main Source Connections
The main source section defines the connections of external main sources to the program and 
preset buses. (A similar section, in the preview/aux page, describes the main source connections 
to the preview bus.)

External main sources reach the frame through two sets of ports, designated A and B. The desig-
nations are not important and serve only to distinguish one set from the other. There are 2 sets 
because there are 2 buses, preset and program.

You must configure both sets in the same way, but using different connector numbers and 
destination IDs. Leaving one set unconfigured will result in errors.

There are 3 main source options: 

• Use all-level takes

Any external main source will use all levels of the NV9000 destination selected for the main 
sources. When you check this option, fields in this section relating to levels are hidden. 

• Use video input for embedded audio

Embedded audio is obtained from the principle video source. The fields that allow an addi-
tional source are hidden. 

• Enable mono AES

Embedded audio is obtained from the principle video source. The fields that allow an addi-
tional source are hidden. 
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Of these, the first 2 options combine, resulting in four ways to configure main sources. (The third 
option, mono AES, is a separate function, although you cannot use it if you check ‘Use All-Level 
Takes’. “All-level” implies that the audio sources are embedded in the video source and therefore 
cannot be discrete sources.)

Case 1 — Neither Option Checked
The main source uses specific levels. A separate destination can be used for embedded audio: 

The first router destination (under the heading ‘NV9000 Dest ID’ and next to ‘Main Video A’) 
provides video and audio on one or more NV9000 levels. You can specify up to 5 distinct levels 
and those correspond to the five drop-down menus under the heading ‘NV9000 Dest Levels ID’. 

You specify the connector numbers for the individual levels in the middle column. You do not 
have to use all the fields. If the NV9000 destination has fewer than 5 levels, assign the unused 
connectors a value of 0 and leave the level field blank.

The second router destination (next to ‘Emb Audio Video A’) is required if any external audio 
source is embedded. (Breakaway is possible for that source.) 

The third and fourth router destinations are like the first and second, but for channel B. 

Follow these steps for port set A:

1 Select the router destination in the drop-down list for ‘Main Video A’. The destination field is 
a drop-down list only if you have an NV9000 system connected (and identified). If the 
NV9000 is not connected, you’ll have to enter device IDs by typing.

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

3 Choose (or enter numerically) the virtual level for the video connection.

4 For each audio connection, enter the number of the audio connector. The cable from this 
connector will go to the audio router supporting the destination you selected. 

5 For each audio connection, choose (or enter numerically) the virtual level for the audio con-
nection.

6 Optionally, select a router destination in the drop-down list for ‘Emb Audio Video A’ and 
enter the BNC number used to connect to this destination.

7 Leave 0 or blank all fields for which there is no connection.
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Make similar settings for port set B, but using a different router destination and different inputs. 
Port set B must be configured identically to port set A except for the different destinations and 
connector numbers. 

The video level specified here also applies to external squeezeback sources if you have 
enabled them.

This example shows hypothetical connections for one main source: 

If (1) any of your external main source’s audio is embedded and (2) the master control system 
will require audio breakaway from any of those sources, you will need to connect a second 
router destination and a second video input (in addition to the first). 

This is an example showing connections that allow external embedded audio for breakaway: 
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Case 2 — All-Level
The main source uses the video level specified under ‘NV9000 Dest Levels ID’ and all audio levels 
of the separate NV9000 destination supplying embedded audio: 

The first router destination (next to ‘Main Video A’) provides video. You must specify a connector 
number for the video. 

The second router destination (next to ‘Emb Audio Video A’) is required. You must specify a 
connector number for the embedded audio. The connector must not be the same connector as 
for ‘Main Video A’.

The third and fourth router destinations are like the first and second, but for port set B. 

Follow these steps for port set A:

1 Select the router destination in the drop-down list. 

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

3 Specify the NV9000 level for the video connection.

4 Optionally, select a router destination in the drop-down list for ‘Emb Audio Video A’ and 
enter the BNC number used to connect to this destination.

Make similar settings for port set B, but using a different router destination and different inputs. 
Port set B must be configured identically to port set A except for the different destinations and 
connector numbers. 

The video level specified here also applies to external squeezeback sources if you have 
enabled them.
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Case 3 — Video In
The main source uses specific levels. Embedded audio comes from ‘Main Video A’ and ‘Main 
Video B’. Additional audio sources can be specified: 

Breakaway for the embedded audio channels is not possible, but it is possible for any of the 
discrete channels. 

The first router destination (under the heading ‘NV9000 Dest ID’ and next to ‘Main Video A’) 
provides video and some combination of embedded audio and discrete audio on one or more 
NV9000 levels. You can specify up to 5 discrete levels and those correspond to the five drop-
down menus under the heading ‘NV9000 Dest Levels ID’. 

You specify the connector numbers for the individual levels in the middle column. You do not 
have to use all the fields. If the NV9000 destination has fewer than 5 discrete levels, assign the 
unused connectors a value of 0 and leave the level field blank.

The second router destination is like the first, but for channel B. 

Follow these steps for port set A:

1 Select the router destination in the drop-down list. 

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

3 Specify the virtual level for the video connection.

4 For each audio connection, enter the number of the audio connector. The cable from this 
connector will go to the audio router supporting the destination you selected. 

5 For each audio connection, choose (or enter numerically) the virtual level for the audio con-
nection.

6 Leave 0 or blank all fields for which there is no connection.

Make similar settings for port set B, but using a different router destination and different 
inputs. Port set B must be configured identically to port set A except for the different desti-
nations and connector numbers. 

Example: The video level specified here also applies to external squeezeback sources if you 
have enabled them.
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Case 4 — Both Options Checked
The main source uses all levels of the NV9000 destination specified. Embedded audio comes 
from the main video. No additional audio sources can be specified: 

The first router destination (next to ‘Main Video A’) provides video and embedded audio. 

The video level specified here applies to external squeezeback sources if you have enabled 
them. It does not apply to the main sources here.

The second router destination is like the first, but for channel B. 

Follow these steps for port set A:

1 Select the router destination in the drop-down list. 

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

3 Specify the virtual level for the video connection.

Make similar settings for port set B, but using a different router destination and different inputs. 
Port set B must be configured identically to port set A except for the different destinations and 
port numbers. 
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Mono AES
The ‘Enable Mono AES’ check box allows you to specify separate levels for the AES channels that 
use discrete connectors (for external main sources).

This check box is not available for the ‘Preview, Aux’ configuration page.

If you leave the check box unchecked, each backplane connector (for main source audio) corre-
sponds to a single NV9000 “virtual level.” 

If you check the check box, each backplane connector (for main source audio) corresponds to 
two NV9000 virtual levels, making 8 fields for 8 audio channels. You can specify the NV9000 
virtual level for each individual channel. 

It should be noted that discrete audio connectors provide connections for the first 8 audio chan-
nels. If a video signal is to be associated with 16 audio channels, the association must be carried 
out another way. (Let the video signal be a local main source, for instance.)
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Key Source Connections
The key source section describes router connections for external key sources: 

External key sources reach the frame through 3 port sets, designated 1, 2, and 3. The designa-
tions are not important and serve only to distinguish one port from the other. There are 3 ports 
because there are 3 keyers in the MCPM.

Each port comprises 2 video input connectors (BNC). One input is for video fill; the other is for 
the key. If your external key is a self-key, you do not need to use the key input. 

The router destinations (defined in the NV9000 configuration for the purpose of supplying a 
master control system) provides the video on 1 or 2 virtual levels. If all your external keys are 
self-keys, you do not need to specify a level for key input.

Leave unused boxes blank (or 0).

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps for each key source port:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you’ll have to enter device IDs by typing.

2 Enter the BNC number for the video connector(s). The cable from this connector will go to 
the video router supporting the destination you selected. 

3 Choose (or enter numerically) the virtual level for the video connection.

4 Leave 0 or blank all fields for which there is no connection.

This example shows hypothetical connections for one key source: 
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Squeezeback Source Connections
External squeeze image sources are referenced, during configuration and operation, through 
the ‘Main Sources’ list. However, they reach MCPM physically through the connection defined in 
this section of the ‘ExtRtrSrc Settings’ page: 

External squeeze sources reach the frame through 2 ports. One port is for background images; 
the other is for squeeze2 images under enhanced squeezeback.

Enhanced squeezeback is available only in the MCPM-SDHD and MCE. 

The NV9000 levels for external squeezeback sources are specified in the main sources 
section. 

Leave unused boxes with a value of 0.

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps for each squeeze source:

1 Select the router destination in the drop-down list. 

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

Audio Over Source Connections
The over source section defines router connections of external over sources to the program and 
preset buses. (A similar section, in the preview/aux page, describes the over source connections 
to the preview bus.)

Like external main sources, external over sources reach the frame through two sets of ports, 
designated A and B. The designations are not important and serve only to distinguish one set 
from the other. There are 2 sets because there are 2 buses, preset and program.

You must configure both sets alike. Leaving one unconfigured will result in errors.

There is one over source option: ‘Use all-level take’ where any external over source will use all 
levels of the NV9000 destination selected for the over sources. When you check this option, 
fields in this section relating to levels are hidden. 

This option results in 2 ways to configure over sources. 
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Case 11—1Specific Levels
The over source uses specific levels. Embedded audio comes from ‘Over Audio A Emb’ and ‘Over 
Audio B Emb’. Additional audio sources can be specified: 

Like external main sources, external over sources reach the frame through two ports, desig-
nated A and B. The designations are not important and serve only to distinguish one port from 
the other. There are 2 ports because there are 2 buses, preset and program.

Each port comprises 5 input connectors and a router destination. A connector is a BNC, a 
Phoenix 3-pin quick-release connector, or a 3-pin shielded twisted pair (STP) group on a DB25. 
The first 4 connectors are for discrete audio; the fifth connector supports embedded audio (and 
it is actually a video connection).

The router destination (defined in the NV9000 configuration for the purpose of supplying a 
master control system) provides audio on one or more virtual levels. 

If your external over sources have fewer than 4 levels, leave the extra boxes blank (0).

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps for port set A:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you will have to enter device IDs by typing.

2 If the audio is embedded . . .

In the box labeled ‘Over Audio A’, enter the number of the video connector in which the 
audio is embedded. The cable from this connector will come from the video router support-
ing the destination you selected. 

If there are additional discrete audio sources, for each audio connection, enter the number 
of the audio connector. The cable from this connector will go to the audio router supporting 
the destination you selected. 

3 Otherwise . . .

For each audio connection, enter the number of the audio connector. The cable from this 
connector will go to the audio router supporting the destination you selected. 

4 Leave 0 all fields for which there is no connection.

Make similar settings for port set B, but using a different router destination and different inputs. 
Port set B must be configured identically to port set A except for the different port numbers. 
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Case 21—1All Levels
The over source uses all levels of the NV9000 destinations specified. Embedded audio comes 
from ‘Over Audio A Emb’ and ‘Over Audio B Emb’. No additional audio sources can be specified: 

In this case, each port set has just one connector — for embedded audio (and it is actually a 
video connection).

Follow these steps for port set A:

1 Select the router destination in the drop-down list. 

2 In the box labeled ‘Over Audio A Emb’, enter the number of the video connector in which the 
audio is embedded. The cable from this connector will come from the video router support-
ing the destination you selected. 

Make a similar setting for port set B, but using a different router destination and a different 
input. 

Preview/Aux Page
The preview/aux page is visible when you select the ‘Pvw, Aux’ radio button: 

The preview/aux page is largely dependent on the external router sources enabled in the 
program/preset page. What you enable in the program/preset page is also enabled in the 
preview/aux page. The main source options and over source options are the same also. (There 
are no controls affecting those options in the preview/aux page because the controls exist in the 
program/preset page.) 
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The preview/aux page does have an independent aux bus section, however. This illustration 
shows all the sections of the preview/aux page: 

The external connections for the preview bus apply to main sources, key sources, squeezeback 
sources, and over sources, as they do for the program and preset buses. Here, unlike the 
program/preset page, there is only one connection set (A) for main sources, and similarly, only 
one connection set (A) for over sources. As in the program/preset page, there are 3 connection 
sets for keys and one connection set for squeezeback.

Identifies
the

NV9000

Router Destination IDs Frame Inputs

Mai
Con

Bus switch

Aux bus
options

Key
Con

Squ
Sou
Con

Ove
Con

Aux
Con
185



Operation
ExtRtrSrc Settings (for MCEs)
Key Source Connections
The key source section describes router connections for external key sources: 

External key sources reach the preview bus through 3 port sets, designated 1, 2, and 3. The 
designations are not important and serve only to distinguish one port from the other. There are 
3 ports because there are 3 keyers in the MCPM.

Each port comprises 2 video input connectors (BNC). One input is for video fill; the other is for 
the key. If your external key is a self-key, you do not need to use the key input. 

The router destinations (defined in the NV9000 configuration for the purpose of supplying a 
master control system) provides the video on 1 or 2 virtual levels. If all your external keys are 
self-keys, you do not need to specify a level for key input. The virtual levels are specified in the 
program/preset page.

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps for each key source port:

1 Select the router destination in the drop-down list. 

2 Enter the BNC number for the video connector(s). The cable from this connector will go to 
the video router supporting the destination you selected. 

3 Choose (or enter numerically) the virtual level for the video connection.

4 Leave 0 or blank all fields for which there is no connection.

Squeezeback Source Connections
External squeeze image sources are referenced, during configuration and operation, through 
the ‘Main Sources’ list. However, they reach MCPM physically through the connection defined in 
this section of the ‘ExtRtrSrc Settings’ page: 

External squeeze sources reach the preview bus through 2 ports. One port is for background 
images; the other is for squeeze2 images under enhanced squeezeback.

Enhanced squeezeback is available only in the MCPM-SDHD and MCE. 

The external squeezeback sources use the NV9000 level specified in the main sources 
section. 

The entries you make in this configuration page must match the actual connections you make. 
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Follow these steps for each squeeze source:

1 Select the router destination in the drop-down list. 

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

3 Leave 0 or blank all fields for which there is no connection.

Audio Over Source Connections
The over source section defines router connections of external over sources to the preview bus. 
External over sources reach the preview bus through a single sets of ports, designated A. The 
designation is not important.

There is one over source option: ‘Use all-level take’ where any external over source will use all 
levels of the NV9000 destination selected for the over sources. When you check this option, 
fields in this section relating to levels are hidden. 

This option results in 2 ways to configure over sources. 

Case 11—1Specific Levels
The over source uses specific levels. Embedded audio comes from ‘Over Audio A Emb’. Addi-
tional audio sources can be specified: 

External over sources reach the frame through a single port set, designated A. The designation is 
not important.

The port comprises 5 input connectors and a router destination. The first 4 connectors are for 
discrete audio; the fifth connector supports embedded audio (and it is actually a video 
connection).

The router destination (defined in the NV9000 configuration for the purpose of supplying a 
master control system) provides audio on one or more virtual levels. 

If your external over source has fewer than 4 levels, leave the extra boxes blank (0).

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you will have to enter device IDs by typing.

2 If the audio is embedded . . .

In the box labeled ‘Over Audio A Emb’, enter the number of the video connector in which the 
audio is embedded. The cable from this connector will come from the video router support-
ing the destination you selected. 

If there are additional discrete audio sources, for each audio connection, enter the number 
of the audio connector. The cable from this connector will go to the audio router supporting 
the destination you selected. 
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3 Otherwise . . .

For each audio connection, enter the number of the audio connector. The cable from this 
connector will go to the audio router supporting the destination you selected. 

4 Leave 0 all fields for which there is no connection.

Case 21—1All Levels
The over source uses all levels of the NV9000 destination specified. Embedded audio comes 
from ‘Over Audio A Emb’. No additional audio sources can be specified: 

In this case, the port set has just one connector — for embedded audio (and it is actually a video 
connection).

Follow these steps for port set A:

1 Select the router destination in the drop-down list. 

2 In the box labeled ‘Over Audio A Emb’, enter the number of the video connector in which the 
audio is embedded. The cable from this connector will come from the video router support-
ing the destination you selected. 

Aux Bus Connections
The aux bus source section defines router connections of external main sources to the aux 
buses. The MCE has two aux buses, A and B. External main sources reach the aux buses through 
two ports, similarly designated A and B. 

Note that master control panels such as the iMC-Panel-300 that have aux buttons can be 
configured so that the aux buttons correspond to either of the MCE’s aux buses (and for 
other purposes as well).

There is one aux bus source option: ‘Use all-level take’ where any external main source will use 
all levels of the NV9000 destination selected for the aux bus source. 

This option results in 2 ways to configure aux bus sources. takes occur (1) on all levels or (2) just 
the video level specified in the main sources section: 

There is no change to the configuration page when you check or uncheck this option. 
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ExtRtrSrc Settings (for MCPMs)
The ‘ExtRtrSrc Settings’ page becomes available if you check the ‘Enable External Router Source’ 
checkbox in the ‘General Settings’ page. There are two forms of the ‘ExtRtrSrc Settings’ page, 
one for MCEs and one for other MCPMs. This section describes the page for MCPMs. 

This is a representative sample of the ‘ExtRtrSrc Settings’ page for an MCPM-SDHD. There are 
slight variations for other MCPMs: 

The ‘ExtRtrSrc Settings’ page defines the connections between router destinations and the 
inputs at the backplane. 
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Refer to the NV9000 documentation for information regard routers, levels, sources, destinations, 
and other concepts.

Purpose
This is what the ‘ExtRtrSrc Settings’ page does:

• Identifies the NV9000 router control system from which to obtain external source signals. 

• Specifies the router connections for main sources, key sources, squeeze image sources, and 
over sources.

Page Organization
The ‘ExtRtrSrc Settings’ configuration page has 6 sections: 

1 NV9000 IP Address. 

2 Main Source Connections.

3 Key Source Connections.

4 Squeezeback Source Connections.

5 Audio Over Source Connections. 

NV9000 IP Address
This address is the same as the address specified in the general settings page. If it is not, specify 
the IP address of either the primary NV9000 system controller or the virtual IP address of the 
NV9000 system. The virtual IP address is defined in NV9000-SE Utilities. You need not specify the 
secondary controller (if you have one). 

If there is a secondary (backup) system controller, the NV9000 fails over to the backup controller 
without any effect on the master control system.

Connectors
A port connector is a BNC, a Phoenix 3-pin quick-release connector, or a 3-wire shielded twisted 
pair (STP) group on a DB25. They are numbered in the range 1 to 128. See the Master Control 
Reference Manual for connector details.

The entries you make in the ExtRtrSrc Settings’ page must match the actual connections you 
make if you expect your system to function properly. 
190



MasterConfig
User’s Guide
Main Source Connections
The main source section defines the connections of external main sources to the frame: 

External main sources (that are not chosen during operation as squeeze sources) reach the 
frame through two port sets, designated A and B. The designations are not important and serve 
only to distinguish one set from the other. There are 2 port sets because there are 2 buses, 
preset and program.

You must configure both sets alike. Leaving one unconfigured will result in errors.

Each port set comprises 6 input connectors and two router destinations. The second router 
destination in a set is required only when at least one external source’s audio is embedded and 
breakaway is possible for that source. Otherwise, you can ignore the second destination and the 
6th connector.

The first router destination (defined in the NV9000 configuration) provides video and audio on 
one or more NV9000 levels. There are potentially 5 levels and those correspond to the five input 
boxes. 

If your external main sources have fewer than 5 levels, leave the extra boxes blank (or 0).

The entries you make in this configuration page must match the actual connections you make if 
you expect your system to function properly. 

Follow these steps for port A:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you’ll have to enter device IDs from memory.

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

3 Choose (or enter numerically) the virtual level for the video connection.

4 For each audio connection, enter the number of the audio connector. The cable from this 
connector will go to the audio router supporting the destination you selected. 

5 For each audio connection, choose (or enter numerically) the virtual level for the audio con-
nection.

6 Leave 0 or blank all fields for which there is no connection.
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Make similar settings for port B, but using a different router destination and different inputs. 

This example shows hypothetical connections for one main source port: 

If (1) any of your external main source’s audio is embedded and (2) the master control system 
will require audio breakaway from any of those sources, you will need to connect a second 
router destination and a second video input (in addition to the first). 

This is an example showing connections that allow external embedded audio for breakaway: 
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Mono AES
The ‘Enable Mono AES’ check box allows you to specify separate levels for the AES channels that 
use discrete connectors (for external main sources).

This check box is not available for the ‘Preview, Aux’ configuration page.

If you leave the check box unchecked, each backplane connector (for main source audio) corre-
sponds to a single NV9000 “virtual level.” 

If you check the check box, each backplane connector (for main source audio) corresponds to 
two NV9000 virtual levels, making 8 fields for 8 audio channels. You can specify the NV9000 
virtual level for each individual channel. 

It should be noted that discrete audio connectors provide connections for the first 8 audio chan-
nels. If a video signal is to be associated with 16 audio channels, the association must be carried 
out another way. (Let the video signal be a local main source, for instance.)
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Key Source Connections
The main source section describes the connections of external key sources to the frame: 

External key sources reach the frame through 3 ports, designated 1, 2, and 3. The designations 
are not important and serve only to distinguish one port from the other. There are 3 ports 
because there are 3 keyers in the MCPM.

Each port comprises 2 video input connectors (BNC). One input is for video fill; the other is for 
the key. If all your external keys are self-keys, you do not need to use the key input. 

The router destinations (defined in the NV9000 configuration for the purpose of supplying a 
master control system) provides the video on 1 or 2 virtual levels. 

Leave unused boxes blank (or 0).

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps for each key source port:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you’ll have to enter device IDs from memory.

2 Enter the BNC number for the video connector(s). The cable from this connector will go to 
the video router supporting the destination you selected. 

3 Choose (or enter numerically) the virtual level for the video connection.

4 Leave 0 or blank all fields for which there is no connection.

This example shows hypothetical connections for one key source port: 
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Squeezeback Source Connections
External squeeze image sources are referenced, during configuration and operation, through 
the ‘Main Sources’ list. However, physically they reach MCPM through the connection defined in 
this section of the ‘ExtRtrSrc Settings’ page: 

External squeeze sources reach the frame through 2 ports. One port is for background images; 
the other is for squeeze2 images under enhanced squeezeback.

Enhanced squeezeback is available only in the MCPM-SDHD (and MCE). For other MCPMs, 
the image 2 fields are absent.

Leave unused boxes with a value of 0.

The entries you make in this configuration page must match the actual connections you make. 

Follow these steps for each squeeze source:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you’ll have to enter device IDs from memory.

2 Enter the BNC number for the video connector. The cable from this connector will go to the 
video router supporting the destination you selected. 

Audio Over Source Connections
The over source section describes router connections for external over sources: 

Like external main sources, external over sources reach the frame through two ports, desig-
nated A and B. The designations are not important and serve only to distinguish one port from 
the other. There are 2 ports because there are 2 buses, preset and program.

Each port comprises 5 input connectors and a router destination. The first 4 connectors are for 
discrete audio; the fifth connector supports embedded audio (and it is actually a video 
connector).

The router destination (defined in the NV9000 configuration for the purpose of supplying a 
master control system) provides audio on one or more virtual levels. 

If your external over sources have fewer than 4 levels, leave the extra boxes blank (0).

The entries you make in this configuration page must match the actual connections you make. 
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Follow these steps for port A:

1 Select the router destination in the drop-down list. The destination field is a drop-down list 
only if you have an NV9000 system connected (and identified). If the NV9000 is not con-
nected, you’ll have to enter device IDs from memory.

2 If the audio is embedded

Enter the number of the video connector in which the audio is embedded. The cable from 
this connector will come from the video router supporting the destination you selected. 

3 Otherwise...

For each audio connection, enter the number of the audio connector. The cable from this 
connector will go to the audio router supporting the destination you selected. 

4 Leave 0 all fields for which there is no connection.

Make similar settings for port B, but using a different router destination and different inputs.

Intuition XG
The ‘Intuition XG’ page is available for MCEs only: 

This configuration page defines the connections between the Intuition XG graphics processor 
and the MCE.

Please refer to Miranda’s Intuition XG and XMedia documentation if you need detailed informa-
tion about these products. The Master Control Reference Manual provides some information.

XG Keyer
Channel 1

XG Keyer
Channel 2

Pre-Roll

Audio

Options
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Eighteen functions were added (at 6.3.0) to Miranda’s Xstudio software that allow Xstudio to use 
and control an MCE’s squeezeback effects and audio overs. See XStudio Add-On Commands on 
page 205. Also please refer to the Master Control Reference Manual for details.

Purpose
This is what the ‘Intuition XG’ page does:

• Specifies the IP address(es), on the master control network of the Intuition XG processor(s). 

• Specifies the keyers to use for the Intuition XG keyer layers.

• Specifies the parameters for Intuition XG audio.

• Specifies the input ports used by the fill and key signals from the Intuition processor(s).

• Specifies the pre-roll delay (in frames).

• Specifies the number of XG layers and the keyer’s behavior with respect to transitions.

Page Organization
The ‘Intuition XG’ configuration page has 4 sections: 

1 XG Keyer Channel 1. 

2 XG Keyer Channel 2. 

3 Pre-Roll. 

4 Audio. 

5 Options. 

XG Keyer Channel 1 
If the MCE is connected to a Intuition XG processor, check the ‘Program’ checkbox and fill the 
other fields that appear when the ‘Program’ box is checked: 

Do not check the ‘Program’, ‘Preset’, or ‘Preview’ checkboxes if the MCE is not connected to a 
Intuition XG processor.

If you are using only one Intuition XG channel, you can use any keyer in the ‘External Keyer’ field. 
If you are using two Intuition XG channels, you must use keyer 3 for the ‘Program’ channel.

Note that keyer 1 is pre-squeeze and keyers 2 and 3 are post-squeeze. 

IP address Specify the IP address of the Intuition XG processor, on the master control 
network.

‘Key Cut’ input, 
‘Key Fill’ input

Specify the BNC input numbers (on an SWB input backplane module) that 
supply keyer layer 1. The allowable range is 1–64.

‘Key Fill’ means the “fill” signal and ‘Key Cut’ means the “key” signal.

Oxtel port This should always be 5006 (or as defined in the Intuition XG processor).

External keyer Choose one of the available keyers to execute the effect. 
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XG Keyer Channel 2 
You can use either the preset bus or the preview bus for channel 2. Check the ‘Preset’ box or the 
‘Preview’ checkbox to make the choice. The options that appear are the same in either case.

If the MCE is connected to a Intuition XG processor, and there is a second keyer layer, check the 
‘Preset’ checkbox and fill the other fields that appear when the ‘Preset’ box is checked: 

Do not check ‘Preset’ or ‘Preview’ unless you have also checked ‘Program’. You can do so, but 
the results will be erroneous. (You cannot check both of these.)

If you are using two Intuition XG channels, you must use keyer 2 for the ‘Preset’ channel (and 
keyer 3 for the ‘Program’ channel).

If you do not have a second Intuition XG channel (i.e., XG key layer 2), do not check ‘Preset’ or 
‘Preview’. The resulting page would appear like this: 

IP address Specify the IP address of the Intuition XG processor used for XG keyer layer 2, 
on the master control network. Typically, this is the same processor as for XG 
keyer layer 1.

‘Key Cut’ input, 
‘Key Fill’ input

Specify the BNC input numbers (on an SWB input backplane module) that 
supply keyer layer 2. The allowable range is 1–64.

‘Key Fill’ means the “fill” signal and ‘Key Cut’ means the “key” signal.

Oxtel port This should always be 5007 (or as defined in the Intuition XG processor).

External keyer Choose one of the available keyers to execute the effect. Note that keyer 1 is 
pre-squeeze and keyers 2 and 3 are post-squeeze. 
198



MasterConfig
User’s Guide
Pre-Roll
Specify a delay value (in frames) that suits your particular system. The default value is 6 frames. 

Use 6 frames if your MCE processes interlaced video. Use 12 frames if it processes a progres-
sive video format. 

The Intuition XG does not use tapes. “Pre-roll” is a fictitious term meaning “delay.”

Pre-roll must be enabled in the general settings.

Audio
The Intuition XG video signals can include embedded audio (up to 16 channels). The MCE 
processes this audio as an audio over. These are the audio options:

• Number of audio channels.

Select a number from 2 to 16.

• Ratio.

This is the default over-to-main ratio of the XG layers. Note that the over-to-main ratio is 
non-linear. Panel operators can adjust the over level and the over-to-main ratio.

• Automatically turn on over.

Check this box if you want the XG over (the dedicated audio over available for Intuition XG 
audio) to turn on automatically when a panel operator presses an ‘XG layer’ button. 

When this option is enabled, the XG over actually follows the state of keyers assigned to 
the Intuition XG channels. When the keyer is on, the XG over is on; when the keyer is off, 
the XG over is off. The state of a keyer changes when (1) an operator presses an ‘XG layer’ 
button or when (2) an operator presses an ‘XG keyer control’ button. 

Certain operations can override this rule. For instance, if the operator selects the XG over 
independently, pressing an ‘XG Layer’ button does not affect the XG over nor does press-
ing an ‘XG Keyer Control’ button.

The XG audio is embedded on the fill input of an Intuition XG channel. 

Options

Keyer Behavior
Always specify 14050 as the XMS port. This is a port defined in the Intuition XG processor.

If you are using two separate processors (i.e., program and preset or preview are at different IP 
addresses) there will be two regions in which to enter the XMS port and the behavior.

Choose one of the 2 transition behaviors in the drop-down list. 

• Normal. 

The keyer layer transitions normally to program. In flip-only mode, the effect remains on the 
preset bus until the panel operator clears the effect from the preset bus. If the MCE is in flip-
flop mode, the content of the program bus transfers to the preset bus. 

• Clear Preset after Program Transitions to On.

The video effect transitions normally to program. In flip-only mode, the effect is removed 
from the preset bus at the completion of the transition.
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If the MCPM is in flip-flop mode, the content of the program bus transfers to the preset bus, 
overriding this option. 

Maximum Keyer Layers
The Intuition XG processor has either 1 or 2 channels. Each channel handles up to 4 layers. You 
can specify the maximum number of layers in this field. Your system will perform better when 
this value is low.
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Audio Gain
Audio gain is expressed in decibels, in the range –108 dB to +12 dB. Internal audio is AES PCM 
(pulse code modulation) data, that is to say, a series of digital values. When the MCPM applies 
audio gain, it scales the incoming audio values by 

10 gain/10

as shown in this table: 

Technically, every 3.0103 dB (10 log102) doubles the audio level. However, MasterConfig uses 
shorthand notation: a gain value of 3 represents 3.0103 dB and a gain value of 12 correspond-
ingly represents 12.0412 dB. 

Therefore, if you enter a gain value of +6, you will have quadrupled the audio level. If you enter a 
value of –3, you will have cut the audio level in half. 

Human sound perception is logarithmic. 
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Gain below –20 dB is virtually inaudible. 

Unity gain (0 dB) is scaling by 1 and therefore a no-op.

Color Values

Y, Cr, CB
The MCPM has several internal matte generators. Matte generators are used for the following 
purposes:

• Fade to Black signal.

• Loss of Signal (LOS) indication.

• Transition processing.

All use Y, Cr, and Cb values to define the matte color. In MasterConfig, you must specify Y in the 
range 64 to 940. You must specify Cr and Cb in the range 64 to 960. 

The table shows the relationship between the 6 main (fully saturated) colors plus white and 
black, and their Y, Cr, Cb equivalents: 

The angles are positions on a “color wheel”:

Mapping RGB to Y, Cr, Cb 
Theoretically

Y (luminance) is in the range [0, 1]
Cr, Cb (chrominance) are in the range [–0.5, +0.5]

Master control uses 10-bit Y, Cr, and Cb values. 

HSB Color Points

Angle 0 60 120 180 240 300 — —

Hue Blue Magenta Red Yellow Green Cyan White Black

Y 164 426 326 840 578 678 940 64

Cr 439 887 960 585 137 64 512 512

Cb 960 809 361 64 215 663 512 512
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The standard-definition1 analog mapping is this: 

Numerically, this analog formula is:

Y = 0.299 * R + 0.587 * G + 0.114 * B
Pb = 0.168736 * R – 0.331264 * G + 0.5 * B
Pr = 0.5 * R – 0.418688 * G – 0.081312 * B

where Y is in the range [0, 1] and Pr and Pb are in the range [–0.5, +0.5].

Digitally, and accounting for headroom and toeroom, the transform is this: 

Y = 64 + ( 262.952 * R + 516.228 * G + 100.256 * B ) / 256
Cb = 512 + ( –151.780 * R – 297.976 * G + 449.756 * B ) / 256
Cr = 512 + ( 449.756 * R – 376.616 * G – 73.140 * B ) / 256

when R, G, and B are 8-bit values, in the range [0, 255]. With rounding, the resulting Y values are 
in the range [64–940] and the resulting Cr, and Cb values are in the range [64–960].

ITU-R BT.709 (HD) uses the same formula with different constants:

KR = 0.2126
KB = 0.0722

SMTPE 240M (1125-line HD) uses the same formula with another set of constants:

KR = 0.212
KB = 0.087

HSB
Squeezeback border colors are expressed as HSB2 (hue, saturation, brightness) values. 

To express a color as an HSB value, first define the hue as an integer from 0.0 to 359.9 (degrees). 
Here also, the angles are positions on a “color wheel”:

1. (ITU-R BT.601, formerly CCIR 601)

B – Y
1 – KB

Y = KR × R + (1 – KR – KB) × G + KB × B

Pb = 
1
2 ×

R – Y
1 – KR

Pr = 
1
2 ×

where
KR = 0.299
KB = 0.114

2. The master control model used is HSV, a cylindrical model. Brightness and saturation are not completely 
independent.
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Saturation is the amount of “color” in the color. Express saturation from 0 to 100%. When 
“brightness” is 100%, a saturation value of 0% means white and a saturation value of 100% 
means pure color (hue). 

Brightness — in the HSV model — is the degree of “black” in the color. Express brightness from 0 
to 100%. A value of 0% represents black. When the saturation value = 100%, a brightness value 
of 100% represents pure color (hue). 

It is a combination of the “saturation” and “brightness” knobs on the control panel that give 
various gray levels, tints, and shades of color. This chart shows several saturation and brightness 
values for the hue “red”: 

Mapping HSV to RGB 
Given an HSV color (h,s,v) with h in the range [0–360°], and s and v in the range [0, 1], you can 
calculate an (r,g,b) value. 

h′ = ⎣h / 60⎦ mod 6

f = h / 60 – h′
p = v × (1 – s)

q = v × (1 – f × s)

t = v × (1 – (1 – f) × s)
Then, 

These (r,g,b) values are normalized to the real range [0, 1]. Multiply the (r,g,b) values by 256 to 
get 8-bit R, G, B values.

There is an inverse mapping, of course, but it is not discussed here.
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(p, v, t), if h′ = 4
(p, q, v), if h′ = 5

These choices have blue at 0°
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XStudio Add-On Commands
The following lists summarizes the commands added to Xstudio. 

Squeezeback
1 Squeeze move ( sqz number, duration ).

Executes the selected squeeze (1–32) for a specified duration.

The range of values for duration is 1–300. When the value is 1, the squeeze uses the default 
transition rate, that is, slow, medium, or fast (or cut). When the value is 2 through 300, the 
value represents a number of frames. This is true for any of these commands that specify a 
duration.

2 Squeeze move cut ( squeeze number ).

Executes the selected squeeze (1–32). Being a cut, there is no duration.
3 Squeeze move default transrate ( squeeze number ).

Executes the selected squeeze (1–32) using the default transition rate (slow, medium, fast, or 
cut).

4 Squeeze move reverse ( duration ).

Reverse-executes the squeeze (1–32) previously selected at the specified duration.

5 Squeeze move reverse cut ( ).

Reverse-executes the squeeze (1–32) previously selected. Being a cut, there is no duration.

6 Squeeze move reverse default transrate ( ).

Reverse-executes the squeeze (1–32) previously selected at the default transition rate (slow, 
medium, fast, or cut).

7 Squeeze override P2 position/size ( top, left, height, width, opacity ).

The commands sets up the parameters for the “run P2” commands that follow. “P2” identi-
fies the secondary squeeze image. 

The parameters ‘top’ and ‘left’ represent the position of the top, left corner of the secondary 
squeeze image. These values are in the range 0–1000, in units of 0.1 percent. 

The parameters ‘height’ and ‘width’ represent the reduction of the secondary squeeze 
image. These values are in the range 300–1000, in units of 0.1 percent. (Squeeze images can-
not be reduced to less than 30% of their original size nor increased beyond 100%.)

The ‘opacity’ parameter must be in the range 0–1000, again, in units of 0.1 percent. 

8 Squeeze override position/size ( top, left, height, width ).

The commands sets up the parameters for the “run” commands that follow. 
These parameters affect the primary squeeze image.

The parameters ‘top’ and ‘left’ represent the position of the top, left corner of the primary 
squeeze image. These values are in the range 0–1000, in units of 0.1 percent. 

The parameters ‘height’ and ‘width’ represent the reduction of the primary squeeze image. 
These values are in the range 300–1000, in units of 0.1 percent. (Squeeze images cannot be 
reduced to less than 30% of their original size nor increased beyond 100%.)
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9 Squeeze override run ( squeeze number, duration ).

Executes the selected squeeze (1–32) as a single-squeeze for the specified duration and 
applies the previously specified overrides.

10 Squeeze override run cut ( squeeze number ).

Executes the selected squeeze (1–32) as a single-squeeze. Being a cut, there is no duration. 
Uses the specified overrides.

11 Squeeze override run with P2 ( squeeze number, duration ).

Executes the selected dual-squeeze (1–32) for a specified duration. 
Uses the specified overrides.

12 Squeeze override run with P2 cut ( squeeze number ).

Executes the selected dual-squeeze (1–32). Being a cut, there is no duration. 
Uses the specified overrides.

Audio Over
13 Voice over fade on ( over number ).

Ramps up an audio over using rate and ratio specified below. 
The over selected must be in the range 1–4 or 17 or 18. 

The range 1–4 represents normal audio overs. The value 17 identifies the audio over associ-
ated with a secondary squeeze image (sometimes called the “P2 over”). The value 18 identi-
fies the audio over used by XG keys.

14 Voice over fade off ( ).

Ramps down current audio over using the rate and ratio specified in the following com-
mands. 

15 Voice over fade on XG over ( ).

This command executes a fade on using over number 18. The effect of the command is the 
same as if you had used the ‘fade on’ command with an argument value of 18.

16 Voice over fade rate ( duration ).

Sets up the fade rate for an audio over.

17 Voice over ratio ( ratio ).

Sets up the over ratio for an audio over. The value must be in the range 0–1000 (units of 0.1 
percent). The default ratio is 50%. 

18 XPT take ( main src ).

Selects a main source. The main source must be in the range 1–128. The command does not 
execute the transition.

Although the command parameters are given in parentheses here, they actually appear in a 
drop-down dialog in Xstudio. If a command has no parameters, there is no drop-down dialog. 
See the Master Control Reference Manual for more information. 
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NV9000 Integration 
If your master control system is used with an NV9000 Router Control System, connected routers 
may be used as pre-selectors “ahead of” master control inputs. 

The benefits of integrating master control and a NV9000 server include:

• Potentially thousand of inputs.

• Router source names appear on buttons. 

• The control panel can control the upstream router. Router information is displayed on the 
control panel.

• The ability to execute router salvos (with or without channel changes) from the control 
panel.

Generally, the following steps are required to link the NV5100MC frame and the NV9000:

• Establish a network connection between the NV9000 and the NV5100MC. Use the Master 
Control network port of the NV9000.

• Make the required configuration changes to the NV9000 database to support master con-
trol. 

• In the MCS Panel Configuration Editor, configure IP addresses for the NV9000 primary server 
and, if it is present, the redundant server. 

In general, refer to the NV9000-SE Utilities User’s Guide for information about the NV9000 
router control system.

The following MasterConfig configuration pages include NV9000 configuration settings:

• General Settings. 

• Main Sources. 

• Over Sources. 

If you have a NV9000 router connected to your master control system, IP addresses for the 
NV9000 servers will have been entered during installation of the Master Control software. If you 
did not specify these IP addresses during installation, and you want to do so, you must uninstall 
and reinstall the Master Control software, specifying these addresses during the install process. 
It is not difficult and does not take a long time.

A reinstall does not overwrite or delete existing configuration files.

Testing Configurations against Installed MCEs
You can click ‘Test Config with MCPM’ in the file menu to test you present configuration against 
the features of an installed MCE. The command applies only the MCEs.

The test issues zero or more warnings or errors messages followed by a summary report: 
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The configuration you are testing matches the installed MCE if the number of warnings and 
errors is 0. These are the warnings (and one error message) that you might see: 

1 If your configuration specifies ‘Has PVW Board’ in the general settings and the installed MCE 
has no preview board, the test issues a warning: “Preview board is not available.”

2 If your configuration specifies ‘Has AXM Board’ in the general settings and the installed MCE 
has no preview board, the test issues a warning: “AXM board is not available.”

3 If your configuration specifies ‘Enable Main Squeeze’ in the general settings and the 
installed MCE does not have the two DVEs required, the test issues a warning: “Pgm/pst 
main squeeze has insufficient hardware available.”

Note that “main squeeze” refers to the squeeze background image. DVEs “D” (J24) and “C” 
(J30) on the core board are required. 

Refer to the Master Control Reference Manual for the location of DVEs A–D.

4 If your configuration specifies ‘Enable P2 Squeeze’ in the general settings and the installed 
MCE does not have the DVE required, the test issues a warning: “Pgm/pst squeeze 2 has 
insufficient hardware available.”

Note that “P2 squeeze” refers to squeeze image 2. DVE “B” (J29) on the core board is required. 

5 If your configuration specifies both ‘Enable Main Squeeze’ and ‘Has PVW Board’ in the gen-
eral settings and the installed MCE does not have the DVE required, the test issues a warn-
ing: “Squeeze on Pvw bus has insufficient hardware available.”

Note that “main squeeze” refers to the squeeze background image. DVE “D” (J24) of the pre-
view board is required. 

6 If your configuration specifies both ‘Enable P2 Squeeze’ and ‘Has PVW Board’ in the general 
settings and the installed MCE does not have the DVE required, the test issues a warning: 
“Squeeze 2 on Pvw bus has insufficient hardware available.”

Note that “P2 squeeze” refers to squeeze image 2. DVE “B” (J29) on the preview board is 
required. 

7 If your configuration specifies ‘Enable Machine Control’ in the general settings and the 
installed MCE does not support machine control, the test issues a warning: “Machine control 
and/or preroll are not supported on this MCE.”

Machine control is available in software release 6.2 or later. 

8 If your configuration specifies either ‘Use All-Level Takes’ or ‘Use Video In for Embedded 
Audio’ (or both) in the ‘ExtRtrSrc Settings’ page and the installed MCE does not support 
those features, the test issues a warning: “MCE app does not support all-level take or map-
ping video input to embedded audio video.”

The features are available in software release 6.3.3 or later. 

9 If your configuration specifies ‘MCE is 16 Channel-Capable’ in the general settings and the 
installed MCE does not support 16 channels, the test issues an error message: “The configu-
ration is using more audio channels than are supported. This configuration will not load.”

Sixteen channel audio is available in software release 6.0 or later. 

10 If your configuration specifies ‘Dual Dolby Decoders’ in the general settings and the installed 
MCE does not support dual Dolby decoders, the test issues a warning: “MCE application ver-
sion or configuration does not support dual Dolby decoders.”

Dual Dolby decoders are available in software release 6.3.3 or later. 
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11 If your configuration specifies ‘Has Dolby E Decoders’ in the general settings and the 
installed MCE does too few Dolby decoders (on the AXM board), the test issues a warning: 
“MCE hardware does not have enough Dolby decoders to support the configuration.”

This test is performed in software release 6.3.3 or later. 

The test does not report which ones are missing.

If the configuration does not specify dual Dolby decoders, the MCE requires decoders A, B, C, 
and D for Dolby on the program and preset buses. Decoders E and F are required for Dolby 
on the preview bus. 

Dolby of any kind implies that an AXM board is installed. The configuration must have ‘Has 
AXM Board’ checked in the general settings.

Dolby on the preview bus implies that a preview board is installed. The configuration must 
have ‘Has PVW Board’ checked in the general settings. 

12 If your configuration specifies ‘Enable Hard Cut of Backup’ in the ‘Video Effect & Over Set-
tings’ page and the installed MCE does not support hard cuts for Dolby backup audio, the 
test issues a warning: “MCE application version does not support hard cuts to Dolby backup.”

Hard cuts for Dolby backup audio are available in software release 6.3.3 or later. 
Note that these tests are run automatically for any MCE configuration when you write the 
configuration to the MCE. 
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3Gig A term adopted by Miranda to refer to video rates of 2.966 Gb/s and 2.970 Gb/s. For NVISION series 
routers, a 3Gig signal also accepts HD and SD rates. It reclocks at 270 Mb/s, 1.483 Gb/s, 1.485 Gb/s, 
2.996 Gb/s, and 2.970 Gb/s. Reclocking is bypassed at other rates. 

Clean Feed A video output that can select program content from a tap at one of several points in the 
MCPM’s video effect layering. The clean feed signal is directed to a clean feed output at the rear 
of the MCPM.

Control panel An inclusive term meaning a hardware control panel or a software control panel (GUI). 

DARS Digital Audio Reference Signal.

GUI Graphical User Interface. The term usually refers to the iMC-Panel-GUI.

Imagestore 
750

The Imagestore 750 is a 1RU transition processor, also called a “channel branding processor.” It 
has several purchase options, including a master control option that allows it to function in the 
context of the iMC master control system.

iMC-Panel-
300

A hardware control panel. 

iMC-Panel-
200

A compact hardware control panel. 

iMC-Panel-
100

A 3RU rack-mountable control panel with separate display. 

iMC-Panel-
GUI

A software control panel that emulates the iMC-Panel-200. 

Intuition XG Intuition XG is a combination of a video, audio, and graphics processor and Xmedia software. 

IP address A 32-bit number that identifies a device on a network. The address is usually expressed as 4 
octets, in decimal notation, joined by periods (e.g., 192.168.7.20).

Keyer A video image (“fill”) generally coupled with another video image (“key”) to be overlayed, 
possibly with transparency, on the program output. The key image is a mask that hides or 
reveals pixels in the fill according to the brightness of the pixel in the key. Some keyers do not 
have separate key images. These keyers self-key, that is, the image is masked according to the 
luminance values in the fill image itself.

Layer One of the 7 video output components (main source, 2 logos, 3 keyers, and squeezeback). The 
are called layers because of their visual priority. Functions to the right, on the control panel, have 
priority.

Some MPCMs can be configured with fewer than the maximum number of video effects. 
Some MCPMs do not support all effects.

Logo In the context of master control, a logo is a graphics file (static or animated) to be overlayed as a 
video effect on a main source. The file — internal to the MCPM — either contains a distinct key 
layer or can “self-key” from its own luminance data. Logo files acceptable to an MCPM are 
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converted from files in common graphic formats (TIF, GIF, JPEG, TGA, BMP, PNG). Animation 
source files must be 32-bit Targa (TGA) files.

MCPM Master Control Processing Module. A transition processor. There are several MCPM models.

MCE Master Control Engine. An advanced transition processor.

Squeezeback A process in which the program video is either (1) reduced in size or (2) cropped and possibly 
repositioned so that an additional video image (the “background”) can be displayed in the 
program output. Squeezeback is subject to transition type and transition rate.

The MCPM-MK-SD and MCPM-MK-SD have no squeezeback generator.

Transition The process by which the MCPM moves the content of the preset bus (source and layers) to the 
program bus. Transitions are governed by transition type and transition rate. 

Vertigo XG A single- or dual-channel HD/SD graphics processor.

XG Dash-
board

Configuration tool for Intuition XG. 

XMedia A collection of configuration and creative software used with Intuition XG. 

Xbuilder “Template population” and “promo timeline control” software for Intuition XG. 

XPlay A “media event sequencer” used to configure the Intuition XG and to manage clips. Xplay must 
be running on the Intuition XG processor for correct operation under master control.

Xstudio “Template creation” software for Intuition XG. 
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Contact Us
Miranda Technical Support
For technical assistance, please contact the Miranda Technical Support center nearest you:

Corporate Head Office
Miranda Technologies Inc.

3499 Douglas-B.-Floreani, St-Laurent, Quebec, Canada H4S 2C6

Telephone: 514-333-1772

Fax: 514-333-9828

Web: www.miranda.com

Americas
Office hours: 9:00 a.m. – 9:00 p.m. (EST)

Telephone: +1-800-224-7882

Fax: +1-514-335-1614

E-mail: techsupp@miranda.com

Europe, Middle East, Africa, UK
Office hours: 9:00 a.m. – 6:00 p.m. (GMT)

Telephone: +44 118 952 3444 

Fax: +44 118 952 3401 

E-mail: eurotech@miranda.com

France
Office hours: 9:00 a.m. – 5:00 p.m. (GMT+1)

Telephone: +33 1 55 86 87 88

Fax: +33 1 55 86 00 29

E-mail: eurotech@miranda.com

Asia
Office hours: 9:00 a.m. – 5:00 p.m. (GMT+8)

Telephone: +852-2539-6987

Fax: +852-2539-0804

E-mail: asiatech@miranda.com

China
Telephone: +86-10-5873-1814

E-mail: asiatech@miranda.com
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